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Branchement de l'antenne
Si vous ne branchez pas de câblosélecteur ou de récepteur satellite au téléviseur, une antenne ou un service de 
câblodistribution doit être branché afin que le téléviseur puisse recevoir les signaux de diffusion.

Branchez le câble de l'antenne ou du câblodistributeur dans le connecteur ANT IN, tel qu'illustré dans le diagramme 
ci-dessous.

"" Il n'est pas nécessaire de brancher l'antenne si vous utilisez un câblosélecteur ou un récepteur satellite.

Connexion d'appareils vidéo
Ce téléviseur possède un large éventail de connecteurs pour les appareils externes comme les câblosélecteurs, les 
récepteurs satellite, les lecteurs Blu-ray, les lecteurs DVD, les caméscopes et les consoles de jeux. Voici une liste de 
connecteurs disponibles classés selon une qualité d'image décroissante.

●● HDMI

●● Composante

●● Composite (A/V)

Branchez un appareil vidéo au téléviseur à l'aide d'un connecteur HDMI afin d'obtenir la meilleure qualité d'image. 
Si l'appareil n'est pas pourvu d'un connecteur HDMI, essayez d'utiliser un connecteur de composante pour obtenir 
la meilleure qualité d'image.

"" Le nombre de connecteurs ainsi que leur nom et emplacement peuvent varier en fonction du modèle du téléviseur.

"" Reportez-vous au guide d'utilisation de l'appareil externe pour son branchement au téléviseur. Le nombre de 
connecteurs ainsi que leur nom et emplacement peuvent varier en fonction du fabricant.

Branchement d'une antenne et d'appareils externes
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Branchement HDMI
Il est recommandé d'utiliser l'un des câbles HDMI suivants :

●● Câble HDMI haute vitesse

●● Câble HDMI haute vitesse avec Ethernet

"" Utiliser un câble HDMI d'une épaisseur de 14 mm (0,55 po) ou moins.

"" L'utilisation d'un câble HDMI non-certifié peut causer une absence d'image ou une erreur de connexion.

"" Certains câbles et appareils HDMI peuvent ne pas être compatibles avec le téléviseur en raison de spécifications HDMI 
différentes.

"" Ce téléviseur ne prend pas en charge le canal Ethernet HDMI. Ethernet est un réseau local (LAN) formé de câbles 
coaxiaux respectant la norme IEEE.

Consultez le schéma et branchez le câble HDMI au connecteur de sortie HDMI de l'appareil vidéo et au connecteur 
d'entrée HDMI du téléviseur.

"" Le nombre de connecteurs ainsi que leur nom et emplacement peuvent varier en fonction du modèle du téléviseur.

Lorsque la connexion est établie, appuyez sur la touche SOURCE pour sélectionner l'appareil externe connecté.
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Branchement d'une composante
Consultez le schéma et branchez le câble composante aux connecteurs d'entrée composante du téléviseur et aux 
connecteurs de sortie composante de l'appareil.

Assurez-vous que les couleurs des câbles correspondent aux couleurs du connecteur.

Lorsque la connexion est établie, appuyez sur la touche SOURCE pour sélectionner l'appareil externe connecté.
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Connexion composite (A/V)
Reportez-vous au diagramme et branchez le câble AV aux connecteurs d'entrée AV du téléviseur et aux 
connecteurs de sortie AV de l'appareil.

Si vous utilisez les connecteurs d'entrée AV du téléviseur, utilisez un connecteur en Y pour connecter la sortie 
audio de l'appareil au téléviseur.

Lorsque la connexion est établie, appuyez sur la touche SOURCE pour sélectionner l'appareil externe connecté.
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Connexions d'entrée et de sortie audio
Votre téléviseur est doté de diverses entrées pour les appareils comme les lecteurs de Blu-ray ou de DVD et de 
diverses sorties vers des appareils comme des amplificateurs. Voici une liste des connexions prises en charge.

●● Audio numérique (optique)

●● Audio (analogique)

"" Il est recommandé d'utiliser un récepteur AV pour obtenir une meilleure qualité audio.

"" Le nombre de connecteurs ainsi que leur nom et emplacement peuvent varier en fonction du modèle du téléviseur.

"" Reportez-vous au guide d'utilisation de l'appareil externe pour son branchement au téléviseur. Le nombre de 
connecteurs ainsi que leur nom et emplacement peuvent varier en fonction du fabricant.

"" Lorsque vous connectez l'appareil externe au haut-parleur externe, veillez à connecter en premier le haut-parleur au 
téléviseur, et ensuite connectez l'appareil externe. Si l'ordre de connexion est inversé, il peut en résulter des problèmes 
de synchronisation.

Branchement audio numérique (optique)
Le branchement d'un récepteur AV au connecteur audio numérique (câble audio optique) du téléviseur vous 
permet d'écouter une sortie audio numérique.

"" Le branchement de l'appareil à l'aide d'un câble optique n'éteint pas automatiquement les haut-parleurs du téléviseur. 
Pour désactiver les haut-parleurs du téléviseur, réglez Sortie du son du téléviseur (Son > Paramètres haut-parleur > 
Sortie du son du téléviseur) à un autre élément que les haut-parleurs du téléviseur.

"" Réglez le volume de l'appareil audio en utilisant la télécommande de celui-ci.

"" Un bruit inhabituel venant de l'appareil audio en cours d'utilisation peut indiquer un problème avec l'appareil audio lui-
même. Si cela se produit, demandez de l'aide au fabricant de l'appareil audio.

"" L'audio numérique est disponible seulement avec les diffusions à canaux 5.1.

Consultez le schéma et branchez le câble optique au connecteur de sortie audio numérique du téléviseur et au 
connecteur d'entrée audio numérique de l'appareil.
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Branchement d'une sortie audio
Reportez-vous au diagramme et branchez un câble audio au connecteur de sortie audio du téléviseur et au 
connecteur d'entrée audio de l'appareil.

Lorsque la connexion est établie, appuyez sur la touche SOURCE pour sélectionner l'appareil externe connecté.

Connexion à un ordinateur
Vous pouvez connecter un ordinateur au téléviseur, comme si le téléviseur devenait l'écran de l'ordinateur, grâce 
à un câble HDMI ou DVI vers HDMI. Vous pouvez également connecter un ordinateur au téléviseur à l'aide de 
votre réseau domestique afin d'obtenir accès aux fichiers média enregistrés sur l'ordinateur. Voici une liste des 
connexions que vous pouvez établir.

Pour utiliser le téléviseur comme un écran d'ordinateur

●● Branchez le téléviseur grâce au port HDMI et à un câble HDMI.

Vous pouvez connecter un ordinateur au téléviseur et ainsi afficher sur le téléviseur ce qui se trouverait à 
l'écran grâce à un câble HDMI.

●● Branchez-vous au port HDMI (DVI) grâce à un câble DVI vers HDMI.

Vous pouvez brancher un ordinateur au téléviseur en reliant le port DVI de l'ordinateur au port HDMI du 
téléviseur à l'aide d'un câble DVI vers HDMI, et ainsi utiliser le téléviseur comme un écran d'ordinateur.

Pour accéder aux fichiers médias situés sur un ordinateur et les lire à l'aide du téléviseur

●● Établissez la connexion à l'aide de Samsung Link.

Accédez rapidement aux fichiers audio, vidéo ou d'images enregistrés sur un ordinateur sur lequel vous avez 
installé le logiciel Samsung Link, même si vous ne connectez pas directement le téléviseur à l'ordinateur.

●● Établissez une connexion en DLNA par l'entremise de votre réseau domestique.

Accédez rapidement aux fichiers audio, vidéo ou d'images enregistrés sur un ordinateur en branchant le 
téléviseur et le téléviseur au même routeur ou point d'accès.
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Connexion au moyen du port HDMI
Pour une connexion HDMI, nous recommandons un des types de câbles HDMI suivants :

●● Câble HDMI haute vitesse

●● Câble HDMI haute vitesse avec Ethernet

"" Utiliser un câble HDMI d'une épaisseur de 14 mm (0,55 po) ou moins. L'utilisation d'un câble HDMI non-certifié peut 
causer une absence d'image ou une erreur de connexion.

"" Certains câbles et appareils HDMI peuvent ne pas être compatibles avec le téléviseur en raison de spécifications HDMI 
différentes.

"" Ce téléviseur ne prend pas en charge le canal Ethernet HDMI. Ethernet est un réseau local bâti sur des câbles coaxiaux 
standardisés par l'IEEE.

"" Beaucoup d'adaptateurs graphiques n'ont pas de ports HDMI, mais des ports DVI. Si votre adaptateur graphique a 
un port DVI, connectez l'ordinateur au téléviseur à l'aide d'un câble DVI-HDMI. Pour de plus amples renseignements, 
reportez-vous à la section « Connexion à l'aide d'un câble DVI-HDMI ».

Conformément au diagramme, connectez un câble HDMI au connecteur de sortie HDMI de l'ordinateur et au 
connecteur d'entrée HDMI du téléviseur.

"" Le nombre de ports ainsi que leur nom et emplacement peuvent différer en fonction du modèle.

Lorsque la connexion est établie, appuyez sur la touche SOURCE pour sélectionner l'appareil externe connecté.
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Connexion à l'aide d'un câble DVI-HDMI
Si la carte graphique de votre ordinateur ne prend pas en charge l'interface HDMI, connectez l'ordinateur au 
téléviseur grâce à un câble DVI (Digital Visual Interactive) vers HDMI. Veuillez remarquer que la connexion DVI vers 
HDMI est uniquement prise en charge par le port HDMI (DVI), et ne prend pas en charge la transmission du signal 
audio. Pour entendre le son provenant de l'ordinateur, branchez les haut-parleurs externes au connecteur de 
sortie audio de l'ordinateur.

"" Pour connaître les formats de résolutions pris en charge, reportez-vous à la section « Instructions à lire avant de 
procéder à la connexion d'un ordinateur (résolutions prises en charge) ».

Consultez le schéma et branchez le câble DVI vers HDMI du port HDMI (DVI) du téléviseur au port de sortie DVI de 
l'ordinateur.

Lorsque la connexion est établie, appuyez sur la touche SOURCE pour sélectionner l'appareil externe connecté.
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Connexion au moyen de Samsung Link
Accédez rapidement aux fichiers de photos, de vidéos et de musique enregistrés sur un ordinateur sur lequel le 
logiciel Samsung Link a été installé. Vous pouvez également, grâce à Samsung Link, lire le contenu d'un ordinateur 
que vous avez enregistré à Samsung Link à l'aide de votre compte Samsung, et ce, même si l'ordinateur et le 
téléviseur ne sont pas connectés au même routeur ou point d'accès.
1.	 Sur un ordinateur, allez au portail de contenu et de services Samsung (http://link.samsung.com), puis 

connectez-vous à votre compte Samsung.

"" Pour installer le logiciel de bureau Samsung Link, vous devez ouvrir une session sur votre compte Samsung. Si vous 
n'avez pas de compte Samsung, vous devrez tout d'abord en créer un.

2.	 Installez le logiciel Samsung Link sur un ordinateur de bureau. Une fois l'installation terminée, l'ordinateur 
sera enregistré grâce à Samsung Link.

3.	 Sélectionnez un dossier sur l'ordinateur connecté au téléviseur. Vous pouvez lire à l'aide du téléviseur les 
fichiers de photos, vidéos et de musique qui se trouvent dans le dossier en question.

"" Pour de plus amples renseignements sur l'utilisation du logiciel Samsung Link pour ordinateurs de bureau, reportez 
à la section d'aide du logiciel.

Connexion par DLNA en utilisant votre réseau domestique
Vous pouvez accéder rapidement aux fichiers photo, vidéo et de musique enregistrés sur un ordinateur et les lire 
sur le téléviseur.
1.	 Connecter le téléviseur et l'ordinateur au même routeur ou point d'accès. Une fois les deux appareils 

connectés au même routeur ou point d'accès, vous devez configurer un réseau domestique.

"" DLNA est une technologie qui permet de partager du contenu entre les téléviseurs, les ordinateurs et les appareils 
mobiles au moyen d'un routeur câblé ou sans fil.

2.	 Sur l'ordinateur, sélectionnez [Panneau de configuration] > [Réseau et Internet] > [Centre Réseau et 
partage] > [Modifier les paramètres de partage avancés], et ensuite cliquez sur [Choisir les options de 
diffusion de contenu multimédia] pour activer la diffusion de contenu multimédia.

3.	 À partir de la liste, réglez le téléviseur à [Autorisé].

4.	 Lancement de Windows Media Player sur un ordinateur. Sélectionnez [Paramètres] > [Gestion des 
bibliothèques], puis ajoutez l'endroit où les fichiers audio, vidéo ou d'image que vous désirez lire à l'aide du 
téléviseur se trouvent.

"" Vous pouvez également déplacer les fichiers vers le dossier par défaut du Windows Media Player, puis les lire 
ensuite sur le téléviseur.

"" Si le partage de fichiers est activé, des accès non autorisés peuvent se produire. Si vous n'avez pas besoin d'accéder 
à des données, désactivez le partage de fichiers.
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Connexion à un appareil mobile
Vous pouvez connecter un appareil mobile comme un téléphone intelligent ou une tablette directement au 
téléviseur, ou le connecter au réseau et faire afficher l'écran de l'appareil mobile, ou lire son contenu, à l'aide du 
téléviseur. Voici une liste des connexions que vous pouvez établir.

●● Établir la connexion à l'aide d'une recopie d'écran de l'appareil sur le téléviseur

Vous pouvez connecter le téléviseur et l'appareil mobile à l'aide de la fonction effet miroir. Vous pouvez voir 
l'écran de l'appareil mobile sur l'écran du téléviseur.

"" Cette option est disponible uniquement sur un appareil mobile qui prend en charge la fonction de miroitage.

●● Établir une connexion à un appareil mobile sans routeur sans fil (Wi-Fi Direct)

Wi-Fi Direct permet de connecter le téléviseur et l'appareil mobile sans avoir recours à un routeur ou un 
point d'accès. Vous pouvez accéder rapidement aux fichiers photo, vidéo et de musique enregistrés sur 
l'appareil mobile connecté et les lire sur le téléviseur.

"" Cette option est disponible uniquement sur un appareil mobile qui prend en charge la fonction Wi-Fi Direct.

●● Établir une connexion à l'aide de Samsung Link

Samsung Link vous permet de lire facilement des fichiers photo, vidéo et de musique enregistrés sur un 
appareil mobile doté du logiciel Samsung Link sans avoir besoin d'établir une connexion avec le téléviseur.

●● Établir une connexion en DLNA par l'entremise de votre réseau domestique

Vous pouvez accéder facilement aux fichiers photo, vidéo et de musique enregistrés sur un appareil mobile 
en connectant ce dernier et le téléviseur au même routeur ou point d'accès.
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Mise en miroir de l'écran
MENU > Réseau > Screen Mirroring Ess. maint.

Effectuez la connexion sans fil au téléviseur d'un appareil mobile dont la fonction de mise en miroir est activée, 
puis procédez à la lecture des fichiers vidéo et audio stockés dans l'appareil sur le téléviseur. La mise en miroir fait 
référence à la fonction qui effectue la lecture des fichiers vidéo et audio d'un appareil mobile sur le téléviseur et 
l'appareil mobile simultanément.

"" Pour utiliser la fonction de Recopie d'écran, l'appareil mobile doit prendre en charge une fonction de mise en miroir 
telle que AllShare Cast ou Recopie d'écran. Pour vérifier si votre appareil mobile prend en charge la fonction de recopie 
d'écran, veuillez visiter le site Web du fabricant de l'appareil mobile.

"" L'image ou le son pourrait s'interrompre par intermittence selon l'état du réseau.

Connexion par le biais d'un appareil mobile

1.	 Sur l'appareil mobile, lancez Screen Mirroring. L'appareil mobile recherche les appareils disponibles auxquels 
se connecter.

2.	 À partir de la liste des résultats de recherche, sélectionnez le téléviseur. Le téléviseur affiche un message 
contextuel dans la partie supérieure de l'écran.

3.	 Dans la fenêtre contextuelle, sélectionnez Permet. pour connecter l'appareil mobile.

"" Tous les appareils mobiles autorisés antérieurement se connecteront automatiquement sans nécessiter 
d'approbation.

"" Si vous sélectionnez Bloquer, l'appareil ne pourra pas se connecter. Et si vous réglez la connexion de l'appareil à 
« Bloquer », l'appareil ne pourra plus se connecter tant que vous ne modifierez pas l'état de la connexion. Pour 
modifier la connexion d'un dispositif bloqué, allez à Réseau > Screen Mirroring > Gest. périph., sélectionnez le 
dispositif, puis sélectionnez Permet..
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Se connecter automatiquement en permettant les connexions

1.	 Allez à Réseau > Screen Mirroring, puis sélectionnez Screen Mirroring. La fonction Screen Mirroring s'active. 
Vous pouvez également lancer la recopie d'écran en appuyant sur la touche SOURCE de votre télécommande, 
puis en sélectionnant Screen Mirroring dans la liste qui se trouve dans la partie supérieure de l'écran.

2.	 Lancer la Recopie d'écran à partir de votre dispositif mobile. Le dispositif effectue une recherche d'appareils 
disponibles.

3.	 Sélectionnez le téléviseur dans la liste. Le téléviseur permet automatiquement la connexion, et le dispositif se 
connecte.

"" Lorsque la connexion d'un appareil mobile s'avère impossible, essayez de mettre le téléviseur hors tension, puis de 
nouveau sous tension.

Gérer la connexion de dispositif mobiles que vous avez déjà connectés

"" Cette fonction est uniquement disponible si vous avez déjà connecté des dispositifs au téléviseur, ou si vous avez fait une 
tentative qui a été bloquée. 

1.	 Allez à Réseau > Screen Mirroring > Gest. périph.. Le téléviseur affiche une liste des dispositifs que vous 
avez connectés au téléviseurs auparavant, ou dont la connexion au téléviseur a déjà été bloquée. L'état de la 
connexion est également affiché (Permettre/Bloquer).

2.	 Sélectionnez un dispositif. Une fenêtre contextuelle s'affiche.

3.	 Dans la fenêtre contextuelle, vous pouvez choisir de Permettre la connexion, de la Bloquer ou de Supprimer 
le dispositif de la liste.
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Connecter des appareils mobiles sans utiliser de routeur sans fil (Wi-Fi 
Direct)
Allez à MENU > Réseau > Wi-Fi Direct Ess. maint.

Vous pouvez connecter un appareil mobile qui prend en charge la fonction Wi-Fi Direct directement au téléviseur, 
sans utiliser un routeur ou un point d'accès sans fil. Après avoir connecté un appareil mobile au téléviseur à l'aide de 
la fonction Wi-Fi Direct, vous pouvez lire sur le téléviseur des fichiers vidéo, de musique et de photos enregistrés 
sur l'appareil mobile.

"" Cette option est disponible uniquement sur un appareil mobile qui prend en charge la fonction Wi-Fi Direct. Veuillez 
vérifier si votre appareil mobile prend en charge Wi-Fi Direct.

"" L'image ou le son pourrait s'interrompre par intermittence selon l'état du réseau.

1.	 Activez Wi-Fi Direct sur l'appareil mobile, et ensuite allez à Réseau et sélectionnez Wi-Fi Direct sur le 
téléviseur. Le téléviseur recherche automatiquement la liste des appareils disponibles et l'affiche. Le nom du 
téléviseur s'affiche également sur l'appareil mobile.

2.	 Sélectionnez l'appareil dans la liste pour effectuer la connexion. Si une demande de connexion est faite par le 
téléviseur, un message d'autorisation s'affiche sur l'appareil portatif et vice-versa.

3.	 Acceptez la connexion. Une connexion s'établit entre le téléviseur et l'appareil mobile.

Connexion au moyen de Samsung Link
Samsung Link pour permet de lire les fichiers vidéo, de photos et de musique enregistrés sur un appareil mobile 
pour lequel Samsung Link est activé. Vous pouvez également, grâce à Samsung Link, lire le contenu d'un appareil 
mobile que vous avez enregistré dans Samsung Link à l'aide de votre compte Samsung, et ce, même si l'appareil 
mobile et le téléviseur ne sont pas connectés au même routeur ou point d'accès.
1.	 Exécutez l'application Samsung Link sur l'appareil mobile, puis connectez-vous à votre compte Samsung.

"" Pour utiliser Samsung Link, vous devez vous connecter à votre compte Samsung. Si vous n'avez pas de compte 
Samsung, vous devrez tout d'abord en créer un.

2.	 Accéder aux photos, vidéos et fichiers musicaux enregistrés sur un dispositif mobile, et les lire.

"" Pour de plus amples renseignements sur l'utilisation du logiciel mobile Samsung Link, reportez à la section d'aide du 
logiciel.
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Connexion par DLNA en utilisant votre réseau domestique
Vous pouvez accéder rapidement aux fichiers photo, vidéo et de musique enregistrés sur un appareil mobile et les 
lire sur le téléviseur.
1.	 Branchez le téléviseur et l'appareil mobile au même routeur ou point d'accès. Une fois qu'ils sont connectés à 

un seul routeur ou point d'accès, un réseau domestique est configuré.

"" DLNA est une technologie qui permet de partager du contenu entre les téléviseurs, les ordinateurs et les appareils 
mobiles au moyen d'un routeur câblé ou sans fil.

2.	 Permettre le partage des fichiers d'un appareil mobile. Vous pouvez lire sur le téléviseur le contenu partagé 
sur l'appareil mobile.

"" Tant que la fonction Partage de fichiers est activée, un accès non autorisé peut avoir lieu. Si vous n'avez pas besoin 
d'accéder à des données, désactivez le partage de fichiers.

Préciser le nom du téléviseur sur un réseau
MENU > Réseau > Nom de l'appareil Ess. maint.

Sélectionnez ou spécifiez une dénomination pour le téléviseur qui s'affiche sur les appareils mobiles et les 
ordinateurs portables.
1.	 Sélectionnez Nom de l'appareil à partir du menu Réseau puis choisissez un nom à partir de la liste qui 

s'affiche. Vous pouvez également sélectionner Entrée util. pour saisir un nom manuellement.

2.	 Vérifiez le nom à partir d'un appareil mobile ou un ordinateur portable.
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Passage d'une source vidéo à une autre
Appuyez sur la touche SOURCE pour basculer d'un appareil externe branché au téléviseur à un autre. Par exemple, 
pour basculer à une console de jeux branchée au deuxième connecteur HDMI, appuyez sur la touche SOURCE. La 
Liste source s'affiche dans la partie supérieure de l'écran. Dans la Liste source, sélectionnez HDMI2.

"" Les noms des connecteurs peuvent varier selon le modèle.

Autres fonctions disponibles lorsque vous affichez la Liste source
Diverses fonctions figurent dans le menu contextuel Options lorsque le téléviseur affiche la Liste source. Les 
fonctions qui figurent dans le menu Options varient en fonction de la source sélectionnée dans la Liste source et 
de l'appareil externe connecté à cette source.

Pour afficher le menu Options, appuyez sur la touche TOOLS ou appuyez sur la touche E et maintenez la 
pression.

Voici les fonctions qui peuvent figurer au menu Options :

●● Entrer le nom : permet d’assigner un nom d’appareil à une source d’entrée, par exemple, Blu-ray à HDMI1. 
Pour assigner un nom d’appareil à une source d’entrée, suivez la procédure ci-après :

1.	 Ouvrez la Liste source. Cette liste s'affiche dans une ligne horizontale au haut de l'écran. À l'aide de votre 
télécommande, mettez en évidence la source à laquelle vous voulez donner un nom.

2.	 Sélectionnez Entrer le nom dans le menu Options. Le clavier s'affiche à l'écran.

3.	 Entrez un nouveau nom à l'aide du clavier. Vous pouvez saisir 15 caractères ou moins.

4.	 Quand vous aurez terminé, sélectionnez DONE sur le clavier, puis appuyez sur la touche E.

●● Information : permet d'afficher de l'information détaillée sur les appareils branchés.

●● Retirer USB : permet de retirer un appareil USB branché au téléviseur en toute sécurité. Cette option est 
disponible uniquement lorsque le dispositif USB a été sélectionné.

●● Supprimer : permet de supprimer un appareil externe d'une source. Lorsque vous supprimez un appareil 
externe d'une source, vous supprimez les données sur l'appareil enregistrées par le téléviseur ainsi que le lien 
créé entre l'appareil et la source.

La fonction de télécommande universelle
Il est possible que cette fonction ne soit pas disponible dans tous les pays et pour tous les modèles.

Lorsque la Liste source s'affiche, la touche Conf. téléc. universelle s'affiche dans le coin supérieur droit de 
l'écran. Appuyez sur cette touche pour lancer la fonction de télécommande universelle. À l'aide de la fonction 
de télécommande universelle, vous pouvez commander des câblosélecteurs, des lecteurs Blu-ray, des chaînes de 
cinéma maison et d'autres appareils externes à l'aide de la télécommande de votre téléviseur. Reportez-vous à la 
section « Commande des appareils externes avec la télécommande - Utilisation de la télécommande universelle » 
pour de plus amples renseignements sur l'utilisation de la fonction de télécommande universelle.
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Affichage et utilisation de la télécommande à l'écran
Il se peut que la touche KEYPAD ne soit pas disponible selon le modèle ou la région.

Appuyez sur la touche KEYPAD de la télécommande pour que la télécommande à l'écran s'affiche. Utilisez la 
télécommande à l'écran pour entrer des chiffres, régler la lecture du contenu et utiliser les fonctions du téléviseur, 
comme avec une vraie télécommande.

"" Les touches de télécommande à l'écran peuvent varier en fonction du modèle de téléviseur et des fonctions que vous 
utilisez.

Touche Description

Web Browser Permet de lancer le navigateur Web.

PIP
Permet d'afficher les vidéos provenant d'un appareil externe ou d'un ordinateur à l'écran 
principal et une émission télévisée dans une fenêtre image sur image.

P.Mode Vous permet de sélectionner le Mode image.

Speaker Settings
Permet de sélectionner les haut-parleurs qui diffuseront le son du téléviseur. Vous devez 
brancher un système de cinéma maison ou un amplificateur avec des haut-parleurs externes 
au téléviseur pour utiliser cette fonction.

Gest. d'horaire Permet d'afficher l'écran Gestionnaire d'horaire.

MEDIA PLAY Permet de lire du contenu média enregistré sur des dispositifs USB.

MENU Permet d'afficher le menu du téléviseur à l'écran.

e-Manual Permet d'ouvrir le Guide électronique.

Utilisation de la télécommande et des périphériques
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Commande des appareils externes avec la télécommande – 
Utilisation de la télécommande universelle
MENU > Système > Config. télécommande universelle

Cette fonction pourrait ne pas être prise en charge en fonction du modèle ou de la région.

La fonction de télécommande universelle du téléviseur permet de contrôler le câblosélecteur, le lecteur Blu-ray, 
la chaîne de cinéma maison et d'autres appareils externes branchés au téléviseur à l'aide de la télécommande du 
téléviseur. Pour chacun des appareils externes que vous désirez commander, vous devez accomplir le processus 
de configuration de la télécommande universelle. La première étape de ce processus consiste à connecter le câble 
de relais IR (fourni) au téléviseur et à placer le bout du câble réservé au transmetteur devant l'appareil que vous 
désirez commander.

"" Certains appareils externes branchés au téléviseur pourraient ne pas prendre en charge la fonction de la télécommande 
universelle.

Connexion du câble de rallonge IR
"" La couleur et la conception du câble de rallonge IR peuvent varier selon le modèle.

Pour amorcer le processus de configuration de la télécommande universelle, branchez le câble de relais IR (fourni) 
à la sortie IR du téléviseur, tel qu'indiqué dans le diagramme. Placez ensuite le côté transmetteur du câble à 10 cm 
ou moins du capteur de signal de télécommande de l'appareil, et en direction du capteur.

Il ne doit pas y avoir d'obstacles entre l'extrémité transmetteur du câble de rallonge IR et l'appareil externe. Un 
obstacle constituerait une interférence à la transmission des signaux de la télécommande.
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Configuration de la télécommande universelle
"" Si vous voulez régler les commandes dans le cas d'un décodeur, vous devez avoir à portée de main le code postal, 

l'adresse et le nom du fournisseur du câble avant de commencer. Si vous voulez régler les commandes dans le cas d'un 
lecteur Blu-ray ou d'un système de cinéma maison, vous avez besoin du nom du fabricant et du numéro de modèle.

1.	 Mettez en marche l'appareil externe que vous voulez commander la fonction de la télécommande universelle.

2.	 Appuyez sur la touche SOURCE de la télécommande pour afficher l'écran Source.

3.	 Sélectionnez l'icône  Conf. téléc. universelle.

"" Vous pouvez également lancer la configuration de la télécommande universelle à partir du menu de votre téléviseur. 
Allez à Système > Config. télécommande universelle.

4.	 Le téléviseur vérifier si le câble de relais IR est branché. S'il confirme la connexion, appuyez sur la touche E.

5.	 Sélectionnez le type d'appareil que vous voulez commander, un décodeur, un lecteur Blu-ray ou un système 
de cinéma maison.

6.	 Suivez les instructions à l'écran pour terminer la configuration et enregistrer l'appareil. Les instructions 
diffèrent en fonction de l'appareil que vous voulez configurer.

"" Si après avoir enregistré l'appareil externe, celui-ci ne répond pas, enregistrez-le de nouveau à l'aide de son numéro 
de modèle. 

"" Vous devez placer l'unité Extender IR de sorte qu'elle soit en face de l'appareil externe afin de pouvoir en assurer le 
contrôle.

Commander un appareil externe à l'aide de la télécommande du téléviseur

Durant le processus de configuration de la télécommande universelle, le téléviseur enregistre le connecteur (la 
source) à laquelle l'appareil externe est branché. Pour commander un appareil externe enregistré à l'aide de la 
télécommande du téléviseur, sélectionnez l'appareil externe dans la Liste source.
1.	 Appuyez sur la touche SOURCE de votre télécommande.

2.	 Sélectionnez la source (connecteur ) à laquelle l'appareil est branché (HDMI1, HDMI2, etc.) S'il s'agit d"un 
lecteur Blu-ray, d'un système de cinéma maison ou d'un appareil similaire, l'écran d'accueil ou le menu de 
l'appareil en question s'affiche à l'écran du téléviseur. S'il s'agit d'un décodeur, une chaîne s'affiche à l'écran.

3.	 Pour commander l'appareil, pointer la télécommande vers le capteur IR du téléviseur.
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Fonctions de la télécommande universelle
1.	 Appuyez sur la touche SOURCE pour afficher la liste Source.

2.	 Sélectionnez  Conf. téléc. universelle dans la partie supérieure de l'écran. Le processus de configuration de 
la télécommande universelle s'amorce.

3.	 Sélectionnez un appareil externe enregistré à l'écran Conf. téléc. universelle. Les options suivantes sont 
disponibles :

●● Utiliser avec décodeur

Fonction audio d'un décodeur branché à un système de cinéma maison relié au téléviseur.
"" Cette fonction est disponible uniquement si vous avez sélectionné un décodeur à l'étape 3 et qu'un système de 

cinéma maison est branché au téléviseur.

●● Utiliser avec lecteur Blu-ray

Fonction audio d'un lecteur Blu-ray branché à un système de cinéma maison relié au téléviseur.
"" Cette fonction est disponible uniquement si vous avez sélectionné un lecteur Blu-ray à l'étape 3 et qu'un 

système de cinéma maison est branché au téléviseur.

●● Utiliser avec cinéma maison

Fonction audio d'un appareil externe branché à un système de cinéma maison.
"" Cette fonction est disponible uniquement si vous avez sélectionné un décodeur ou un lecteur Blu-ray à l'étape 

3 et qu'un système de cinéma maison est branché au téléviseur.

●● Config. de la source

Changer la source d'entrée du téléviseur pour l'appareil externe sélectionné.

●● Marche TV synchron.

Lorsqu'il est réglé sur On, le décodeur branché se désactive lorsque vous éteignez le téléviseur.
"" Cette fonction est disponible uniquement si vous avez sélectionné un décodeur à l'étape 3. Vous pouvez 

synchroniser uniquement la mise sous tension du téléviseur avec un décodeur.

●● Renommer

Permet de renommer l'appareil externe enregistré. Le nouveau nom peut contenir jusqu'à 15 caractères.

●● Supprimer

Retirer l'appareil externe de la liste des appareils enregistrés. L'appareil n'est plus enregistré et vous ne 
pouvez plus le commander à l'aide de la fonction de télécommande universelle.
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Commander le téléviseur à l'aide d'un clavier
MENU > Système > Gest. périph. > Réglages du clavier Ess. maint.

En branchant un clavier, vous pouvez contrôler en toute facilité la plupart des fonctions du téléviseur.
"" Certains modèles ne prennent pas en charge les claviers de classe USB HID.

Branchement d'un clavier

Branchement d'un clavier USB

Branchez le câble du clavier au port USB du téléviseur. Un message de connexion s'affiche à l'écran.

Utilisation du clavier
Utilisez les fonction de la télécommande ci-dessous grâce au clavier USB branché au téléviseur.

●● Touches fléchées (modifient le focus), touche Windows (touche MENU), touche liste de menus (touche 
TOOLS), touche Entrée (sélection et activation des éléments), touche Échap (touche RETURN) et touches 
numériques (touches numériques).

●● F1 (a), F2 (b), F3 ({), F4 (}), F5 ( ), F6 (touche SOURCE), F7 (Liste CH), F8 (touche¢), F9/F10 (touches 
de volume), F11/F12 (touches des chaînes)

●● Page précédente/Page suivante : défiler vers le haut ou le bas dans le navigateur Web.

Changer de clavier Ess. maint.

Sélectionnez Système > Gest. périph. > Réglages du clavier > Sélectionner clavier. Permet de choisir le clavier à 
utiliser.

"" Il n'est possible d'utiliser qu'un seul clavier à la fois.
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Saisie des langues, du type de clavier et changement de la clé langue

Sélectionnez Système > Gest. périph. > Réglages du clavier > Options de clavier. Les options suivantes sont 
disponibles : Ess. maint.

●● Langue du clavier

Si le clavier prend en charge plusieurs langues, sélectionnez celle que vous voulez utiliser dans la liste.

●● Type de clavier

Faites correspondre le type de clavier à la langue sélectionnée sous Langue du clavier.

"" La liste Type de clavier varie en fonction de la langue sélectionnée dans Langue du clavier.

●● Changer langue saisie

Si le clavier prend en charge plusieurs langues, sélectionnez celui que vous voulez utiliser pour passer d'une 
langue à une autre.

Commander le téléviseur à l'aide d'une souris
MENU > Système > Gest. périph. > Réglages de souris Ess. maint.

En branchant une clavier, vous pouvez contrôler en toute facilité la plupart des fonctions du téléviseur.
"" Certains modèles ne prennent pas en charge les souris de classe USB HID.

Branchement d'une souris

Branchement d'une souris USB

Branchez le câble de la souris au port USB du téléviseur. Un message de connexion s'affiche à l'écran.
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Utilisation de la souris
Si une souris USB est branchée au téléviseur, un pointeur s'affiche à l'écran tu téléviseur. Vous pouvez utiliser ce 
pointeur pour commander le téléviseur, exactement comme vous le feriez sur un ordinateur.

●● Sélection et exécution d'un élément

Faites un clic de gauche avec votre souris.

●● Affichage des touches TOOLS

En cliquant à droite, vous affichez les touches Outils à l'écran, ce qui vous permet d'utiliser facilement les 
fonctions du téléviseur.

"" Les touches d'Outils peuvent varier selon la fonction que vous utilisez.

●● Défilement du menu ou de l'écran du téléviseur

Déplacez la molette de souris vers le haut ou le bas. Le menu ou l'écran du téléviseur défile alors vers le haut 
ou le bas.

●● Quitter le menu ou la fonction du téléviseur

Cliquez sur la touche X. Le menu se ferme.

"" La touche X s'affiche sur le menu du téléviseur lorsqu'une souris est utilisée. Le fait de cliquer à gauche une fois en 
utilisant une fonction permet d'afficher la touche X sur l'écran en cours.

Changer de souris Ess. maint.

Sélectionnez Système > Gest. périph. > Réglages de souris > Sélect. une souris. Permet de choisir la souris à utiliser.
"" Vous pouvez utiliser une seule souris en même temps.

Modifier les boutons de la souris et la vitesse du pointeur Ess. maint.

Sélectionnez Système > Gest. périph. > Réglages de souris > Options souris. Les options suivantes sont disponibles 
:

●● Bouton principal

Sélectionnez la touche (gauche ou droite) à utiliser pour sélectionner et exécuter les options.

●● Vitess pointeur

Ajustez la vitesse de déplacement du pointeur apparaissant à l'écran.
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Saisir du texte à l'aide du clavier QWERTY à l'écran
Un clavier QWERTY apparaît à l'écran lorsque vous devez saisir du texte (saisie du mot de passe réseau, ouverture 
de session de votre compte Samsung, etc.), vous permettant de saisir du texte à l'aide de votre télécommande.

Utilisation de fonctions supplémentaires
Sélectionnez  à l'écran du clavier QWERTY. Les options suivantes sont disponibles :

●● Texte recommandé

Activer/désactiver la fonction Texte recommandé. L'activation de la fonction Texte recommandé vous 
permet de saisir rapidement du texte en commençant par les caractères que vous avez tapés en affichant 
les mots recommandés. Par exemple, pour saisir le mot « Internet », il vous suffit de taper « In » et de 
sélectionner le mot « Internet » dans la liste des mots suggérés. Le mot est mémorisé afin que vous puissiez 
saisir le même texte à nouveau plus facilement.

●● Restaurer les données texte recommandées

Supprimez les mots recommandés et les mots mémorisés pour effacer la liste.

●● Prédire la prochaine lettre

Activer/désactiver la fonction Prédiction textuelle. Lorsque la fonction Prédiction textuelle est activée, vous 
n'avez pas besoin de trouver les touches de caractères ou d'appuyer dessus. Par exemple, pour saisir le mot 
« Internet », sélectionnez « I ». Un mot suggéré s'affichera à côté de la lettre « I ». Il vous suffit de sélectionner 
le mot suggéré « Internet ».

"" Cette fonction dépend des mots que vous avez ajoutés au dictionnaire préalablement.
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Connexion à Internet câblée
Lorsque vous connectez le téléviseur à Internet, vous avez accès à des services en ligne et à des fonctions Smart, et 
vous pouvez mettre à jour rapidement et facilement le logiciel du téléviseur.

Utilisation de câbles LAN CAT 7
Nous vous recommandons d'utiliser des câbles réseau de catégorie 7.

"" La vitesse de votre connexion à Internet doit être supérieure à 10 Mbps pour que le téléviseur puisse se connecter à 
Internet.

Vous pouvez brancher le téléviseur aux points d'accès Internet de trois façons. En utilisant des câbles Cat 7, 
branchez le téléviseur aux points d'accès Internet de l'une de façons illustrées ci-dessous.

●● Modem externe

●● ① Routeur IP + ② Modem externe

Connexion Internet
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●● Prise LAN murale

Connexion automatique à un réseau Internet câblé
MENU > Réseau > Paramètres réseau Ess. maint.

Connexion automatique au réseau disponible
1.	 Réglez le Type de réseau à Câble, puis sélectionnez Connexion.

2.	 Le téléviseur tente de se connecter à un réseau disponible. Une fois la connexion établie, un message de 
confirmation s'affiche. Sélectionnez OK. En cas d'échec, essayez à nouveau ou établissez la connexion 
manuellement.
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Connexion manuelle à un réseau Internet câblé
MENU > Réseau > Paramètres réseau

Dans le cas où le réseau exige une adresse IP statique, saisissez l'adresse IP, le masque de sous-réseau, la passerelle 
et les valeurs DNS permettant de se connecter manuellement au réseau. Communiquez avez votre fournisseur 
d'accès Internet pour obtenir ces données.

"" Pour de plus amples renseignements sur les adresse IP dynamiques et IP statiques, reportez-vous à la section « Adresses 
IP dynamiques et statiques ».

1.	 Réglez le Type de réseau à Câble, puis sélectionnez Connexion.

Paramètres réseau
Sélectionnez le type de réseau

Type de réseau Câble

Connexion

Vous pouvez connecter 
TV à Internet.

2.	 Sélectionnez Arrêter lorsque le téléviseur tente de se connecter au réseau. Une fois la connexion réseau 
interrompue, sélectionnez Param. IP.

Paramètres réseau
Vérification de la connexion annulée.

Test de connexion au réseau câblé arrêté.

Changer réseau Param. IP Réessayer Fermer
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3.	 À l'écran Paramètres IP, réglez Param. IP à Entrer manuellement.

Param. IP

Param. IP	 Entrer manuellement

Adresse IP	 0.0.0.0
Masque s.-réseau	 0.0.0.0

Passerelle	 0.0.0.0

Param. DNS	 Entrer manuellement

Serveur DNS	 0.0.0.0

OK Annuler

4.	 Sélectionnez Adresse IP. Lorsque la fenêtre de saisie d'adresse IP s'affiche, entrez trois chiffres dans chaque 
champ sur la ligne d'adresse IP. Si la valeur comporte moins de trois chiffres, ajoutez des zéros au début. 
Par exemple, pour entrer 10, entrez 010. Une fois que trois chiffres sont entrés dans un champ, la mise en 
évidence passe automatiquement au champ suivant.

"" Entrez des chiffres en appuyant sur les touches chiffrées. Une fois tous les champs remplis, appuyez de nouveau sur 
la touche E.

5.	 Répétez ces étapes pour les champs Masque s.-réseau, Passerelle et Serveur DNS.

6.	 Une fois terminé, sélectionnez OK.

7.	 Le téléviseur tente à nouveau de se connecter au réseau à l'aide des paramètres saisis. Une fois la connexion 
établie, un message de confirmation s'affiche. Sélectionnez OK.

"" La vitesse du réseau peut varier en fonction des réglages du serveur DNS.

"" Pour de plus amples renseignements sur les réglages du serveur DNS, communiquez avec votre fournisseur de 
services Internet.
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Connexion à Internet sans fil
Lorsque vous connectez le téléviseur à Internet, vous avez accès à des services en ligne et à des fonctions Smart, et 
vous pouvez mettre à jour rapidement et facilement le logiciel du téléviseur.

Connexion automatique à un réseau Internet sans fil
MENU > Réseau > Paramètres réseau

Connectez le téléviseur à l'Internet à l'aide d'un routeur sans fil. Assurez-vous d'être en possession du SSID (nom) 
et du mot de passe du routeur sans fil avant de tenter de vous connecter. Vous pouvez trouver le mot de passe sur 
l'écran de configuration du routeur sans fil.
1.	 À l'écran Paramètres réseau, réglez Type de réseau à Sans fil. Le téléviseur affiche automatiquement une liste 

des réseaux sans fil disponibles.

2.	 Sélectionnez un réseau. Si le routeur sans fil souhaité ne figure pas dans la liste, sélectionnez Ajouter réseau 
et saisissez manuellement le SSID (nom) du réseau.

3.	 Entrez le mot de passe à l'aide du clavier qui s'affiche à l'écran. Quand vous avez terminé, sélectionnez Fait. 
Si la fonction sécurité n'est pas activée sur le réseau sélectionné, le clavier n'apparaîtra pas à l'écran et le 
téléviseur tentera immédiatement une connexion.

–– Pour sélectionner un caractère sur le clavier à l'écran, mettez-le en évidence, puis sélectionnez-le. 
Sélectionnez la touche Maj pour voir les majuscules. Sélectionnez la touche 123#& pour voir d'autres 
caractères.

–– Pour voir les caractères que vous entrez, sélectionnez Aff. mot de p..

4.	 Le téléviseur tente de se connecter au réseau. Une fois la connexion établie, le téléviseur affiche un 
message de confirmation. Sélectionnez OK. En cas d'échec, essayez à nouveau ou établissez la connexion 
manuellement.
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Connexion manuelle à un réseau Internet sans fil
MENU > Réseau > Paramètres réseau

Dans le cas où le réseau exige une adresse IP statique, saisissez l'adresse IP, le masque de sous-réseau, la passerelle 
et les valeurs DNS permettant de se connecter manuellement au réseau. Pour obtenir ces données, veuillez 
communiquer avec votre fournisseur d'accès Internet.

"" Pour de plus amples renseignements sur les adresse IP dynamiques et IP statiques, reportez-vous à la section « Adresses 
IP dynamiques et statiques ».

1.	 À l'écran des réglages de réseau, réglez Type de réseau à Sans fil. Le téléviseur affiche automatiquement une 
liste des réseaux sans fil disponibles.

Paramètres réseau
Sélectionnez le type de réseau

Type de réseau Sans fil

Réseau sans fil

AP0000
Vous pouvez connecter TV à 

Internet. Veuillez choisir le réseau 

sans fil à utiliser.

AP0001

Ajouter réseau

Rafraîchir WPS (PBC)

2.	 Sélectionnez un réseau. Si le routeur sans fil souhaité ne figure pas dans la liste, sélectionnez Ajouter réseau 
et saisissez manuellement le SSID (nom) du réseau.

3.	 Entrez le mot de passe à l'aide du clavier qui s'affiche à l'écran. Quand vous avez terminé, sélectionnez Fait. 
Si la fonction sécurité n'est pas activée sur le réseau sélectionné, le clavier n'apparaîtra pas à l'écran et le 
téléviseur tentera immédiatement une connexion.

–– Pour sélectionner un caractère sur le clavier à l'écran, mettez-le en évidence, puis sélectionnez-le. 
Sélectionnez la touche Maj pour voir les majuscules. Sélectionnez la touche 123#& pour voir d'autres 
caractères.

–– Pour voir les caractères que vous entrez, sélectionnez Aff. mot de p..

4.	 Sélectionnez Arrêter lorsque le téléviseur tente de se connecter au réseau. Une fois la connexion réseau 
interrompue, sélectionnez Param. IP.

Paramètres réseau
Vérification de la connexion annulée.

Test de connexion au réseau sans fil arrêté.

Changer réseau Param. IP Réessayer Fermer
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5.	 À l'écran Paramètres IP, réglez Param. IP à Entrer manuellement.

Param. IP

Param. IP	 Entrer manuellement

Adresse IP	 0.0.0.0
Masque s.-réseau	 0.0.0.0
Passerelle	 0.0.0.0

Param. DNS	 Entrer manuellement

Serveur DNS	 0.0.0.0

OK Annuler

6.	 Sélectionnez Adresse IP. Lorsque la fenêtre de saisie d'adresse IP s'affiche, entrez trois chiffres dans chaque 
champ sur la ligne d'adresse IP. Si la valeur comporte moins de trois chiffres, ajoutez des zéros au début. 
Par exemple, pour entrer 10, entrez 010. Une fois que trois chiffres sont entrés dans un champ, la mise en 
évidence passe automatiquement au champ suivant.

"" Entrez des chiffres en appuyant sur les touches chiffrées. Une fois tous les champs remplis, appuyez de nouveau sur 
la touche E.

7.	 Répétez ces étapes pour les champs Masque s.-réseau, Passerelle et Serveur DNS.

8.	 Une fois terminé, sélectionnez OK.

9.	 Le téléviseur tente à nouveau de se connecter au réseau à l'aide des paramètres saisis. Une fois la connexion 
établie, un message de confirmation s'affiche. Sélectionnez OK.

"" La vitesse du réseau peut varier en fonction des réglages du serveur DNS.

"" Pour de plus amples renseignements sur les réglages adéquats du serveur DNS, communiquez avec votre 
fournisseur de services Internet.

Connexion à un réseau Internet sans fil avec WPS
MENU > Réseau > Paramètres réseau

Si le routeur est pourvu d'une touche WPS, vous pouvez l'utiliser pour connecter automatiquement le téléviseur au 
routeur. WPS configurera automatiquement les clés SSID et WPA.

●● Le routeur doit prendre en charge la technologie WPS afin de pouvoir utiliser la fonctionnalité WPS.

1.	 À l'écran Paramètres réseau, réglez Type de réseau à Sans fil. Le téléviseur affiche automatiquement une liste 
des réseaux sans fil disponibles.

2.	 Sélectionnez WPS (PBC) puis appuyez sur la touche WPS ou PBC du routeur dans les deux minutes.

3.	 Le téléviseur obtient automatiquement les réglages associés au SSID et au mot de passe, puis se connecte au 
réseau. Une fois la connexion établie, le téléviseur affiche un message de connexion. Sélectionnez OK.
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Résolution de problèmes de connectivité à Internet
Si vous ne pouvez pas brancher le téléviseur à Internet, lisez les renseignements ci-dessous.

Résolution de problèmes de connectivité câblée à Internet

Aucun câble réseau détecté Ess. maint. Ess. maint.

Vérifiez que le câble réseau est branché. Si c’est le cas, vérifiez que le routeur est sous tension. Dans ce cas, 
éteignez-le et rallumez-le.

Échec de la configuration automatique de l’adresse IP Ess. maint.

Effectuez les étapes suivantes ou configurez le réglage Param. IP manuellement.
1.	 Veillez à ce que le serveur DHCP soit activé sur le routeur et réinitialisez le routeur.

2.	 Si la configuration ne fonctionne toujours pas, communiquez avec votre fournisseur Internet pour en savoir 
davantage.

Impossible de se connecter au réseau Ess. maint.

Suivez les étapes ci-après :
1.	 Vérifiez toutes les valeurs dans Param. IP.

2.	 Veillez à ce que le serveur DHCP soit activé sur le routeur. Puis, débranchez et rebranchez le routeur.

3.	 Si la configuration ne fonctionne toujours pas, communiquez avec votre fournisseur Internet pour en savoir 
davantage.

La connexion au réseau local a été établie, mais impossible de se connecter à Internet Ess. maint.

1.	 Vérifiez que le câble LAN Internet est branché correctement au port LAN externe du routeur.

2.	 Vérifiez les valeurs DNS dans Param. IP.

3.	 Si le problème persiste, communiquez avec votre fournisseur Internet.
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La configuration du réseau est terminée, mais impossible de se connecter à Internet Ess. maint.

Si le problème persiste, communiquez avec votre fournisseur Internet.

Résolution de problèmes de connectivité sans fil à Internet

La connexion au réseau sans fil a échoué, Ess. maint. Ess. maint.

Le routeur sans fil sélectionné introuvable. Allez à Paramètres réseau et sélectionnez le bon routeur.

Impossible de se connecter à un routeur sans fil Ess. maint. Ess. maint.

Essayez les solutions suivantes :
1.	 Vérifiez que le routeur est sous tension. Si c'est le cas, éteignez-le et rallumez-le.

2.	 Entrez le bon mot de passe, si nécessaire.

Échec de la configuration automatique de l’adresse IP Ess. maint.

Effectuez les étapes suivantes ou configurez le réglage Param. IP manuellement.
1.	 Veillez à ce que le serveur DHCP soit activé sur le routeur. Puis, débranchez et rebranchez le routeur.

2.	 Entrez le bon mot de passe, si nécessaire.

3.	 Si la configuration ne fonctionne toujours pas, communiquez avec votre fournisseur Internet pour en savoir 
davantage.

Impossible de se connecter au réseau Ess. maint.

Suivez les étapes ci-après :
1.	 Vérifiez toutes les valeurs dans Param. IP.

2.	 Entrez le bon mot de passe, si nécessaire.

3.	 Si la configuration ne fonctionne toujours pas, communiquez avec votre fournisseur Internet pour en savoir 
davantage.
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La connexion au réseau local a été établie, mais impossible de se connecter à Internet Ess. maint.

1.	 Vérifiez que le câble LAN Internet est branché correctement au port LAN externe du routeur.

2.	 Vérifiez les valeurs DNS dans Param. IP.

3.	 Si le problème persiste, communiquez avec votre fournisseur Internet.

La configuration du réseau est terminée, mais impossible de se connecter à Internet Ess. maint.

Si le problème persiste, communiquez avec votre fournisseur Internet.

Vérification de l'état de la connexion réseau
MENU > Réseau > État du réseau Ess. maint.

Réseau

État du réseau

Paramètres réseau

Wi-Fi Direct

Paramètres de l’appareil multimédia

Screen Mirroring

Nom de l'appareil	 [TV]Samsung L…

"" Selon le modèle de votre téléviseur, le menu affiché peut différer de l'image ci-dessus.

Visualisez l'état actuel du réseau et d'Internet.
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Smart Hub
MENU > Smart Hub > Ouvrir Smart Hub Ess. maint.

Smart Hub vous permet de naviguer sur le Web et de télécharger des applications.
"" Vous devez payer pour obtenir certains services Smart Hub. Pour utiliser un service à la carte, vous devez avoir un 

compte auprès d'un fournisseur de services, ou encore un compte Samsung Apps pour votre téléviseur. Reportez-vous à 
la section « Utiliser Smart Hub à l'aide d'un compte Samsung » pour avoir plus de renseignements.

"" Le téléviseur doit être connecté à Internet pour accéder à Smart Hub.

"" Il est possible que certaines fonctions de Smart Hub ne soient pas disponibles en fonction du fournisseur de service, de la 
langue ou de la région.

"" Pour utiliser Smart Hub, vous devez accepter le contrat d'utilisation et la politique de confidentialité. Si vous ne le faites 
pas, vous n'aurez pas accès aux fonctions et aux services associés à ces documents. Vous pouvez voir l'ensemble du texte 
des Conditions et politique en vous rendant à Smart Hub > Conditions et politique. Si vous désirez cesser d'utiliser Smart 
Hub, vous pouvez résilier l'entente. Ess. maint.

"" Des interruptions de services de Smart Hub peuvent être causées par des perturbations de votre service Internet.

Essai des connexion Smart Hub
MENU > Support technique > Autodiagnostic > Test de connexion à Smart Hub

Si Smart Hub ne fonctionne pas, allez à Support technique > Autodiagnostic > Test de connexion à Smart Hub. 
Diagnostiquez le problème en vérifiant la connexion Internet, votre fournisseur d'accès Internet, le serveur 
Samsung et les panneaux d'applications Samsung.

"" Une fois le test terminé, si Smart Hub continue à présenter des problèmes, communiquez avec votre fournisseur de 
services Internet ou un centre de service à la clientèle Samsung.

Fonctions Smart
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Ouvrir l'Premier Écran
Appuyez sur la touche  alors que vous regardez la télévision pour ouvrir l'Premier Écran.

À l'Premier Écran, cherchez dans les applications, chaînes ou sources favorites, et accédez aux fonctions lancées 
antérieurement ou fréquemment utilisées.

Configuration de votre élément favori

1.	 Appuyez sur la touche  pour ouvrir l'Premier Écran, puis passez à un élément désiré.

2.	 Appuyez sur la touche E et maintenez la pression. Le menu Options s'affiche.

3.	 Dans le menu Options, sélectionnez Ajouter aux favoris pour ajouter l'élément sélectionné à la liste de 
favoris; celui-ci parviendra alors au haut de liste.

"" Pour supprimer un élément favori, sélectionnez-le, et ensuite appuyez sur la touche E en maintenant la pression 
pour afficher le menu contextuel. Ensuite, sélectionnez Supprimer des favoris.

Suppression de l'historique de navigation

1.	 Appuyez sur la touche  pour ouvrir l'option Premier Écran, et sélectionnez Effacer tout. Le programme 
vous demandera de confirmer votre sélection.

2.	 Sélectionnez la touche OK à l'écran. Votre historique de navigation est entièrement effacé.

"" Toutefois, les éléments de la liste de favoris ne seront pas supprimés.

"" Vous pouvez également supprimer l'historique de votre navigation en sélectionnant la fonction Effacer tout au 
menu Smart Hub > Paramètres Premier Écran.
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Passage à l'écran Panneau
Appuyez sur la touche  pour ouvrir l'Premier Écran, puis sélectionnez l'icône Panneau. À l'écran Panneau, pour 
chaque panneau de service, les éléments suivants sont disponibles :

●●  SAMSUNG APPS

Vous pouvez profiter de diverses applications gratuites et à la carte dans les domaines des actualités, des 
sports, de la météo et des jeux, comme vous le feriez sur un téléphone intelligent ou une tablette.

Utilisation de la fonction Didacticiel Smart Hub
MENU > Support technique > Didacticiel Smart Hub

Sélectionnez Support technique > Didacticiel Smart Hub. Le tutoriel offre une introduction aux connaissances de 
base nécessaires pour utiliser Smart Hub et les panneaux Smart Hub.

Réinitialiser Smart Hub
MENU > Fonctions Smart > Réinitialisation de Smart Hub

La fonction de réinitialisation Smart Hub Reset vous permet de supprimer de votre téléviseur tous les comptes 
Samsung et tous les éléments associés, y compris les applications. Pour accéder à la fonction Smart Hub Reset, 
vous devez entrer votre mot de passe Smart Hub.

Pour utiliser Smart Hub à nouveau après l'avoir réinitialisé, vous devez de nouveau accepter les modalités.

Ouvrez le menu Système, sélectionnez l'option Configuration, et suivez la procédure de configuration initiale.



36 37

Utiliser Smart Hub à l'aide d'un compte Samsung

Compte Samsung

Connec.

Modifier profil

Lier des comptes de service

Supprimer comptes téléviseur

Créer compte

Conditions et confidentialité

"" Selon le modèle de votre téléviseur, le menu affiché peut différer de l'image ci-dessus.

Création d'un compte Samsung
MENU > Smart Hub > Compte Samsung

Vous devez payer pour obtenir certains services Smart Hub. Pour utiliser un service à la carte, vous devez avoir un 
compte auprès d'un fournisseur de services, ou encore un compte Samsung Apps pour votre téléviseur.

Vous pouvez créer un compte Samsung en utilisant votre adresse de courriel comme nom d'utilisateur.
"" Vous devez accepter le contrat d'utilisation et la politique de confidentialité pour créer un compte Samsung. Sinon, vous 

ne pouvez créer un compte Samsung. Vous pouvez voir le contrat dans son intégralité en vous dirigeant vers Smart Hub 
> Compte Samsung > Conditions et confidentialité.

"" Vous pouvez également créer un compte Samsung au http://content.samsung.com. Une fois votre compte créé, vous 
pouvez utiliser le même nom d'utilisateur sur votre téléviseur et sur le site Web de Samsung.
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Créer un compte Samsung grâce au menu de création de compte Samsung

1.	 Appuyez sur la touche MENU de votre télécommande, puis sélectionnez Smart Hub > Compte Samsung > 
Créer compte > Créer un compte Samsung. L'écran des Conditions générales s'affiche.

2.	 Appuyez sur la touche E pour accepter les Conditions d'utilisation, puis appuyez de nouveau sur la touche 
E.

"" Pour consulter les Conditions générales, sélectionner les touches Afficher les détails.

3.	 Sélectionnez le champ Courriel. Une fenêtre contextuelle apparaît et affiche un clavier. Entrez votre adresse 
de courriel. Utilisez les touches directionnelles pour passer d'un caractère à l'autre, et ensuite appuyez sur la 
touche E pour sélectionner un caractère. Appuyez sur la touche Caps situé à gauche pour entrer des lettres 
majuscules. Appuyez sur la touche 123#& pour voir et sélectionner des symboles additionnels. Sélectionnez 
.com au bas du clavier pour entrer .com.

4.	 Lorsque c'est fait, sélectionnez Fait sur le clavier. L'écran Créer compte s'affiche.

5.	 Entrez un mot de passe, votre prénom et votre nom de famille de la même façon.

"" Si vous désirez protéger votre compte à l'aide d'un mot de passe, sélectionnez « Mot de passe (sécurité : élevée) » 
dans le champ qui se trouve sous le champ Mot de passe. Si vous le ne souhaitez pas, sélectionnez « Pas de mot de 
passe requis ». Vous devrez créer un mot de passe malgré tout. D'autres fonctions de votre compte exigent que 
vous entriez un mot de passe.

"" Laissez la case « Connecter automatiquement » cochée si vous désirez que le téléviseur se connecte 
automatiquement à votre compte lorsque vous mettez le téléviseur sous tension.

6.	 Sélectionnez le champ Date de naissance, et sélectionnez les chiffres grâce aux flèches vers le haut et le 
bas. Sur une télécommande standard, utilisez le pavé numérique. Pour passer vers les années, mois ou jours, 
utilisez les flèches vers la droite et la gauche. Appuyez sur la touche RETURN de la télécommande standard 
lorsque vous avez terminé.

7.	 Quand vous en aurez terminé dans ces champs, sélectionnez Suivant. L'écran de sélection d'images s'affiche.

8.	 Sélectionnez une image qui identifiera votre compte. L'écran « Compte créé » s'affiche. Appuyez sur la 
touche E. Vous êtes connecté à votre compte Samsung.

"" Si vous avez déjà enregistré un compte sur le téléviseur, vous devez vous en déconnecter pour être en mesure de 
créer de nouveaux comptes sur le téléviseur.
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Créer un compte Samsung à partir d'un compte Facebook

Si vous avez un compte Facebook, vous pouvez l'utiliser pour créer un compte Samsung.
1.	 Appuyez sur la touche MENU de votre télécommande, puis sélectionnez Smart Hub > Compte Samsung. 

Ensuite, sélectionnez Connec.. L'écran Connexion s'affiche.

2.	 Sélectionnez , puis sélectionnez Créer avec Facebook à l'écran Connexion.

3.	 Entrez votre nom d'utilisateur et votre mot de passe Facebook et sélectionnez Connexion.

4.	 L'écran des Conditions générales s'affiche.

5.	 Appuyez sur la touche E pour accepter les Conditions d'utilisation, puis appuyez de nouveau sur la touche 
E.

6.	 Pour créer un compte Samsung, suivez les directives qui figurent à l'écran Créer compte.

7.	 Dès qu'un compte Samsung a été créé, vous y êtes automatiquement connecté.

"" Si vous avez utilisé votre compte Facebook pour créer un compte Samsung, les deux comptes seront 
automatiquement liés.

Se connecter à un compte Samsung
MENU > Smart Hub > Compte Samsung > Connec.
1.	 Appuyez sur la touche MENU de votre télécommande, puis sélectionnez Smart Hub > Compte Samsung > 

Connec..

2.	 À l'écran Connexion, sélectionnez votre compte. Sélectionnez la fonction Connexion à l'écran Connexion.

3.	 Si vous n'avez pas besoin d'entrer de mot de passe, la connexion s'amorce. Si vous devez entrer un mot de 
passe, un clavier s'affiche à l'écran. Entrez votre mot de passe. Quand vous avez terminé, sélectionnez Fait.
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Lier votre compte Samsung à des comptes de services externes
MENU > Smart Hub > Compte Samsung > Lier des comptes de service

Lorsque vous liez votre compte Samsung à d'autres comptes, vous vous connectez automatiquement à ces 
comptes en vous connectant à votre compte Samsung. Par exemple, vous pourriez télécharger l'application 
Facebook afin d'accéder à Facebook à partir de votre téléviseur et puis lier votre compte Samsung à votre compte 
Facebook. En vous connectant à votre compte Samsung, vous vous connecterez automatiquement à votre compte 
Facebook et pourrez ainsi accéder à Facebook directement à partir de votre téléviseur.

"" Pour utiliser Lier des comptes de service, vous devez d'abord ouvrir une session dans votre compte Samsung.

Lier un compte de service

1.	 Connectez-vous à votre compte Samsung.

2.	 Allez à Smart Hub > Compte Samsung, puis sélectionnez Lier des comptes de service. Les comptes que vous 
pouvez lier à votre compte Samsung s'affichent.

3.	 Sélectionnez un compte dans la liste. La fenêtre Lier aux autres comptes apparaît à l'écran.

4.	 Entrez le nom d'utilisateur et le mot de passe actuels permettant de se connecter au compte, puis 
sélectionnez OK.

5.	 Une fois la connexion effectuée, le compte sera lié à votre compte Samsung.

Déconnexion d'un compte lié

1.	 Allez à Smart Hub > Compte Samsung et sélectionnez Lier des comptes de service. Sélectionnez un compte 
dont vous souhaitez briser le lien.

2.	 Une boîte de confirmation apparaît. Sélectionnez Oui pour briser le lien entre les comptes.
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Ajouter des renseignements à un compte Samsung, ou les modifier
MENU > Smart Hub > Compte Samsung

Vous pouvez gérer votre compte Samsung à partir du menu de celui-ci.
"" Pour modifier les renseignements sur votre compte, vous devez vous connecter à votre compte Samsung.

1.	 Allez à Smart Hub > Compte Samsung, puis sélectionnez Modifier profil. Le clavier s’affiche.

2.	 Entrez votre mot de passe, puis sélectionnez Fait. L'écran Modifier profil s'affiche.

L'écran Modifier profil vous permet de faire ce qui suit :

●● Modifier votre image de profil

Sélectionnez Modifier l’image de profil pour modifier votre image de profil.

●● Sélectionner une méthode de connexion à votre compte Samsung.

Sélectionnez Mode de connex et choisissez une méthode de connexion dans le menu déroulant qui s'affiche.

●● Activer ou désactiver la connexion automatique

Sélectionnez Connecter automatiquement. La connexion automatique vous connecte automatiquement 
à votre compte Samsung lorsque vous mettez votre téléviseur sous tension. Quand la case est cochée, la 
connexion automatique est activée.

●● Entrer les renseignements de base sur l'utilisateur

Vous pouvez entrer votre prénom, votre nom de famille et votre date de naissance.

●● Ajouter une carte de crédit à votre compte Samsung.

Sélectionnez Ajouter une carte pour ajouter une carte de crédit à votre compte Samsung. Le fait d'ajouter 
une carte de crédit à votre compte vous permet d'acheter plus facilement des films et des émissions. Suivez 
les directives simples qui s'affichent à l'écran.

●● S'abonner au bulletin Samsung

Vous pouvez recevoir des courriels contenant des renseignements sur les produits Samsung, les annonces de 
nouveaux services, les offres spéciales et les événements.

Supprimer un compte Samsung du téléviseur
MENU > Smart Hub > Compte Samsung > Supprimer comptes téléviseur

Allez à Smart Hub > Compte Samsung, puis sélectionnez Supprimer comptes téléviseur. Les renseignements 
associés au nom d'utilisateur et au mot de passe du compte actuellement connecté sont supprimés du téléviseur. 
Les renseignements associés aux comptes externes liés au compte actuellement connecté sont également 
supprimés du téléviseur.

"" Seuls les renseignements associés au compte actuellement connecté sont supprimés. Les renseignements associés aux 
autres compte enregistrés sur le téléviseur demeurent.



42

Utilisation du panneau SAMSUNG APPS
SAMSUNG APPS

Recommandé

Mes apps

Les plus populaires Nouveautés Catégories

"" La convivialité dépend de votre modèle particulier et de la région.

Smart Hub vous offre un éventail de contenus gratuits (nouvelles, sports, météo et jeux) que vous pouvez 
télécharger et dont vous pouvez profiter directement sur votre téléviseur. La première ligne qui s'affiche à l'écran 
comprend les applications recommandées par Samsung. Ces applications sont automatiquement téléchargées sur 
votre téléviseur dès que vous configurez Smart Hub. Les lignes d'applications qui suivent la première comprennent 
des applications qui ont été automatiquement téléchargées sur votre téléviseur et d'autres applications que vous 
avez sélectionnées et téléchargées.

"" Pour qu'il soit possible d'utiliser SAMSUNG APPS, le téléviseur doit être connecté à Internet.

"" Lorsque vous lancez Smart Hub pour la première fois, les applications par défaut sont installées automatiquement. Les 
applications installées par défaut peuvent varier en fonction de la région.
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Utiliser les fonctions prises en charge des applications téléchargées à l'aide 
du menu contextuel
Déplacez l'objectif vers une application de la deuxième rangée ou d'une autre rangée puis appuyez sur la touche 
E et maintenez la pression. Le menu Outils s'affiche et vous présente les fonctions ci-dessous.

●● Déplacer

Vous permet de changer la position d'une application à l'écran.

●● Supprimer

Vous permet de supprimer l'application sélectionnée de votre téléviseur.

●● Suppressions multiples

Vous permet de supprimer un groupe d'applications de votre téléviseur.

●● Afficher les détails

Permet d’afficher de l'information détaillée sur l'application sélectionnée.

●● Modifier le mode d'affichage

Vous permet de modifier la façon dont les applications sont triées à l'écran, soit par Personnalisé ou par Plus 
joués.

●● Verr./Déverr.

Vous permet de verrouiller ou de déverrouiller une application.

●● M. à jour app.

Présente une liste d'applications pour lesquelles des mises à jour sont disponibles. Vous pouvez sélectionner 
les applications qui seront mises à jour.
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Utiliser les fonctions prises en charge des applications recommandées à 
l'aide du menu contextuel
Déplacez l'objectif vers une application recommandée de la rangée supérieure, puis appuyez sur la touche E et 
maintenez la pression. Un menu déroulant comportant les fonctions ci-dessous s'affiche.

●● Afficher les détails

Permet d’afficher de l'information détaillée sur l'application sélectionnée.

●● M. à jour app.

Vous permet de mettre les applications à jour quand des mises à jour sont disponibles.

●● Verrouiller/Déverrouiller

Vous permet de verrouiller ou de déverrouiller une application.

Installer une application

Installation rapide

1.	 À l'écran SAMSUNG APPS, sélectionnez Les plus populaires, Nouveautés, ou Catégories.

"" Les fonctions Les plus populaires et Nouveautés vous présentent respectivement les applications Samsung les 
plus populaires, et les plus récentes. Pour consulter l'intégralité de la liste d'applications par genre, sélectionnez 
Catégories. Lorsque l'écran Catégories s'affiche, sélectionnez une icône de catégorie afin de voir les applications qui 
y correspondent.

2.	 Déplacez la cible de saisie sur une application, puis appuyez sur la touche E et maintenez la pression. Un 
menu contextuel s'affiche.

3.	 Dans le menu contextuel, sélectionnez Téléch..

"" Il est gratuit d'installer la plupart des applications.

"" Lors de l'installation d'une application, la barre de progression s'affiche au bas de l'icône de l'application, ce qui vous 
permet de constater où en est l'installation.

4.	 L'application sélectionnée est installée dans le téléviseur.

"" Vous pouvez voir les applications installées à l'écran SAMSUNG APPS.
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Installer une application à partir de l'écran d'information détaillée

1.	 À l'écran SAMSUNG APPS, sélectionnez Les plus populaires, Nouveautés, ou Catégories.

"" Les fonctions Les plus populaires et Nouveautés vous présentent respectivement les applications Samsung les 
plus populaires, et les plus récentes. Pour consulter l'intégralité de la liste d'applications par genre, sélectionnez 
Catégories. Lorsque l'écran Catégories s'affiche, sélectionnez une icône de catégorie afin de voir les applications qui 
y correspondent.

2.	 Sélectionnez une application dans la liste. Les renseignements détaillés sur votre sélection apparaissent à 
l'écran.

3.	 Sélectionnez Téléch. pour installer l'application sélectionnée sur le téléviseur.

"" Il est gratuit d'installer la plupart des applications.

"" Lors de l'installation d'une application, la barre de progression s'affiche au bas de l'icône de l'application, ce qui vous 
permet de constater où en est l'installation.

4.	 Une fois l'installation terminée, la touche Téléch. passe à Ouvrir.

"" Vous pouvez voir les applications installées à l'écran SAMSUNG APPS.

Remarques supplémentaires

"" Si l'espace disponible dans la mémoire interne du téléviseur ne permet pas l'installation d'une application, vous pouvez 
installer cette application sur une clé USB.

"" Vous pouvez voir les icônes des applications enregistrées sur une clé USB à l'écran Applications seulement si le dispositif 
est branché au téléviseur. Vous pouvez utiliser une application installée sur une clé USB uniquement lorsque la clé USB 
est branchée au téléviseur. L'application se ferme si la clé USB est retirée pendant l'exécution de l'application.

"" Vous pouvez utiliser une application installée sur une clé USB sur un ordinateur, ou un autre téléviseur.

Lancement d'une application

Sélectionnez une application à l'écran SAMSUNG APPS, puis appuyez sur la touche E. Vous pouvez également 
lancer une application à partir de son écran Détails.
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Utilisation de la fonction e-Manual

Lancement du guide électronique
MENU > Support technique > e-Manual

Le guide électronique intégré contient de l'information sur les principales fonctions du téléviseur.
"" Vous pouvez aussi télécharger une copie du guide électronique à partir du site Web de Samsung et le lire sur votre 

ordinateur ou l'imprimer.

"" Les mots apparaissant en jaune (par ex., Image Mode) indiquent qu'il s'agit d'un élément de menu item et les mots en gras 
apparaissant en blanc (par ex., Smart Hub) indiquent qu'il s'agit de touches sur la télécommande.

"" Les flèches servent à indiquer le chemin du menu. (Exemple : MENU > Image > Image Mode)

1.	 Appuyez sur la touche E-MANUAL de la télécommande. Vous pouvez également sélectionner Support 
technique > e-Manual dans le menu du téléviseur.

2.	 Sélectionnez une catégorie à gauche de l'écran. Lorsqu'une sélection est effectuée, le contenu de la catégorie 
sélectionnée s'affiche du côté droit de l'écran.

3.	 Sélectionnez un élément dans la liste. Le guide électronique s'ouvre alors à la page correspondante.

Si une description ne peut être affichée dans un seul écran...

●● Placez le pointeur sur la page à afficher  /  à l'écran. Appuyez sur le bouton < ou le bouton > pour 
faire défiler la page vers le haut ou vers le bas.

Fonctions supplémentaires du guide électronique

Chargement de pages à l'aide de mots clés

Sélectionnez Recherche pour afficher l'écran de recherche. Entrez le terme à rechercher, puis sélectionnez Fait. 
Sélectionnez un élément à partir des résultats de la recherche pour charger la page correspondante.

Chargement des pages à partir de la page d'index

Sélectionnez Index pour afficher l'écran de l'index. Sélectionnez un sujet dans la liste pour accéder à la page 
correspondante.
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Utilisation de l'historique pour charger les pages lues antérieurement

Sélectionnez Page ouverte. La liste des pages lues antérieurement s'affiche. Sélectionnez une page. Le guide 
électronique se déplace à la page sélectionnée.

Accès au menu à partir du guide électronique
Sélectionnez  (Ess. maint.) à droite sur une page de description d'une option pour accéder à l'élément de menu 
correspondant et essayez d'exécuter immédiatement l'option en question. Si vous voulez lire une rubrique du guide 
électronique portant sur une fonction de menu d'écran particulière :

–– Appuyez sur la touche e-Manual de la télécommande pour télécharger la page correspondante du guide 
électronique.

"" Certains menus à l'écran ne permettent pas d'accéder au Guide électronique.

Chargement des pages de référence
Sélectionnez  (Lien) du côté droit d'une page de description de fonction pour accéder à la page de référence 
correspondante.

Mise à jour du guide électronique en fonction de la version la plus récente
Vous pouvez mettre à jour le guide électronique de la même façon que vous mettez à jour les applications.

1.	 Appuyez sur la touche  pour ouvrir le Premier Écran, puis sélectionnez l'icône du Panneau. L’écran Panneau 
s’affiche.

2.	 Allez à l'écran SAMSUNG APPS et mettez en évidence le e-Manual.

3.	 Appuyez sur la touche E et maintenez la pression. Le menu « Outils » s'affiche.

4.	 Sélectionnez la fonction Met. app. à j. dans le menu Outils. Une fenêtre contextuelle s’affiche.

5.	 Sélectionnez e-Manual dans la fenêtre contextuelle, et ensuite Mise à j.

Configuration de la mise à jour automatique

MENU > Smart Hub > Réglage des app.

Pour mettre à jour automatiquement le guide électronique, allez au menu Smart Hub > Réglage des app., puis 
réglez l'option Mise à jour auto à Activer. Le guide électronique est mis à niveau automatiquement si de nouvelles 
versions sont disponibles.
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Utilisation du mode Web Browser
Web Browser est une application vous permettant de naviguer sur Internet.

"" Utilisez le clavier et la souris pour naviguer de manière plus conviviale.

"" La page de navigation peut être différente de celle d'un ordinateur.

Méthodes de navigation

L'option Web Browser offre deux méthodes de navigation :  Les fonctions Navig. par pointeur et  Navig. 
par lien. Navig. par pointeur vous permettent de déplacer le pointeur pour effectuer une sélection alors que la 
fonction Navig. par lien permet d'utiliser les flèches directionnelles pour déplacer la cible de saisie.

La méthode de navigation par défaut du mode Web Browser est Navig. par pointeur. Pour activer l'option Navig. 
par lien, sélectionnez l'icône .

Aperçu de la barre d'état et de commande

Ouvrir le Web Browser pour afficher la barre d'état et de commande en haut de l'écran. Les éléments suivants sont 
disponibles :

●●  Retour

Retourner à la page précédente.

●●  Suivante

Aller à la page suivante.

●●  Signets et historique

Permet de passer à l'écran Signets et historique. À cet écran, vous pouvez ajouter la page en cours aux 
Favoris, ou déplacer, modifier ou supprimer une page mise dans les Favoris. L'accès aux pages visitées est 
facilité en naviguant à l'écran Historique.
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●●  Page d'accueil

Permet de passer à l'écran principal.

●● Barre d'adresse

Permet de vérifier l'adresse de la page en cours ou d'entrer la page Web pour aller à la page choisie.

●●  Rafraîchir /  Arrêter

Permet de recharger la page en cours ou d'interrompre le téléchargement.

●●  Add to Bookmarks

Permet d'ajouter la page en cours aux Favoris. 

●● Recherche

Permet de faire une recherche par mot clé en utilisant le moteur de recherche propre à l'utilisateur.

"" Pour changer de moteur de recherche, sélectionnez l'icône  et ensuite sélectionnez un moteur de recherche 
dans les paramètres Moteur de recherche.

●●  Zoom

Permet de faire un zoom rapproché ou éloigné de la page Web en cours.

●●  ISI

Permet d'utiliser le Web Browser tout en regardant une émission télévisée sur le même écran. 

●●  Navig. par lien /  Navig. par pointeur

Permet de sélectionner une des deux méthodes prises en charge par le Web Browser.

●●  Réglage

Permet de configurer les paramètres Web Browser. Pour plus d'information, reportez-vous à la section « 
Préférences de navigation ».

●●  Fermer

Permet de quitter le mode Web Browser.

●● Nouv ongl.

Permet d'ouvrir un nouvel onglet.



50

Préférences de navigation

Sélectionnez l'élément  à l'écran. Permet de configurer les paramètres de navigation selon vos besoins ou à 
votre convenance.

"" Certains éléments peuvent ne pas être disponibles en fonction de la page Web. Les éléments qui ne sont pas disponibles 
sont en gris.

●● Sites approuvés

Pour empêcher les enfants d'avoir accès à des pages Web au contenu inapproprié, vous pouvez limiter l'accès 
aux pages Web pré-enregistrées.

"" On vous demandera d'entrer un mot de passe lorsque vous sélectionnerez l'option Sites approuvés. Entrez le mot 
de passe. Le mot de passe par défaut est 0000.

Fonction d'approbation de sites : permet d'activer et de désactiver l'option Fonction d'approbation de sites.

Réinitial. mot de passe sites approuvés : permet de modifier le mot de passe.

Ajout site actuel : permet d'ajouter la page en cours aux Sites approuvés.

Gérer les sites approuvés : permet d'entrer l'adresse de la page Web que vous souhaitez ajouter aux Sites 
approuvés, ou de sélectionner un site dans la liste et de le supprimer.

"" Lorsque l'on désactive l'option Fonction d'approbation de sites et qu'il n'y a aucune page Web dans la liste, l'accès à 
toute page Web s'en trouve restreint.

●● Navigation privée activée / Navigation privée désactivée

Activer et désactiver l'option Navigation privée. Lorsque l'on active l'option Navigation privée, l'historique de 
navigation n'est pas sauvegardé. 

"" Lorsque l'on active l'option Navigation privée, l'icône  s'affiche au début de la barre d'adresse.

●● Définir moteur de rech.

Permet de définir le moteur de recherche par défaut dans la liste.
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●● Config. navigateur Web

Permet de configurer les Config. navigateur Web, comme les comportements de navigation ou la sécurité.

Déf. page d’accueil : permet de sélectionner une page Web et de la définir comme la page d'accueil.

Bloc. fen. pub. : permet de bloquer ou débloquer les fenêtres contextuelles.

Blocage de pages : permet de bloquer ou débloquer les pages comme les pages commerciales. Permet de 
gérer une liste de pages à bloquer en entrant l'adresse d'une page Web.

Général : permet de supprimer l'historique de navigation ou les informations d'utilisation d'Internet ou de 
réinitialiser le Web Browser. Utilisez la navigation confidentielle pour restreindre l'accès à votre système par 
des codes malveillants ou des sites d'hameçonnage.

Encodage : permet de régler l'encodage à Auto, ou de sélectionner une méthode d'encodage dans la liste.

Curseur : permet de régler la vitesse du pointeur en mode Navig. par pointeur, ou de changer la méthode 
d'accès aux liens.

Infos sur le navigateur : permet de vérifier la version en cours du mode Web Browser.

●● Aide

Cette fonction vous permet de vous familiariser avec les bases du mode Web Browser.
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Déplacer une application à l'écran des applications.
1.	 À l'écran SAMSUNG APPS, sélectionnez l'application que vous désirez déplacer.

2.	 Appuyez sur la touche E et maintenez la pression. Un menu contextuel s'affiche.

3.	 Dans le menu contextuel, sélectionnez Déplacer. 

"" Il est possible qu'on vous demande de passer au mode d'affichage Personnalisé.

4.	 Mettez en évidence une application que vous désirez déplacer. Déplacez l'application à l'endroit désiré grâce 
aux touches de flèches.

5.	 Lorsque l'application se trouve à son nouvel endroit, appuyez sur la touche E.

"" Vous ne pouvez pas déplacer les applications recommandées.

Supprimer une application du téléviseur
"" Si une application est supprimée, les données qui lui sont associées sont également supprimées.

Supprimer une application

1.	 À l'écran SAMSUNG APPS, déplacez l'application que vous désirez retirer.

2.	 Appuyez sur la touche E et maintenez la pression. Un menu contextuel s'affiche.

3.	 Dans le menu contextuel, sélectionnez Supprimer. Une fenêtre de confirmation de suppression s'affiche.

4.	 Sélectionnez Oui. L'application sélectionnée est supprimée.



52 53

Supprimer plusieurs applications

1.	 À l'écran SAMSUNG APPS, déplacez l'application que vous désirez retirer.

2.	 Appuyez sur la touche E et maintenez la pression. Un menu contextuel s'affiche.

3.	 Dans le menu contextuel, sélectionnez Suppr. multi. Une case à cocher s'affiche sur les icônes des 
applications.

4.	 Sélectionnez toutes les applications que vous souhaitez supprimer. Un crochet s'affiche sur chacune des 
applications que vous avez sélectionnées. Lorsque vous avez terminé, sélectionnez la fonction Supprimer 
dans la partie inférieure de la page. Une fenêtre de confirmation de suppression s'affiche.

5.	 Sélectionnez Oui. Les applications sélectionnées sont supprimées.

Classement ou évaluation d'une application
À l'écran d'information détaillée sur l'application, vous pouvez évaluer l'application ou soumettre une critique au 
développeur.

"" Pour évaluer une application ou soumettre une critique, vous devez être connecté à votre compte Samsung. Vous 
pouvez seulement soumettre une évaluation ou une critique d'une application ou d'un jeu à partir du téléviseur que vous 
avez utilisé pour acheter l'application.

Mise à jour des applications
1.	 À l'écran SAMSUNG APPS, sélectionnez une application.

2.	 Appuyez sur la touche E et maintenez la pression. Un menu contextuel s'affiche.

3.	 Dans le menu contextuel, sélectionnez Met. app. à j.. Une fenêtre contextuelle s'affichera et dressera la liste 
des applications qui peuvent être mises à jour.

4.	 Sélectionnez les applications que vous souhaitez mettre à jour, puis sélectionnez Mise à j. Les dernières 
versions de toutes les applications sélectionnées sont installées.

"" Pour sélectionner toutes les applications qui figurent dans la fenêtre de mise à jour, sélectionnez Choisir tout.

Configuration de la mise à jour automatique des applications

Pour que les applications soient mises à jour automatiquement, allez à Smart Hub > Réglage des app. et réglez Mise 
à jour auto à Activer. Les applications seront alors mises à jour automatiquement si de nouvelles versions sont 
disponibles.
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Utiliser les fonctions des autres applications
MENU > Smart Hub > Réglage des app. Ess. maint.

Vous pouvez configurer des fonctions supplémentaires de vos applications.

Configuration des notifications forcées

La fonction de Notifications forcées permet aux éditeurs de certaines applications installées sur votre téléviseur 
d'envoyer des alertes contenant des nouvelles au sujet de leurs applications, des renseignements sur les 
modifications, etc. Les messages s'affichent à l'écran du téléviseur.
1.	 Allez à Smart Hub > Réglage des app. > Param. de notification forcée, puis réglez Notification poussée à 

Activer.

2.	 À l'écran Notification poussée, sélectionnez les applications desquelles vous désirez recevoir des notifications 
forcées.

"" La liste des applications qui offrent les Notification poussée comprend seulement les applications qui prennent en 
charge les Param. de notification forcée.

Utiliser les applications associées à des chaînes.

Une telle application est associée à une chaîne en particulier. Elle offre en temps réel des services ou 
renseignements liés à une émission de la chaîne en question.

Allez à Smart Hub > Réglage des app., puis réglez Channel-Bound Apps à Activer.
"" Vous pouvez utiliser cette fonction que lorsqu'une application prenant en charge Channel-Bound Apps est installée sur le 

téléviseur.
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Lire le contenu multimédia (photos, vidéos et musique)
"" Vous ne pouvez pas lire le contenu média que votre téléviseur ne prend pas en charge. Pour de plus amples 

renseignements, reportez-vous à la section « Instructions à lire avant de lire des fichiers photo, vidéo ou de musique ».

"" Faites une copie de sauvegarde de vos fichiers important avant de brancher une clé USB. Samsung décline toute 
responsabilité en cas de fichiers endommagés ou perdus.

Lecture du contenu média enregistré sur une clé USB
1.	 Pour utiliser la fonction multimédia, appuyez sur la touche KEYPAD, et ensuite sélectionnez la fonction Media 

Play ou appuyez sur la touche SOURCE. Les clés USB branchées au téléviseur sont indiquées.

2.	 Sélectionnez le dispositif auquel vous voulez accéder. Les dossiers et les fichiers contenus sur la clé USB 
sélectionnée sont affichés.

3.	 Sélectionnez le contenu que vous désirez lire à partir de la liste. Le contenu est lu.

"" Vous pouvez aussi vous rendre au contenu que vous désirez lire, et appuyer sur la touche ∂ pour lancer la lecture.

4.	 Pour quitter, appuyez sur la touche ∫ ou RETURN.

"" Si vous branchez une clé USB dans le téléviseur alors que vous utilisez le téléviseur, une fenêtre contextuelle s'ouvrira et 
vous présentera les dossiers et fichiers figurant sur la clé USB.

"" Vous pouvez également, si vous avez sélectionné une clé USB à l'écran Source, parcourir les dossiers et les fichiers de la 
clé USB par l'entremise d'une fenêtre contextuelle.

Retrait d'une clé USB en toute sécurité

1.	 Appuyez sur la touche SOURCE. L'écran Source s'affiche.

2.	 Allez à la clé USB que vous désirez retirer. Appuyez sur la touche E et maintenez la pression. Une fenêtre 
s'affiche et présente une liste d'options.

3.	 Sélectionnez l'option Retirer USB dans la liste.
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Lire du contenu multimédia enregistré sur un ordinateur ou un appareil 
mobile

Permettre une connexion avec un ordinateur ou un appareil mobile

Pour lire sur le téléviseur du contenu multimédia qui se trouve sur un ordinateur ou un appareil mobile, vous devez 
faire ce qui suit :

●● Tout d'abord, établissez une connexion avec l'ordinateur ou l'autre appareil.

●● Ensuite, vous devez permettre que votre téléviseur se connecte à l'ordinateur ou à l'appareil mobile.

Pour savoir comment établir les connexions, reportez-vous aux sections « Connexion à un ordinateur » et « 
Connexion à un appareil mobile ».

Pour permettre une connexion avec un ordinateur ou un appareil mobile, vous devez prendre les mesures 
suivantes :
1.	 Allez à Réseau > Paramètres de l’appareil multimédia. Les appareils branchés au téléviseur sont indiqués.

2.	 Vous permet d'autoriser une connexion entre l'appareil en question et le téléviseur. Vous ne pouvez lire que 
des fichiers média contenus dans des dispositifs que vous avez autorisés à se connecter au téléviseur.

"" Si un ordinateur ou un appareil demande qu'on lui permette de se connecter, une fenêtre de confirmation de la 
permission s'affiche à l'écran du téléviseur et vous permet d'approuver facilement la connexion.

Lorsque vous êtes connecté en DLNA par l'entremise de votre réseau domestique

"" Pour vous connecter à un ordinateur par l'entremise du réseau domestique (DLNA), reportez-vous à la section 
« Connexion à un ordinateur ».

"" Pour vous connecter à un appareil mobile par l'entremise du réseau domestique (DLNA), reportez-vous à la section « 
Connexion à un appareil mobile ».

"" Il se peut que des problèmes de compatibilité surviennent lorsque vous essayez de lire du contenu par l'intermédiaire du 
serveur DLNA d'un tiers.

"" Il est possible que le contenu qui se trouve sur un ordinateur ou un appareil mobile soit impossible à lire, en fonction du 
format de fichier et du type de codage du contenu. De plus, il se peut que certaines fonctions ne soient pas disponibles.

"" Il est possible que la lecture du contenu multimédia soit interrompue, en fonction de la condition du réseau. Si cela se 
produit, transférez le contenu vers un dispositif de stockage USB, puis lisez le contenu à partir du dispositif.

1.	 Allez à Réseau > Paramètres de l’appareil multimédia. Les appareils branchés au téléviseur sont indiqués.

2.	 Sélectionnez un appareil connecté par l'entremise de votre réseau domestique (DLNA), et les dossiers et 
fichiers partagés s'afficheront.

3.	 Sélectionnez le contenu que vous désirez lire à partir de la liste. Le contenu est lu.

"" Vous pouvez aussi vous rendre au contenu que vous désirez lire, et appuyer sur la touche ∂ pour lancer la lecture.
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Quand la connexion est établie à l'aide de Samsung Link

"" Pour vous connecter à un ordinateur par l'entremise de Samsung Link, reportez-vous à la section « Connexion à un 
ordinateur ».

"" Pour vous connecter à un appareil mobile par l'entremise de Samsung Link, reportez-vous à la section « Connexion à un 
appareil mobile ».

"" Il est possible que le contenu qui se trouve sur un ordinateur ou un appareil mobile soit impossible à lire, en fonction du 
format de fichier et du type de codage du contenu. De plus, il se peut que certaines fonctions ne soient pas disponibles.

"" Il est possible que la lecture du contenu multimédia soit interrompue, en fonction de la condition du réseau. Si cela se 
produit, transférez le contenu vers un dispositif de stockage USB, puis lisez le contenu à partir du dispositif.

1.	 Allez au menu Smart Hub > Compte Samsung et sélectionnez Connec. pour vous connecter à votre compte 
Samsung.

2.	 Sélectionnez Paramètres de l’appareil multimédia dans le menu Réseau. Les appareils branchés au téléviseur 
sont indiqués.

3.	 Sélectionnez un appareil connecté à l'aide de Samsung Link. La liste des dossiers et fichiers qui se trouvent 
sur l'appareil sélectionné s'affiche.

4.	 Sélectionnez le contenu que vous désirez lire à partir de la liste. Le contenu est lu.

"" Vous pouvez aussi vous rendre au contenu que vous désirez lire, et appuyer sur la touche ∂ pour lancer la lecture.
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Lecture de fichiers photos
Vous pouvez lire des fichiers photos sauvegardés sur un dispositif USB. Ess. maint.

Touches et fonctions disponibles pendant le visionnement de photos

Le téléviseur affiche les touches ci-dessous lorsque vous appuyez sur la touche E quand vous regardez des 
photos provenant d'une source multimédia. Les touches de lecture disparaîtront si vous appuyez sur la touche 
RETURN.

●● Pause / Lecture

Lance ou arrête le diaporama. Le diaporama vous permet de visionner toutes les photos contenues dans un 
dossier, une par une.

●● Précédent / Suivant

Voir la photo précédente ou suivante.

●● Paramètres

Les fonctions ci-dessous sont disponibles lorsque vous sélectionnez la touche Paramètres.

Fonction Description

Paramètres de 
diaporama

Vitesse : permet de régler la vitesse du diaporama.
Effets : permet d'appliquer des effets au diaporama.

Pivoter Permet de faire pivoter la photo.

Zoom Permet de faire un agrandissement par un facteur de 4.

Image Mode Permet de modifier le réglage du mode Image.

Musique de fond

Permet d'entendre une musique de fond pendant le visionnement des photos.
"" Le fichier de musique doit être enregistré dans le même dispositif que le fichier de photos.
"" Un mini lecteur apparaît à l'écran lorsque vous faites jouer'une musique de fond. Le mini 

lecteur vous permet d'interrompre la lecture du fichier musical actuel et de lire un autre 
fichier.

Son Mode
Permet de modifier le réglage du mode Son.

"" Cette option n'est prise en charge que pendant la lecture de musique de fond.

Sélectionner les haut-
parleurs

Choisissez les haut-parleurs pour la lecture de la musique d'arrière-plan. Cette fonction est 
seulement disponible si un cinéma maison ou un récepteur est branché au téléviseur.

Envoyer

Cette fonction a les mêmes caractéristiques que la fonction « Copier » sur un ordinateur. Cette 
fonction vous permet d'envoyer la photo courante vers un autre dispositif de stockage.

"" Pour avoir la liste des dispositifs de stockage pris en charge, reportez-vous à la section « 
Dispositifs de stockage compatibles pour un transfert de fichiers ».

Information Permet d'afficher de l'information détaillée sur la photo courante.
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Lecture de fichiers vidéo
Vous pouvez lire des vidéos sauvegardés sur un dispositif USB. Ess. maint.

Touches et fonctions disponibles pendant le visionnement de vidéos

Le téléviseur affiche les touches ci-dessous lorsque vous appuyez sur la touche E quand vous regardez des vidéos 
provenant d'une source multimédia. Les touches de lecture disparaîtront si vous appuyez sur la touche RETURN.

●● Pause / Lecture

Interrompre ou reprendre la lecture d'une vidéo

Lorsque la lecture d'une vidéo est mise sur pause, vous pouvez utiliser les fonctions suivantes. Le téléviseur 
ne diffuse pas de son lorsqu'une vidéo est en pause ou lorsque vous utilisez les fonctions Ralenti ou Image par 
image.

–– Étape : Si vous appuyez sur la touche ∑, le fichier vidéo sera lu une image à la fois.

–– Ralenti : Sélectionnez la touche … pour lire la vidéo à une vitesse de lecture lente (1/8, 1/4, 1/2).

●● Rembobinage / Avance rapide

Revenir en arrière ou effectuer la lecture d'une vidéo en avance rapide.

●● Précédent / Suivant

Appuyez deux fois sur la touche € deux fois pour lire la vidéo précédente. Appuyez une seule fois sur la 
touche € pour lire la vidéo actuelle depuis le début.

Pour lire la vidéo suivante, sélectionnez la touche ‚.
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●● Paramètres

Les fonctions ci-dessous sont disponibles lorsque vous sélectionnez la touche Paramètres.

Fonction Description

Sélectionner la scène

Vignettes : permet de sélectionner une scène et de lire la vidéo de cette scène.
"" La fonction Vignettes n'est pas disponible si 1) la vignette de la vidéo n'a pas encore été 

extraite, si 2) la vidéo ne comporte que du contenu audio ou si 3) la durée de la vidéo est 
inférieure à 60 secondes.

Titres de chapitres : permet de sélectionner et de lire une autre vidéo à partir du même dossier.
Barre temps : vous pouvez utiliser les touches ¡ et £ pour parcourir le fichier à des intervalles 
de 10 secondes, ou encore entrer une durée précise pour passer à ce point dans le fichier vidéo.

Sous-titre

Permet de régler les sous-titres d'un fichier vidéo.
Langue : permet d'activer ou de désactiver les sous-titres.
Synchroniser : lorsque la vidéo et les sous-titres ne sont pas synchronisés, vous pouvez ajuster 
la synchronisation.
Réinitialiser la synchronisation : permet de réinitialiser les paramètres de synchronisation à 0.
Taille : permet de sélectionner la taille des sous-titres.
Encodage : si les sous-titres ne fonctionnent pas, vous pouvez modifier la langue d'encodage.

Répéter
Réglez le mode de répétition. L'option Répéter un permet de répéter la vidéo en cours 
seulement. L'option Répét. tout permet de répéter tous les fichiers vidéos que contient le 
dossier.

Image Format
Permet de changer la taille de l'image. Les tailles d'images prises en charge dépendent du 
contenu vidéo.

Image Mode Permet de modifier le réglage du mode Image.

Son Mode Permet de modifier le réglage du mode Son.

Sélectionner les 
haut-parleurs

Sélectionnez les haut-parleurs par lesquels le son doit sortir. Cette fonction est seulement 
disponible si un cinéma maison ou un récepteur est branché au téléviseur.

Langage audio
Permet de choisir la langue audio désirée. Cette option fonctionne seulement lorsque la vidéo 
prend en charge l'audio multipistes.

Information Permet d'afficher de l'information détaillée sur la vidéo.
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Lecture des fichiers de musique
Vous pouvez lire des fichiers de musique sauvegardés sur un dispositif USB. Ess. maint.

Touches et fonctions disponibles pendant la lecture de fichiers musicaux

Le téléviseur affiche les touches ci-dessous lorsque vous appuyez sur la touche E quand vous écoutez de la 
musique provenant d'une source multimédia. Les touches de lecture disparaîtront si vous appuyez sur la touche 
RETURN.

●● Pause / Lecture

Permet d'interrompre ou de reprendre la lecture de la musique.

●● Rembobinage / Avance rapide

Permet de revenir en arrière ou d'effectuer la lecture d'un fichier musical en avance rapide. Appuyez à 
plusieurs reprises sur le bouton pour augmenter jusqu'à 3 fois la vitesse de lecture en retour en arrière ou 
avance rapide. Pour rétablir la vitesse normale de lecture, appuyez sur ∂.

●● Précédent / Suivant

Appuyez deux fois sur la touche € deux fois pour lire le fichier de musique précédent. Appuyez une seule fois 
sur la touche € pour lire le fichier de musique depuis le début.

Pour lire le fichier musical suivant, sélectionnez la touche ‚.

●● Répéter

Réglez le mode de répétition. Répéter un permet de répéter seulement le fichier de musique en cours. Répét. 
tout permet de répéter tous les fichiers de musique que contient le dossier.

●● Lect. al.

Lit les fichiers de musique en ordre aléatoire.

●● Sélectionner les haut-parleurs

Sélectionnez les haut-parleurs par lesquels le son doit sortir. Cette fonction est seulement disponible si un 
cinéma maison ou un récepteur est branché au téléviseur.

●● Son Mode

Permet de modifier le réglage du mode Son.
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Fonctions dans l'écran de la liste des contenus média
Les fonctions suivantes sont disponibles dans l'écran de la liste des contenus média d'un dispositif de stockage.

●● Filtre

Permet de filtrer le contenu afin qu'un seul type soit affiché: photos, vidéos ou musique.

●● Options

Permet d'afficher les options de lecture et d'affichage. Les options varient en fonction du type de contenu 
sélectionné. Les options ci-dessous ne seront pas toutes affichées en même temps.

"" Cette fonction n’est accessible que lorsque Filtre est réglé à Tout.

Les options ci-dessous sont disponibles lorsque vous appuyez sur la touche Options.

Fonction Description

Diaporama
Permet de démarrer le diaporama.

"" Option disponible pour les photos seulement.

Lire sélection Vous permet de lire uniquement le contenu que vous voulez à partir de la liste des médias.

Envoyer

Cette fonction a les mêmes caractéristiques que la fonction « Copier » sur un ordinateur. À l'aide 
de cette fonction, vous pouvez envoyer du contenu vers un autre dispositif de stockage.

"" Pour avoir la liste des dispositifs de stockage pris en charge, reportez-vous à la section « 
Dispositifs de stockage compatibles pour un transfert de fichiers ».

Encodage
Si le titre du contenu ne s'affiche pas comme il se doit, vous pouvez modifier l'encodage des 
caractères.

"" Option disponible les fichiers de musique seulement.

Renommer la liste
Vous pouvez modifier le nom d'une liste de lecture que vous avez créée.

"" Option disponible pour les fichiers de musique seulement.

Supprimer la liste de 
lecture

Vous pouvez supprimer une liste de lecture que vous avez créée.
"" Option disponible pour les fichiers de musique seulement.

Ajouter à la liste de 
lecture

Vous pouvez ajouter un fichier à une liste de lecture que vous avez créée ou créer une nouvelle 
liste.

"" Option disponible les fichiers de musique seulement.
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Aperçu de la diffusion numérique
MENU > Diffusion > Guide Ess. maint. Ess. maint.

Le guide contient un aperçu de toutes les émissions de la liste de chaînes numériques. Vous pouvez consulter les 
horaires de diffusion des émissions et planifier un visionnement.

Appuyez sur la touche GUIDE de votre télécommande pour lancer le guide.
"" Les renseignements contenus dans le Guide ne concernent que les chaînes numériques. Les chaînes analogiques ne sont 

pas prises en charge.

Utilisation de la fonction Guide
Pour voir les fonctions du Guide, appuyez sur la touche E et maintenez la pression. Une fenêtre contextuelle 
contenant la liste des fonctions suivantes s'affiche.

Filtre chaînes

Le filtre de chaînes vous permet de filtrer les chaînes du Guide en fonction des catégories ci-dessous : Chaînes aj. 
et Favoris 1 - Favoris 5.

Parcourir l'horaire des émissions

Vous pouvez déplacer le guide de deux heures dans une direction ou dans l'autre en appuyant sur les touches † et …. 
Vous pouvez consulter l'horaire des émissions ultérieures uniquement.

Gest. d'horaire

Cela permet d'afficher le gestionnaire d'horaire. Pour avoir de l'information au sujet du Gestionnaire d'horaire, 
reportez-vous à la section « Configuration de l'option Planifier un visionnement ».

Modifier les chaînes favorites

« Modif. favoris » vous permet de désigner une chaîne que vous avez sélectionnée dans le Guide en tant que 
favorite.

Pour utiliser la fonction Modifier les chaînes favorites:
1.	 Mettez en évidence une chaîne que vous désirez ajouter à vos favoris à partir du Guide.

2.	 Appuyez sur la touche TOOLS. La fenêtre contextuelle des fonctions du Guide s'affiche.

3.	 Sélectionnez Modifier les chaînes favorites. La fenêtre Modif. favoris s'affiche.

4.	 Sélectionnez la liste de chaînes favorites dans laquelle vous voulez ajouter la chaîne.

Visionnement d'émissions de télévision
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Affichage de l'information détaillée
Vous pouvez obtenir des informations détaillées sur une émission en sélectionnant celle-ci. L'information 
disponible sur les émissions peut varier selon le signal de diffusion et peut ne pas être du tout disponible dans le cas 
de certaines émissions.

●● Sélectionnez une émission en cours sur une autre chaîne, puis Afficher les détails pour Regarder l'émission.

●● Sélectionnez une émission à venir, puis sélectionnez Afficher les détails pour Planifier un visionnement.

"" Pour de plus amples renseignements sur les émissions ou sur l'option Planifier un visionnement, reportez-vous à la 
section « Configuration de l'option Planifier un visionnement ».

Vérification de l'information actuelle sur les émissions
Pour avoir de l'information au sujet d'un spectacle, appuyez sur la touche INFO de la télécommande.

"" Pour afficher l'information sur une émission, il faut d'abord régler l'horloge du téléviseur. Allez à Horloge (Système > 
Heure > Horloge).

"" L'information sur les émissions peut varier en fonction du type de signal d'entrée et peut ne pas être disponible du tout 
pour certaines émissions.

Utilisez les touches ¡ et £ pour consulter des renseignements sur les émissions à venir. Sélectionnez une émission 
afin de configurer l'option Planifier un visionnement pour cette émission.

Pour de plus amples renseignements sur l'option Planifier un visionnement, reportez-vous à la section « 
Configuration de l'option Planifier un visionnement ».

Changer le signal de diffusion
MENU > Diffusion > Antenne Ess. maint.

Vous pouvez choisir le mode DTV correspondant à votre environnement de visionnement. Choisissez le mode 
Hertzien ou Câble. Le mode Hertzien convient aux foyers munis d'une antenne par satellite. Le mode Câble 
convient aux foyers qui ont souscrit à un service de câble local ou assuré par un fournisseur de services par 
satellite.

"" N'utilisez pas cette fonction si votre téléviseur est connecté à un câble ou un décodeur satellite.

Information sur le signal des chaînes numériques et la puissance du signal
MENU > Support technique > Autodiagnostic > Info. sur signal Ess. maint.

Sélectionnez Support technique > Autodiagnostic > Info. sur signal. Des renseignements sur le signal de la chaîne 
numérique, dont la force du signal, s'affichent.

"" Si une antenne distincte est branchée à votre téléviseur, vous pouvez utiliser l'information sur la puissance du signal pour 
régler l'antenne, optimiser la puissance du signal et améliorer la réception des chaînes HD.

"" L'option Info. sur signal est disponible seulement pour les chaînes numériques.
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Configuration de l'option Planifier un visionnement
Configurez le téléviseur pour afficher une chaîne ou une émission en particulier à une certaine date et certaine 
heure. L'icône  s'affiche en regard des émissions programmées dans Planifier un visionnement.

"" Pour planifier le visionnement d'une émission, il faut d'abord régler l'horloge du téléviseur. Allez à Horloge (Système > 
Heure > Horloge).

"" Il n'est pas possible de Planifier un visionnement pour une émission qui est en cours de diffusion.

Planification du visionnement d'une chaîne numérique
Vous pouvez configurer la fonction Planifier un visionnement pour les émissions diffusées sur les chaînes 
numériques sur les écrans suivants :

●● L'écran Guide

●● Écran Information, programme

L'écran Guide

Pour planifier un visionnement à partir de l'écran Guide, suivez les étapes ci-après :
1.	 Appuyez sur la touche GUIDE de votre télécommande.

2.	 À l'écran du guide, utilisez votre télécommande pour mettre en évidence et sélectionner une émission que 
vous voudriez visionner.

3.	 À l'écran des renseignements qui s'affiche, sélectionnez Planifier un visionnement. Le visionnement de 
l'émission est programmé. L’écran Guide s’affiche de nouveau.
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Écran Information, programme

Pour Planifier un visionnement à l'écran INFO, suivez les étapes ci-dessous :
1.	 Changez de chaîne et rendez-vous sur la chaîne qui diffusera l'émission dont vous voulez planifier le 

visionnement.

2.	 Appuyez sur la touche INFO.

3.	 Déplacez-vous vers la droite pour voir l'information sur les émissions qui seront diffusées ultérieurement. Les 
renseignements sur les émissions qui seront diffusées plus tard à la même chaîne s'affichent à l'écran.

4.	 Mettez en surbrillance et sélectionnez l'émission que vous voulez planifier. L’écran Information s’affiche.

5.	 Sélectionnez Planifier un visionnement. Le visionnement de l'émission est programmé. Appuyez sur la touche 
RETURN de votre télécommande.

Planifier le visionnement d'une chaîne analogique
MENU > Diffusion > Gest. d'horaire Ess. maint.

Lorsque vous planifiez le visionnement d'une émission sur une chaîne analogique, vous devez connaître le numéro 
de la chaîne, le ou les jours de la semaine pour lesquels la diffusion est prévue ainsi que l'heure à laquelle l'émission 
sera diffusée.

Pour planifier un visionnement d'une chaîne analogique, suivez les étapes ci-après :
1.	 Appuyez sur la touche MENU, et sélectionnez l'option Diffusion > Gest. d'horaire.

2.	 À l'écran Gest. d'horaire, sélectionnez Horaire. L’écran Planifier un visionnement s’affiche.

3.	 À l'écran Planifier un visionnement, sélectionnez la connexion Antenne, (Hertzien ou Câble), puis passez au 
champ Chaîne.

"" Si vous recevez uniquement vos émissions de télévision par Hertzien ou Câble, le champ Connexion d'antenne 
affiche uniquement Hertzien ou uniquement Câble.

4.	 Mettez en évidence le champ Chaîne, puis sélectionnez-le. Faites défiler l'écran vers le haut ou le bas afin de 
trouver la chaîne désirée, puis sélectionnez-la. Déplacez-vous au champ Répéter.

5.	 Mettez en évidence le champ Répéter, puis sélectionnez-le. Sélectionnez Une fois, Manuel, Sam~Dim, 
Lun~Ven, ou Quotid.. Si vous sélectionnez le mode manuel, vous devrez également mettre en évidence et 
sélectionner les jours que vous désirez.

6.	 Déplacez-vous au champ Heure et sélectionnez-le. Utilisez les flèches vers le haut/bas pour régler les chiffres. 
Fixez les valeurs des champs am/pm et Minutes de la même façon.

7.	 Une fois l'heure saisie, appuyez sur la touche RETURN.

8.	 Sélectionnez OK au bas de l'écran Planifier un visionnement.
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Annuler la planification d'un visionnement
Pour annuler la planification d'un visionnement précis, suivez les étapes ci-après :
1.	 Appuyez sur la touche MENU, et sélectionnez l'option Diffusion > Gest. d'horaire.

2.	 À l'écran Réservé, sélectionnez le visionnement planifié. Un menu contextuel s'affiche.

3.	 Sélectionnez Supprimer pour annuler.

4.	 Sélectionnez Oui dans la fenêtre contextuelle « Supprimer cette émission ». Le visionnement planifié est 
supprimé.

Modifier la planification d'un visionnement
Pour modifier l'heure, le jour ou la chaîne d'un visionnement planifié, suivez les étapes ci-après :
1.	 Appuyez sur la touche MENU, et sélectionnez l'option Diffusion > Gest. d'horaire.

2.	 À l'écran Réservé, sélectionnez le visionnement planifié. Un menu contextuel s'affiche.

3.	 Sélectionnez Modifier.

4.	 Modifiez l'heure, les jours ou la chaîne de la même façon que pour les chaînes analogiques tel que décrit dans 
la section Planifier un visionnement d'une chaîne analogique. Sélectionnez OK lorsque vous avez terminé.
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Utilisation de la fonction Liste des chaînes
MENU > Diffusion > Liste des chaînes Ess. maint.

Appuyez sur la touche GUIDE pendant que vous regardez la télévision et maintenez-la enfoncée pour afficher le 
Liste des chaînes et changez de chaîne ou consultez les émissions présentées sur d'autres chaînes numériques.

Sélectionnez une chaîne à partir de la Liste des chaînes pour y accéder immédiatement. Pour naviguer rapidement 
dans la liste, utilisez les touches haut/bas des chaînes. Cela permet de déplacer l'objectif, une page à la fois.

L'écran de la liste des chaînes contient les icônes suivantes :

––  : chaîne analogique.

––  : chaîne favorite.

––  : chaîne verrouillée.

●● Utilisation des options

Appuyez sur la touche ¡, et sélectionnez Options. Les options suivantes sont disponibles :

Fonction Description

Antenne

Choisissez le mode Hertzien ou Câble comme mode de diffusion numérique (DTV). Le 
modeHertzien convient aux foyers munis d'une antenne par satellite. Câble convient aux 
foyers qui ont souscrit à un service de câble local ou assuré par un fournisseur de services par 
satellite.

Genre
Triez la liste afin qu'elle présente les chaînes associées à un certain genre seulement. Vous 
pouvez seulement utiliser la fonction Genre si vous avez réglé le mode de chaîne de la Liste des 
chaînes à Chaînes aj. et si les chaînes ajoutées sont associées à des renseignements sur le genre.

Modif. favoris
Sert à définir les chaînes favorites. Reportez-vous à la section « Créer une liste personnelle de 
chaînes favorites » pour avoir plus de renseignements.

●● Affichage des chaînes favorites ou des listes de chaînes favorites

Dans la Liste des chaînes, appuyez sur la touche £, puis sélectionnez Chaînes aj. ou Favoris. Favoris 
s'afficheront seulement si vous avez enregistré au moins un chaîne favorite. Pour de plus amples 
renseignements, reportez-vous à la section « Créer une liste personnelle de chaînes favorites ».
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Enregistrer, retirer et modifier des chaînes
MENU > Diffusion > Modifier la chaîne Ess. maint.

Supprimez des chaînes de l'index, récupérez des chaînes supprimées et renommez des chaînes analogiques. Les 
icônes de l'écran Modifier la chaîne indiquent :

●●  : chaîne analogique.

●●  : chaîne favorite.

●●  : chaîne verrouillée.

Enregistrement et suppression de chaînes
MENU > Diffusion > Modifier la chaîne

Retrait de chaînes enregistrées

Quand vous retirez une chaîne ajoutée à l'index, vous le retirez de la liste de chaînes aux quelles vous pouvez 
accéder grâce aux touches CH.LIST de votre télécommande.
1.	 Déplacez la zone de surbrillance sur une chaîne, puis sélectionnez-la pour la supprimer. Répétez pour 

sélectionner d'autres chaînes.

2.	 Pour désélectionner une chaîne, déplacez la zone de surbrillance sur la chaîne, puis sélectionnez-la.

3.	 Pour sélectionner toutes les chaînes, sélectionnez Options, puis sélectionnez Choisir tout dans la liste. Vous 
pouvez aussi sélectionner Désélectionner tout.

4.	 Une fois que vous avez fait vos sélections, sélectionnez Supprimer.



70

Rajouter des chaînes retirées

Les chaînes sont récupérées dans l'index en les ajoutant de nouveau. Les chaînes supprimées s'affichent en gris 
dans la liste Tout uniquement. En outre, l'option Ajouter n'est disponible que pour les chaînes supprimées.
1.	 Sélectionnez Options pour afficher une liste d'options. Sélectionnez Catégorie à partir de la liste, puis 

sélectionnez Tout.

2.	 Déplacez la zone de surbrillance sur une chaîne que vous voulez ajouter. Répétez pour sélectionner d'autres 
chaînes.

3.	 Pour désélectionner une chaîne, déplacez la zone de surbrillance sur la chaîne, puis sélectionnez-la.

4.	 Pour sélectionner toutes les chaînes, sélectionnez Options, puis sélectionnez Choisir tout dans la liste. Vous 
pouvez aussi sélectionner Désélectionner tout.

5.	 Une fois que vous avez fait vos sélections, sélectionnez Ajouter.

Modifier les chaînes enregistrées
MENU > Diffusion > Modifier la chaîne

Sélectionnez la touche Options dans le bas à gauche de l'écran pour accéder aux options ci-après. Les options 
disponibles peuvent varier en fonction du signal de diffusion.

●● Choisir tout

Permet de sélectionner toutes les chaînes affichées à l'écran Modifier la chaîne.

●● Antenne

Choisissez Hertzien ou Câble comme mode DTV.

●● Catégorie

Les chaînes enregistrées sur le téléviseur sont classées dans les catégories ci-dessous : Tout et Chaînes aj. :

●● Modif. favoris

Sert à définir les chaînes favorites. Pour de plus amples renseignements, reportez-vous à la section « Créer 
une liste personnelle de chaînes favorites ».

●● Renommer un canal

Permet de renommer les chaînes analogiques. Le nouveau nom peut contenir jusqu'à 5 caractères.

●● Information

Affichez de l'information détaillée sur l'émission en cours.
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Verrouill. émissions
MENU > Diffusion > Verrouill. émissions

La fonction Verrouill. émissions vous permet de bloquer des émissions en fonction de leurs classements. Cette 
fonction est utile pour contrôler les émissions que vos enfants regardent. La fonction « Verrouill. émissions » ne 
bloque pas les émissions provenant de sources extérieures, comme les lecteurs Blu-ray, les lecteurs DVD ou les 
fichiers USB.

Chaque fois que vous accédez à la fonction Verrouill. émissions, vous devez entrer le NIP de sécurité. Vous devez 
également entrer le NIP pour écouter une émission bloquée. Le NIP par défaut est 0000. Pour modifier le NIP, allez 
à Système > Changer NIP.

La fonction Verrouill. émissions est disponible uniquement au mode TV.

Bloquer des émissions en fonction d'un système de classification

Pour bloquer un contenu, sélectionnez une catégorie de classement à verrouiller. Toutes les émissions classées 
dans cette catégorie et dans les catégories supérieures sont bloquées; pour y accéder, il faut entrer le NIP. Pour 
débloquer une catégorie, sélectionnez le cadenas. Pour débloquer toutes les catégories d'une rangée, sélectionnez 
le cadenas sous ALL.

Catégories à gauche :

●● TV-Y : jeunes enfants

●● TV-Y7 : enfants de 7 ans et plus

●● TV-G : grand public

●● TV-PG : surveillance parentale

●● TV-14 : téléspectateurs de 14 ans et plus

●● TV-MA : adultes

Catégories en haut :

●● ALL : blocage de tous les classements télé.

●● FV : fantastique et violence

●● V : violence

●● S : sexualité

●● G : langage adulte

●● D : dialogues à caractère sexuel
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Blocage d'émissions selon le classement MPAA

Vous pouvez bloquer des films en fonction de leur classement MPAA. Cela s'applique à tous les contenus faisant 
l'objet d'un classement aux États-Unis.

Classement MPAA :

« La Motion Picture Association of America (MPAA) a établi un système de classification qui fournit aux parents ou 
adultes exerçant une surveillance des renseignements sur les films convenant aux enfants. »

Sélectionnez le cadenas situé à côté de la catégorie à bloquer; les catégories supérieures sont également bloquées 
automatiquement. Pour débloquer une catégorie, sélectionnez le cadenas.

●● V : grand public (aucune restriction).

●● PG : surveillance parentale recommandée.

●● PG-13 : supervision des parents fortement recommandée.

●● R : réservé. Les enfants de moins de 17 ans devraient être accompagnés d’un adulte.

●● NC-17 : non recommandé aux enfants de moins de 17 ans.

●● X : adultes seulement.

●● NR : non classé.

Blocage d'émissions selon le classement anglais canadien

Vous pouvez bloquer des émissions en fonction de leur classification en anglais canadien. Cette option s'applique à 
toutes les émissions diffusées sur les chaînes en anglais canadien.

Sélectionnez le cadenas situé à côté de la catégorie à bloquer; les catégories supérieures sont également bloquées 
automatiquement. Pour débloquer une catégorie, sélectionnez le cadenas.

●● C : émissions destinées aux enfants de moins de 8 ans

●● C8+ : émissions convenant généralement aux enfants de 8 ans et plus, sans surveillance

●● V : émissions grand public convenant à tous les auditoires.

●● PG : surveillance parentale

●● 14+ : émissions dont la teneur peut ne pas convenir, en tout ou en partie, aux enfants de moins de 14 ans

●● 18+ : émissions pour adultes
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Blocage d'émissions selon le classement en français canadien

Vous pouvez bloquer des émissions en fonction de leur classification en français canadien. Cette option s'applique 
à toutes les émissions diffusées sur les chaînes en français canadien.

Sélectionnez le cadenas situé à côté de la catégorie à bloquer; les catégories supérieures sont également bloquées 
automatiquement. Pour débloquer une catégorie, sélectionnez le cadenas.

V : général

8 ans+ : émissions convenant généralement aux enfants de 8 ans et plus, sans surveillance

13 ans+ : émissions pouvant ne pas convenir aux enfants de moins de 13 ans

16 ans+ : émissions pouvant ne pas convenir aux enfants de moins de 16 ans

18 ans+ : émissions pour adultes

Blocage d'émissions selon la catégorie américaine téléchargeable

Vous pouvez bloquer des émissions en fonction de la Catég. américaine téléchargeable. Ce système de 
classification s'applique aux émissions diffusées sur les chaînes numériques américaines.

L'information relative au contrôle parental est automatiquement téléchargée lorsque vous écoutez des chaînes 
numériques. Le téléchargement peut durer plusieurs secondes. Si l’information n’est pas accessible à partir de la 
station de radiotélévision, le menu Catég. américaine téléchargeable est désactivé.

Les niveaux de contrôle parental diffèrent selon la station de radiodiffusion. Le nom du menu par défaut et le nom 
de la Catég. américaine téléchargeable varient selon les données téléchargées.

Même si vous réglez l’affichage à l’écran dans une autre langue, le menu Catég. américaine téléchargeable s’affiche 
en anglais seulement.

Sélectionnez le cadenas situé à côté de la catégorie à bloquer; les catégories supérieures sont également bloquées 
automatiquement. Pour débloquer une catégorie, sélectionnez le cadenas.

Regarder des émissions bloquées ou dont l'accès est restreint

Pour visionner une émission bloquée, vous devez saisir le NIP.

L'écran devient blanc lorsqu'une émission ou un film, dont l'accès est restreint, est bloqué par l'option Verrouill. 
émissions. Pour débloquer l'émission, vous devez saisir le NIP à l'aide de la télécommande lorsqu'un message vous le 
demande.
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Créer une liste personnelle de chaînes favorites
MENU > Diffusion > Modif. favoris Ess. maint.

Vous pouvez désigner comme chaînes favorites les chaînes que vous regardez souvent. Les chaînes favorites sont 
mises en évidence aux écrans Modifier la chaîne et Liste des chaînes grâce au symbole . Vous pouvez créer 
jusqu'à 5 listes de chaînes favorites. 

Enregistrement de chaînes dans la liste de chaîne favorites
MENU > Diffusion > Modif. favoris

Enregistrement de la chaîne en cours dans la liste de chaînes favorites

Pour enregistrer la chaîne en cours dans la liste de chaînes favorites :
1.	 Lorsque vous regardez une chaîne, appuyez sur la touche TOOLS.

2.	 Sélectionnez l'option Modif. favoris dans la liste.

3.	 Dans la fenêtre virtuelle qui s'affiche, sélectionnez les listes de chaînes favorites que vous voulez, puis 
sélectionnez OK.

"" Vous pouvez choisir plusieurs listes de chaînes favorites.

4.	 Sélectionnez de nouveau OK. Le téléviseur a ajouté la chaîne en cours aux listes de chaînes favorites que vous 
avez sélectionnées.
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Enregistrement de plusieurs chaînes dans la liste de chaînes favorites

Pour enregistrer plusieurs chaînes dans la liste de chaînes favorites en même temps :
1.	 Appuyez sur la touche MENU, et sélectionnez l'option Diffusion > Modif. favoris.

2.	 Sélectionnez les chaînes que vous voulez ajouter à vos listes de chaînes favorites à partir de la liste à l'écran.

3.	 Sélectionnez la touche Changer Fav. à l'écran.

4.	 Appuyez à répétition sur la touche E de la télécommande standard pour faire le tour des listes de Favoris 
jusqu'à ce que vous tombiez sur la liste désirée.

5.	 Sélectionnez la touche Ajouter à l'écran. Le téléviseur ajoute les chaînes sélectionnées à la liste de chaînes 
favorites que vous avez choisie.

Faire des sélections uniquement à partir de la liste des chaînes favorites
Pour parcourir la liste de chaînes favorites seulement et sélectionner une chaîne à l'aide des touches de flèches 
vers le haut et le bas :

"" Vous pouvez sélectionnez une liste de chaînes favorites seulement si au moins une chaîne a été ajoutée à cette liste.

1.	 Appuyez sur la touche MENU, et sélectionnez l'option Diffusion > Liste des chaînes. La Liste des chaînes 
s'affiche.

2.	 Appuyez sur la touche £. Une liste de chaînes favorites s'affiche.

3.	 Appuyez sur la touche ¡ ou £ pour afficher d'autres listes de chaînes favorites.

4.	 Surlignez une chaîne dans la liste de chaînes favorites sélectionnée en utilisant les touches ascendante/
descendante des chaînes, puis sélectionnez-la. La chaîne change.
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Modifier la liste de chaînes favorites
MENU > Diffusion > Modif. favoris

Vous pouvez renommer et modifier les listes de chaînes favorites.

Modifier les éléments du menu de l'écran Favoris
Sélectionnez Options à l'écran Modif. favoris pour accéder aux options suivantes :

●● Copier dans Favoris

Sert à copier des chaînes d'une liste de chaînes favorites dans une autre. Reportez-vous à la section « Copier 
des chaînes d'une liste de chaînes favorites dans une autre » pour avoir plus de renseignements.

"" Vous pouvez utiliser l'option Copier dans Favoris seulement si vous avez enregistré une ou plusieurs chaînes dans 
au moins une liste de chaînes favorites.

●● Renommer les favoris

Sert à renommer une liste de chaînes favorites existantes. Reportez-vous à la section « Renommer une liste 
de chaînes favorites » pour avoir plus de renseignements.

"" Cette fonction n'est disponible que si au moins une chaîne a été ajoutée à au moins une liste de chaînes favorites.

●● Antenne

Choisissez l'option Hertzien ou Câble.

●● Modifier la chaîne

Vous sert à gérer les chaînes enregistrées dans le téléviseur. Pour de plus amples renseignements, reportez-
vous à la section « Enregistrer, retirer et modifier des chaînes ».

●● Information

Affichez de l'information détaillée sur l'émission en cours.
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Retrait de chaînes enregistrées d'une liste de chaînes favorites

Pour supprimer des chaînes de votre liste de favoris :
1.	 Sélectionnez Changer Fav..

2.	 Appuyez à répétition sur la touche E pour passer de la liste de Favoris à l'écran à celle que vous désirez 
utiliser.

3.	 Sélectionnez les chaînes que vous voulez retirer de la liste de chaînes favorites sélectionnée.

4.	 Sélectionnez Supprimer. Les chaînes sont retirées de la liste.

Changer l'ordre des chaînes dans une liste de chaînes favorites

Pour modifier l'ordre des chaînes dans une liste de chaînes favorites :
1.	 Sélectionnez Changer Fav. à l'écran.

2.	 Appuyez à répétition sur la touche E pour passer de la liste de Favoris à l'écran à celle que vous désirez 
utiliser.

3.	 Dans la liste sélectionnée, choisissez les chaînes que vous voulez déplacer.

"" Le téléviseur déplacera le groupe de chaînes que vous avez sélectionnées et les réorganisera de façon à ce qu'elles 
soient affichées l'une après l'autre dans leur nouvel emplacement.

4.	 Sélectionnez Modif. ordre. La fonction de surbrillance de modification de l'ordre apparaît et la chaîne que 
vous avez déplacée se trouvant le plus près du haut de la liste est mise en surbrillance.

5.	 Appuyez sur les touches fléchées </> pour déplacer les chaînes que vous avez sélectionnées. Appuyez sur 
la touche E pour faire passer les chaînes à une nouvelle position sur la liste.
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Renommer une liste de chaînes favorites

Pour renommer une liste de chaînes favorites existante : 
1.	 Sélectionnez la touche Options à l'écran. Une liste d'options s'affiche.

2.	 Sélectionnez l'option Renommer les favoris dans la liste. Une fenêtre contextuelle s’affiche.

3.	 Dans la fenêtre contextuelle, sélectionnez la liste de chaînes favorites que vous voulez renommer. Le clavier 
s'affiche à l'écran.

4.	 Sur le clavier, sélectionnez la touche Image claire de droite. Le nom courant apparaissant dans la zone de 
saisie disparaît.

5.	 Entrez un nouveau nom à l'aide du clavier. Le nouveau nom peut contenir jusqu'à 20 caractères.

6.	 Quand vous avez terminé, sélectionnez Fait. La liste des listes de chaînes favorites apparaît sous son nouveau 
nom. Sélectionnez OK.

Copier des chaînes d'une liste de chaînes favorites dans une autre

Pour copier les chaînes d'une liste de chaînes favorites à une autre : 
1.	 Sélectionnez Changer Fav..

2.	 Appuyez à répétition sur la touche E pour passer de la liste de Favoris à l'écran à celle qui contient les 
chaînes que vous désirez copier.

3.	 Sélectionnez la touche Options à l'écran. Une liste d'options s'affiche.

4.	 Sélectionnez l'option Copier dans Favoris dans la liste. Une fenêtre contextuelle s’affiche.

"" Copier dans Favoris est disponible seulement si au moins une chaîne a été ajoutée à une liste de chaînes favorites.

5.	 Dans la fenêtre contextuelle, sélectionnez la liste de chaînes favorites vers laquelle vous voulez copier les 
chaînes sélectionnées.

6.	 Une fois terminé, sélectionnez OK. Le téléviseur copie les chaînes. Sélectionnez de nouveau OK.
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Rendre les émissions de sport plus réalistes avec le mode 
« Soccer »
MENU > Système > Mode Soccer

Cette fonction n'est pas disponible aux États-Unis et au Canada.

Activer la Mode Soccer
MENU > Système > Mode Soccer > Mode Soccer

Allez à Système > Mode Soccer et ensuite réglez Mode Soccer à Activer. Les modes image et son du téléviseur sont 
automatiquement optimisés pour les événements sportifs.

"" En activant la fonction Mode Soccer le Image Mode passe à Stade et le Son Mode à Stade, et désactive certains menus 
Image et Son.

"" Appuyez sur le bouton ¥ pour activer ou désactiver le Mode Soccer.

"" a (Zoom): Interrompt la lecture et divise l'image en 9 parties. Sélectionne une partie pour faire un zoom.
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Fonctions de soutien au visionnement de la télévision

Affichage des sous-titres
MENU > Système > Accessibilité > Sous-titres Ess. maint.

Permet l'affichage de sous-titres pendant que vous regardez la télévision.
"" Même si la fonction de sous-titrage est activée, ils ne seront pas affichés pour les émissions qui ne prennent pas en 

charge les sous-titres.

Activation des sous-titres Ess. maint.

Sélectionnez Système > Accessibilité > Sous-titres > Sous-titres
"" Le téléviseur ne peut pas contrôler ou modifier les sous-titres présents sur les DVD ou Blu-ray. Pour contrôler les sous-

titres des DVD ou Blu-ray, utilisez la fonction de sous-titre du lecteur DVD ou Blu-ray et la télécommande du lecteur.

Sélection de la lange de sous-titrage Ess. maint.

Sélectionnez Système > Accessibilité > Sous-titres > Mode ss-titres codés pour afficher la liste des modes de sous-
titres. La liste des modes peut varier selon le programme.

●● Par défaut / CC1 ~ CC4 / Texte1 ~ Texte4

(Chaînes analogiques seulement) La fonction de sous-titrage analogique peut être exécutée avec les chaînes 
analogiques ou lorsque le signal reçu par le téléviseur provient d'un appareil externe. (Selon le signal de 
diffusion, il se peut que le sous-titrage analogique ne fonctionne pas avec les chaînes numériques.)

●● Par défaut / Service1 ~ Service6 / CC1 ~ CC4 / Texte1 ~ Texte4

(Chaînes numériques seulement) La fonction de sous-titrage numérique fonctionne avec les chaînes 
numériques. Les fonctions Service1 à Service6 pourraient ne pas être disponibles en mode de sous-titrage 
numérique, selon le système de diffusion utilisé.
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Modification de la couleur et de l'opacité de la police ainsi que la taille des sous-titres Ess. maint.

Modifier les valeurs des paramètres de couleur de la police, de couleur de l'arrière plan et de la taille des sous-titres.

Sélectionnez Système > Accessibilité > Sous-titres > Options de sous-titrage numérique, puis choisissez le réglage 
à modifier.

●● Taille

Sert à modifier la taille de la police. La fonction Taille n'est pas prise en charge par les chaînes analogiques.

●● Style des polices

Permet de choisir le style de la police des sous-titres.

●● Couleur de police

Permet de changer la couleur de la police.

●● Couleur arrière-plan

Permet de changer la couleur de l'arrière-plan du sous-titre.

●● Couleur de la fenêtre

Permet de choisir la couleur de la fenêtre de sous-titrage numérique.

●● Opacité de la police

Permet de changer l'opacité des sous-titres.

●● Opacité arrière-plan

Permet de changer l'opacité de l'arrière-plan.

●● Opacité de la fenêtre

Permet de choisir le niveau de transparence de la fenêtre de sous-titrage numérique.

●● Type bord.

Permet de choisir le type de contour des sous-titres numériques.

●● Cou. bord.

Permet de choisir la couleur du contour des sous-titres numériques.

●● Retour par défaut

Permet de restaurer toutes les options d'affichage des sous-titres aux paramètres par Par défaut Les 
réglages par Par défaut s'applique aux paramètres choisis par la station de télévision.

"" Les paramètres d'opacité et de couleur de l'avant et de l'arrière-plan ne peuvent être identiques.
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Activer le guide audio pour la description vidéo
MENU > Système > Accessibilité > Description vidéo Ess. maint.

Sélectionnez Système > Accessibilité > Description vidéo. Permet d'activer le guide audio pour les personnes 
malvoyantes. Cette fonction est disponible seulement avec les diffiusions qui offrent ce service.

Diffusion des émissions ISI
MENU > Image > ISI Ess. maint.

Utilisez la fonction ISI (Image sur image) pour écouter la télévision dans une petite fenêtre dans l'écran principal 
tout en écoutant du contenu provenant d'un lecteur DVD, d'un lecteur Blu-ray, d'un ordinateur ou d'un appareil 
externe différent à l'écran principal.

Sélectionnez Image > ISI pour afficher l'écran de configuration ISI. Les options suivantes sont disponibles dans 
l'écran de configuration ISI :

●● PIP Setting

Permet d'activer/de désactiver la fonction ISI.

●● Antenne

Choisissez entre Hertzien et Câble comme mode de chaîne numérique.

●● Chaîne

Permet de sélectionner la chaîne de l'image secondaire ISI.

●● Taille

Permet de sélectionner le format de l'image secondaire pour la fonction ISI.

●● Position

Permet de sélectionner la position de l'image secondaire pour la fonction ISI.

●● Sélection son

Permet de sélectionner la source audio.

Permet de choisir un système de diffusion.
"" Vous ne pouvez pas utiliser la fonction ISI lorsque vous utilisez Smart Hub ou la fonction 3D. (S'applique aux pays ou aux 

modèles prenant en charge le mode 3D.)

"" La mise hors tension automatique du téléviseur désactive automatiquement le mode ISI.

"" Jouer ou utiliser la fonction karaoké sur l'écran principal peut diminuer la qualité de l'image en mode ISI.

"" Pour profiter de la fonction ISI, la source principale du téléviseur doit être HDMI ou Composante, et la résolution 
d'entrée doit être inférieure à la haute définition intégrale (1080p). Le sous-écran ISI ne prend en charge que les chaînes 
numériques.
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Recherche des chaînes disponibles
MENU > Diffusion > Prog. auto Ess. maint.

Recherche et indexe automatiquement toutes les chaînes reçues grâce au connecteur d'entrée de l'antenne du 
téléviseur.

"" N'utilisez pas cette fonction si votre téléviseur est connecté à un câble ou un décodeur satellite.

"" Si le téléviseur a des chaînes enregistrées, la fonction « Prog. auto » supprime la liste existante, puis sauvegarde les 
chaînes nouvellement balayées.

1.	 Sélectionnez Diffusion > Prog. auto.

2.	 Sélectionnez Démarrer à l'invite. Ceci lance la fonction de programmation automatique. Cette procédure 
peut durer jusqu’à 30 minutes.

Sélection de la langue audio de diffusion
MENU > Diffusion > Options audio Ess. maint.

Configurez la langue audio du programme. Les options audio s'utilisent différemment pour les chaînes analogiques 
et numériques.

"" Appuyez sur la touche INFO pour voir les informations relatives au signal audio de la diffusion en cours.

Sélection de la langue audio de diffusion (numérique)

●● Sélection d'une langue Ess. maint.

Sélectionnez Options audio > Langue privilégiée, puis choisissez une langue. Les diffusions numériques 
contiennent des signaux audio en plusieurs langues. Les émissions numériques contenant la langue que vous 
avez choisie dans Langue privilégiée sont automatiquement lues dans cette langue. Si la langue que vous avez 
choisie n'est pas prise en charge par le signal de diffusion, le téléviseur utilisera la langue audio par défaut 
configurée par la station de télévision. 
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Sélection de la langue audio de diffusion (analogue)

●● Écouter une sortie audio multipistes Ess. maint.

Sélectionnez Options audio > Son multi-piste. Permet de configurer le son pour l'émission en cours de 
diffusion. L'option Son multi-piste peut être réglée sur le mode mono ou stéréo, en fonction du signal de 
diffusion ou de l'émission. Cependant, cette option est automatiquement réglée sur le mode mono si le signal 
de diffusion ou l'émission ne prend pas en charge le mode stéréo.

"" Appuyez sur la touche INFO pour voir les informations relatives au signal audio de la diffusion en cours.

"" Lorsque vous regardez une émission, appuyez sur la touche TOOLS, puis sélectionnez Son multi-piste.

Réglage précis de l'écran
MENU > Diffusion > Config. des chaînes > Syn. Précise Ess. maint.

"" Cette option est disponible seulement pour les programmes analogiques.

Les images analogiques peuvent devenir instables et bruyantes. Si cela se produit, vous pouvez syntoniser le signal 
et/ou réduire le bruit pour rendre l'image plus nette.
1.	 Sélectionnez Diffusion > Config. des chaînes > Syn. Précise. Une barre d'ajustement apparaît dans le bas de 

l'écran.

2.	 Appuyez sur la touche ¡ ou £ pour faire des ajustements. Sélectionnez Enregistrer ou Fermer pour 
appliquer le nouveau paramètre. Sélectionnez Régler pour réinitialiser l'opération de syntonisation.

Suppression des chaînes brouillées.
MENU > Diffusion > Config. des chaînes > Effacer les canaux brouillés

Éliminez les chaînes brouillées de votre liste de chaînes programmée automatiquement.
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Changement du mode d'image et ajustement de la qualité 
d'image

Sélection du mode d'image approprié pour l'environnement de visionnement
MENU > Image > Image Mode Ess. maint.

Les modes d'image suivant utilisent des réglages différents pour le contraste et la luminosité afin d'offrir la 
meilleure expérience de visionnement pour votre environnement.

"" Allez à Entrer le nom, si vous utilisez le réglage PC pour PC ou DVI PC, les deux seuls modes disponibles seront Standard 
et Divertiss..

"" Certaines options ne pas prises en charge en fonction selon le modèle ou le pays.

●● Dynamique

Si la lumière ambiante est trop lumineuse et qu'elle rend l'image à l'écran floue, utilisez ce mode pour rendre 
l'image plus claire.

●● Standard

C'est le mode par défaut qui convient à la plupart des environnements.

●● Naturel

Ce mode permet d’éviter la fatigue oculaire.

●● Cinéma

Idéal pour les pièces sombres, pour regarder des films et en cas de fatigue oculaire. Permet d'assombrir 
l'image, la rendant moins éblouissante.

●● Divertiss.

Permet d'accentuer la netteté de l'image et offre une expérience de visionnement plus dynamique. 

"" Ce mode n'est disponible que lorsque vous utilisez le réglage PC pour PC ou DVI PC dans Entrer le nom.

Réglages de l'image et du son
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Ajustement de la qualité de l'image pour chaque mode d'image.
MENU > Image

Sélectionnez l'un des paramètres suivants à partir du menu Image pour afficher la barre permettant d'ajuster 
le réglage sélectionné. Réglez la valeur en appuyant sur la touche fléchée ¡ ou £ e la télécommande. Pour 
sélectionner un réglage différent, appuyez sur la touche < ou >. Les valeurs réglées sont appliquées à la source 
et au mode Image en cours.

"" Les réglages Couleur et Teinte (V/R) ne peuvent être ajustés lorsque le téléviseur est branché à un ordinateur par 
l'intermédiaire d'un câble HDMI vers DVI.

Choisissez les options Image Mode - Dynamique, Standard, Naturel, Cinéma - et ensuite ajustez les réglages.

●● Contre-jour Ess. maint.

Permet d'ajuster la luminosité et les pixels. La diminution du niveau de luminosité de l'image réduit la 
consommation d'énergie.

●● Contraste Ess. maint.

Permet de régler le contraste de l'image.

●● Luminosité Ess. maint.

Permet de régler la luminosité globale.

●● Netteté Ess. maint.

Permet d'accentuer ou de diminuer la définition des bords des objets.

●● Couleur Ess. maint.

Permet de régler la saturation globale des couleurs.

●● Teinte (V/R) Ess. maint.

Permet de régler le niveau du vert vers le rouge. Vous pouvez augmenter les valeurs du vert et du rouge pour 
que ces couleurs deviennent saturées.

"" Les valeurs réglées sont enregistrées par le téléviseur pour la source et le mode de visionnement en cours et restent en 
vigueur la prochaine fois que la source et le mode de visionnement sont sélectionnés. Par conséquent, le téléviseur peut 
avoir des paramètres de l'image différents pour chaque source externe.
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Appliquer les réglages de l'image en cours à d'autres sources d'entrée Ess. maint.

MENU > Image > Appliquer le mode image

Vous pouvez appliquer un réglage de qualité de l'image que vous avez configuré à l'ensemble des appareils externes 
branchés à votre téléviseur ou à la source en cours seulement.

Pour appliquer le réglage à tous les appareils externes branchés au téléviseur, sélectionnez Toutes sources. Pour 
appliquer le réglage à l'entrée en cours seulement, sélectionnez Source active.

Réglages précis de chaque mode d'image (Réglages avancés)
MENU > Image > Réglages avancés Ess. maint.

Sélectionnez la fonction Image > Réglages avancés pour faire un réglage précis des images à l'écran du téléviseur 
pour chaque Image Mode.

"" L'option Réglages avancés n'est disponible que lorsque la Image Mode est réglée sur Standard ou Cinéma. 

"" Lorsque le téléviseur est branché à un ordinateur au moyen d'un câble HDMI vers DVI, seuls Équilibrage du blanc et 
Gamma peuvent être ajustés.

Choisissez un Image Mode, puis ajustez les réglages.

●● Contraste dyn. Ess. maint.

Permet le réglage automatique du contraste de l'image. Cette option permet d'optimiser le réglage du 
contraste.

●● Tonalité noire Ess. maint.

Permet de régler la profondeur du noir.

●● Ton chair Ess. maint.

Permet d'assombrir ou d'éclaircir les tons chair.

●● Mode RVB uniqu. Ess. maint.

Permet de régler les niveaux du rouge, du vert et du bleu séparément.
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●● Espace couleur

Les modèles à DEL de série 5300, 5200, 5100, 4300 et 4200 ne prennent pas en charge la fonction 
Personnalisé.

Réglez la palette de couleurs (Espace couleur) que le téléviseur peut afficher. Auto permet de régler 
automatiquement l'espace couleur en fonction du signal d'entrée. Natif permet d'appliquer une palette plus 
vaste que celle du signal d'entrée. Personnalisé permet de régler l'espace couleur de façon manuelle.

●● Équilibrage du blanc

–– Pour les téléviseurs à DEL, modèles 5300, 5200, 5100, 4300 et 4200

Permet de régler la température de la couleur de l'image pour que les objets blancs paraissent blancs; ainsi, 
l'image paraît naturelle dans son ensemble. Vous pouvez réglez la luminosité de chacune des trois couleurs au 
moyen des menus Décal. et Gain. Pour restaurer les valeurs par défaut, sélectionnez Régler.

–– Pour les modèles à DEL de série 6100 et ultérieures

Permet de régler la température de la couleur de l'image pour que les objets blancs paraissent blancs; ainsi, 
l'image paraît naturelle dans son ensemble.

2 Points : vous permet de régler la luminosité du rouge, du vert et du bleu grâce au menu Décal. et la 
luminosité globale grâce au menu Gain. Pour restaurer les valeurs par défaut, sélectionnez Régler.

10 Points: permet de diviser le vert, le rouge et le bleu en dix sections chacun, et de modifier l'équilibrage 
des blancs en réglant la luminosité de chacune des sections. Sélectionner la section à régler dans le champ 
Niveau.

"" Vous pouvez utiliser la fonction 10 Points uniquement si l'option Image Mode est réglée à Cinéma. Cette fonction 
n'est pas compatible avec tous les appareils externes.

●● Gamma Ess. maint.

Permet de régler l’intensité de la couleur primaire.

●● Luminosité mouvement Ess. maint.

Permet d'ajuster la luminosité en fonction des mouvements à l'écran afin de réduire la consommation 
d'énergie.

"" Cette fonction n'est disponible que si le Image Mode est réglé à Standard; elle n’est pas prise en charge en mode 
3D. (S'applique aux pays ou aux modèles prenant en charge le mode 3D.)

"" L'ajustement des paramètres Contraste, Luminosité, ainsi que des autres réglages de la qualité de l’image désactive 
la fonction Luminosité mouvement.
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Réglage de l'image pour avoir une meilleure qualité de visionnement (Options 
d'image)
MENU > Image > Options d'image Ess. maint.

Sélectionnez Image > Options d'image pour faire des réglages supplémentaires pour obtenir une meilleure qualité 
de visionnement.

"" Lorsque le téléviseur est branché à un ordinateur au moyen d'un câble HDMI vers DVI, seule la Nuance coul. peut être 
ajustée.

Choisissez un Image Mode, puis ajustez les réglages.

●● Nuance coul. Ess. maint.

Permet de régler la nuance de couleur. Le réglage s'applique à chaque Image Mode. Lorsque vous 
sélectionnez un nouveau Image Mode, le téléviseur applique la nuance de couleur que vous avez sélectionnée 
automatiquement pour ce mode.

"" Si le Image Mode est réglé à Dynamique, vous ne pourrez choisir que Froide ou Standard.

●● Image claire numérique Ess. maint.

Permet d'éliminer les parasites et les images rémanentes causées par un signal faible. Si vous sélectionnez 
Visualisation auto, la puissance du signal s'affiche à l'écran. Le vert indique le meilleur signal possible.

"" Cette fonction n'est disponible que pour les chaînes analogiques.

●● Filtre bruit MPEG Ess. maint.

Permet de réduire le bruit MPEG et d'améliorer la qualité vidéo.

●● Nv nr HDMI Ess. maint.

Pour certains appareils externes branchés au téléviseur par l'entremise d'un câble HDMI, la qualité de l'image 
peut se dégrader (diminution du niveau de noir, faible contraste, décoloration, etc.). Utilise la valeur de niveau 
du noir HDMI pour ajuster le niveau du noir pour corriger le problème.

"" Ce mode est disponible uniquement lorsque le signal d'entrée, et que la connexion au téléviseur est assurée par un 
connecteur HDMI, réglé à RGB444.
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●● Mode Film Ess. maint.

Permet d'optimiser la qualité des films. Sélectionnez ce mode pour regarder des films.

"" Cette fonction est disponible seulement lorsque vous regardez une émission télévisée ou si le signal d'entrée est 
AV, Composante (480i, 1080i), ou HDMI (1080i).

●● Auto Motion Plus

Cette fonction est disponible uniquement avec les modèles à DEL de série 6100 et ultérieures.

Permet d'éliminer le flou et l'effet de flou de scènes très animées. Si vous sélectionnez Personnalisé, vous 
pouvez configurer la Réduction du flou et la Réd. effet de flou manuellement et régler la fonction DEL 
mouvement clair de façon à obtenir une image plus nette sur un téléviseur à DEL.

"" Si la fonction Auto Motion Plus est activée et que vous faites apparaître l'écran INFO, l'écran INFO affiche la 
résolution et la fréquence du signal vidéo entrant (60Hz). La fréquence ne correspond pas à la fréquence de 
l'image affichée à l’écran du téléviseur lorsque la fonction Auto Motion Plus est activée.

"" Si le mode DEL mouvement clair est réglé à Activer et que le téléviseur reçoit un signal vidéo de 60 Hz, il se peut 
que l'écran scintille.

"" Lorsque l'option DEL mouvement clair est réglée sur Activer, l'écran est plus sombre qu'à l'habitude. 

●● DEL mouvement clair

Cette fonction est disponible seulement pour les téléviseurs à DEL de série 5300, 5200, 5100, 4300 et 4200.

Élimine la traînée des scènes rapides très animées afin de rendre l’image plus claire.
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Visionnement 3D
MENU > Image > 3D

La fonction 3D n'est pas offerte aux États-Unis ou au Canada, et est seulement offerte sur les téléviseurs à DEL de 
série 6200 ou d'une série supérieure.

L'option 3D permet le visionnement 3D des contenus média et diffusions 3D. Vous devez porter vos lunettes 3D 
Active de Samsung pour lire un contenu 3D. Les lunettes 3D Active de Samsung de type IR ou les lunettes 3D d'un 
autre fabricant ne sont pas prises en charge.

"" Lisez attentivement les instructions de santé et sécurité concernant le visionnement de contenus en 3D avant toute 
utilisation du mode 3D. Reportez-vous à la section « Précautions à suivre pour visionner du contenu 3D » pour avoir plus 
de renseignements.

"" L'affichage en haute définition de la vidéo 3D dépend habituellement de la qualité et du format du contenu.

Démarrage de la fonction 3D
1.	 Appuyez sur la touche 3D de votre télécommande ou sélectionnez la télécommande 3D à l'écran.

2.	 Effectuez la lecture du contenu 3D.

3.	 Portez les lunettes 3D Samsung, puis mettez les sous tension. Le visionnement 3D est activé.

La distance de visionnement idéale est d’au moins trois fois la hauteur de l’écran. Les images 3D pourraient ne pas 
être affichées si vous ne respectez pas les angles ou la distance de visionnement recommandés.

La fonction 3D peut ne pas fonctionner correctement si un autre produit ou appareil électronique 3D est sous 
tension à proximité. En cas de problème, éloignez le plus possible les autres appareils électroniques des lunettes 
3D Active.

Les images 3D de droite et de gauche pourraient se superposer plus qu'à l'habitude lorsque le téléviseur est allumé. 
Il faut un moment pour que l'affichage soit optimisé et que la superposition cesse.

Il existe plusieurs restrictions relatives à l'utilisation de la télévision 3D :

●● Le lancement de la fonction Smart Hub désactive automatiquement le mode 3D.

●● L'option ISI ne peut pas être utilisée.

●● Certaines options Image sont désactivées.
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Changement du mode 3D
MENU > Image > 3D > Mode 3D
1.	 Appuyez sur la touche 3D de votre télécommande pour activer la fonction 3D, puis sélectionnez la fonction 

Mode 3D sous Image > 3D.

2.	 Choisissez l'un des modes 3D qui s'affichent à l'écran. Les modes 3D pris en charge peuvent varier en fonction 
du contenu 3D.

"" Les réglages du Mode 3D sont configurés automatiquement pour la plupart des contenus 3D.

Les modes 3D suivants sont disponibles. Cependant, la disponibilité des modes peut varier en fonction du format du 
contenu 3D.

"" Les types de résolutions prises en charge varient selon le mode. Reportez-vous à la section « Résolutions prises en 
charge pour les modes 3D » pour avoir plus de renseignements.

●● Of fOf f  (Off)

Désactive le visionnement 3D.

●●  (Normal)

Convertit les images normales en images 3D.

"" Certains formats ne prennent pas en charge ce mode.

●●  (G/D)

Permet de fractionner l'image en deux images superposées gauche et droite pour créer un effet 3D.

●●  (H/B)

Permet de fractionner l'image en deux images superposées haut et bas pour créer un effet 3D.
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Ajustement de l'effet 3D
MENU > Image > 3D

Réglez les paramètres du point de référence visuel, de profondeur et autres paramètres 3D pour personnaliser 
votre expérience de visionnement.

"" Tous les effets 3D à l'exception de Affichage 3D auto peuvent être utilisés lors du visionnement d'un contenu 3D.

●● Ajustement du point de référence visuel de l'effet 3D

Sélectionnez Image > 3D > Perspective 3D. Utilisez la barre d'ajustement affichée à l'écran pour régler le 
point de référence visuel.

●● Ajustement de la profondeur de l'effet 3D

Sélectionnez Image > 3D > Profondeur. Utilisez la barre d'ajustement affichée à l'écran pour régler la 
profondeur.

"" Cette option ne peut pas être utilisée si le mode 3D mode est réglé sur  (Gauche/Droite) ou  (Haut/Bas).

●● Inverser les images 3D gauche/droite 

Sélectionnez Image > 3D > Inversion G/D. Utilisez cette fonctionnalité pour inverser les images de gauche et 
de droite.

●● Affichage d'une contenu 3D en 2D 

Sélectionnez Image > 3D > 3D → 2D. Utilisez cette fonctionnalité pour permettre le visionnement 2D de 
contenu 3D.

"" Cette fonction n'est pas disponible si le mode 3D est réglé à  (Normal) ou Of fOf f  (Désactiver).

●● Ajustement de la luminosité 3D

Sélectionnez Image > 3D > 3D Light Control. Réglez le niveau de luminosité 3D. Si l'écran est trop sombre, 
sélectionnez Élevé.
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Fonctions de prise en charge de l'image

Diffusion des émissions ISI
MENU > Image > ISI Ess. maint.

Regardez une vidéo à partir d'un appareil externe tel qu'un lecteur Blu-ray sur l'écran principal tout en regardant 
une émission de télévision dans la fenêtre Image sur image.

Sélectionnez Image > ISI pour afficher la fenêtre de configuration ISI. Les options suivantes sont disponibles dans la 
fenêtre de configuration ISI : 

●● ISI

Permet d'activer/de désactiver la fonction ISI.

●● Antenne

Choisissez Hertzien ou Câble comme source d'entrée pour la fenêtre d'image secondaire ISI.

●● Chaîne

Permet de sélectionner la chaîne de l'image secondaire ISI.

●● Taille

Permet de sélectionner le format de l'image secondaire pour la fonction ISI.

●● Position

Permet de sélectionner la position de l'image secondaire pour la fonction ISI.

●● Sélection son

Permet de sélectionner la source audio.

Permet de choisir un système de diffusion.
"" Vous ne pouvez pas utiliser la fonction ISI lorsque la fonction Smart Hub ou 3D est activée. (S'applique aux pays ou aux 

modèles prenant en charge le mode 3D.)

"" La mise hors tension automatique du téléviseur désactive automatiquement le mode ISI.

"" Jouer ou utiliser la fonction karaoké sur l'écran principal peut diminuer la qualité de l'image en mode ISI.

"" Pour que la fonction ISI fonctionne, la source de l'écran principal doit être un signal Composante ou HDMI, et la 
résolution d'entrée doit être au minimum HD intégrale (FHD). Le sous-écran ISI ne prend en charge que les chaînes 
numériques.
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Modifier la position et la taille de l'image

Choisir la taille de l'écran appropriée Ess. maint.

MENU > Image > Image Format > Image Format

La plupart des émissions de télévision et vidéos sont affichées en mode plein écran, mais certaines sont affichées 
dans des tailles plus grandes ou plus petites. Vous pouvez modifier la taille de l'écran afin que l'image de ces 
émissions et vidéos remplisse mieux l'écran. 

"" Les dimensions d'écran pris en charge varient en fonction du signal d'entrée. Pour de plus amples renseignements à ce 
sujet, reportez-vous à la section « Dimensions de l'image et signaux d'entrée ».

●● 16:9

Réglez l'image au format écran large 16:9.

●● Zoom1

Permet d'agrandir verticalement l'image 16:9. Vous pouvez déplacer une image agrandie vers le haut ou vers 
le bas.

●● Zoom2

Permet d'agrandir une image agrandie (Zoom 1) davantage. Vous pouvez déplacer une image agrandie vers 
le haut ou vers le bas.

●● Format large

Permet d'augmenter le rapport hauteur/largeur de l'image pour qu'elle remplisse l'écran en entier. Vous 
pouvez ainsi regarder les images 3:4 en format 16:9 sans déformation.

●● 4:3

Permet de régler l'image au mode 4:3.

●● Plein écran

Permet d'afficher l'intégralité de l'image sans coupure.

●● Vue intell. 1

Permet de réduire l'image 16:9 de 50%.

●● Vue intell. 2

Permet de réduire l'image 16:9 de 25 %.
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Régler la position de l'image Ess. maint.

MENU > Image > Image Format > Position

Permet de régler la position de l'image.
"" Cette option n'est disponible que si la fonction Taille est réglée à Zoom1, Zoom2, Format large ou Plein écran. Lorsque 

le téléviseur est réglé sur une chaîne numérique, la position de l'écran ne peut être modifiée si l'option Image Format est 
réglée sur Plein écran.

1.	 Pour régler la position de l'écran, sélectionnez Image > Image Format > Position. Une fenêtre contextuelle 
s’affiche.

2.	 Sélectionnez Position de nouveau dans la fenêtre contextuelle.

3.	 Appuyez sur la <, >, ¡ ou £ pour déplacer l'écran. Une fois terminé, sélectionnez Position, et ensuite 
Fermer. Sélectionnez Régler pour rétablir la position de l'écran.

Lecture audio seulement avec l'écran éteint (Image Non)
MENU > Image > Image Non Ess. maint.

Désactive l'écran et permet la lecture audio par les haut-parleurs seulement. Pour rallumer l'écran, appuyez sur 
une touche (sauf les touches du volume et de mise sous tension).

Réinitialiser les réglages du mode Image
MENU > Image > Réinitial. image Ess. maint.

Utilisez cette option pour rétablir tous les réglages du Image Mode en cours aux réglages définis par défaut. Cela 
n'a pas d'incidence sur les autres modes d'image.
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Changer de mode Son et utiliser les effets sonores

Sélection du mode Son approprié pour l'environnement
MENU > Son > Son Mode Ess. maint.

Les modes Son appliquent des réglages préétablis optimisés pour les différentes situations de visionnement et 
d'écoute à la sortie du son.

"" Les modes de son ne peuvent être utilisés lorsque vous utilisez des haut-parleurs externes.

●● Standard

Il s'agit du mode sonore normal.

●● Musique

Ce mode accentue la musique normale par rapport aux dialogues.

●● Cinéma

Ce mode est calibré pour obtenir le meilleur son pour les films.

●● Voix claire

Ce mode permet d'accentuer les dialogues.

●● Amplifier

Permet d’augmenter l’intensité du son aigu afin d’offrir une meilleure expérience d’écoute. Il est destiné aux 
personnes malentendantes.

Utilisation des effets sonores
MENU > Son > Effet sonore Ess. maint.

Les effets sonores vous permettent de modifier le son provenant du téléviseur.
"" Les effets sonores ne peuvent être utilisés que lorsque Son Mode est réglé à Standard.

"" Les effets sonores ne peuvent être utilisés lorsque vous utilisez des haut-parleurs externes.

Choisissez un Effet sonore, puis ajustez les réglages.

●● DTS TruSurround HD Ess. maint.

Produit un son qui vous donne l'impression d'être dans une salle de cinéma ou dans une salle de concert.

●● DTS TruDialog Ess. maint.

Cette fonction permet de mieux entendre les dialogues en augmentant l’intensité des dialogues.

●● Égaliseur Ess. maint.

Permet de régler l'équilibre entre les haut-parleurs et d'ajuster la largeur de bande. Pour réinitialiser les 
paramètres, sélectionnez Régler.
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Fonctions de prise en charge du son

Sélection des haut-parleurs
MENU > Son > Paramètres haut-parleur > Sortie du son du téléviseur

La fonction de sortie son du téléviseur vous permet de choisir quels haut-parleurs le téléviseur doit utiliser pour la 
sortie audio. Sélectionnez Son > Paramètres haut-parleur > Sortie du son du téléviseur, puis choisissez les haut-
parleurs dans la liste. Pour entendre le son par les haut-parleurs du téléviseur et les haut-parleurs d'un récepteur 
audiovisuel ou cinéma maison branché au téléviseur, sélectionnez Haut-parleur TV. Si vous entendez un écho, 
choisissez n'importe quelle autre option de haut-parleurs que Haut-parleur TV pour désactiver les haut-parleurs 
du téléviseur.

"" L'utilisation des haut-parleurs externes uniquement désactive la touche du volume et la fonction sourdine. De plus, 
certaines options de Son seront désactivées.

●● Haut-parleur TV

Écoutez le son grâce aux haut-parleurs intégrés du téléviseur.

●● Sortie audio

Écoutez le son du téléviseur grâce à des écouteurs ou aux haut-parleurs d'un appareil connecté au téléviseur 
à l'aide d'un câble optique numérique.

Détermination du type d'installation du téléviseur
MENU > Son > Paramètres haut-parleur > Type d'installation télé

Cette option permet de préciser le type d'installation du téléviseur. Vous avez le choix entre Mural et Socle pour 
optimiser automatiquement le son du téléviseur.
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Activation de la sortie sonore numérique
MENU > Son > Paramètres supplém. Ess. maint.

Ce téléviseur intelligent (Smart TV) prend en charge le format de sortie sonore numérique de Sony Philips (SPDIF). 
L'interface numérique de Sony Philips (SPDIF) permet d'obtenir un signal sonore numérique provenant des haut-
parleurs et des différents appareils numériques tels qu'un récepteur A/V ou cinéma maison.

●● Format audio Ess. maint.

Permet de sélectionner le format de sortie audionumérique (SPDIF). Le format de sortie audionumérique 
(SPDIF) varie selon la source d’entrée.

●● Retardateur audio Ess. maint.

Permet de corriger les problèmes de synchronisation audio-vidéo lorsque vous regardez un programme 
télévisé tout en écoutant une sortie audio numérique provenant d'un appareil externe. Lorsque vous activez 
cette fonction, une barre de défilement s'affiche pour vous permettre de régler la durée jusqu'à 250 m.

●● Comp. Dolby num. Ess. maint.

Régler le mode de compression Dolby Digital.

●● Volume auto Ess. maint.

Lorsque vous changez de chaînes, de sources vidéo ou de contenu, la fonction Volume auto règle 
automatiquement le volume du téléviseur de telle manière qu'il soit le même pour toutes les sources. Par 
exemple, si vous passez d'une application vidéo de diffusion en mode continu à un lecteur Blu-ray ou à une 
chaîne favorite, la fonction Volume auto peut modifier le volume de l'ordre de 12 dB pour égaliser le son.

La fonction Volume auto a deux réglages : Normal et Nuit. L'option Normal applique un niveau normal de 
réglage du volume. L'option Nuit applique un volume légèrement plus faible et est idéale pour regarder la 
télévision dans la soirée. Si vous voulez utiliser la commande du volume d'un appareil source externe branché 
pour contrôler le volume, vous devez désactiver la fonction Volume auto. Lorsque vous utilisez la fonction 
Volume auto avec un appareil source externe, il se peut que la commande du volume ne fonctionne pas 
correctement.

Écouter le son 3D en mode 3D
MENU > Son > Audio 3D

Cette fonction n'est pas disponible aux États-Unis et au Canada.

Cette fonction est disponible seulement pour les modèles de téléviseurs à DEL de la série 6200.

La technologie audio 3D offre un son ambiophonique correspondant à l'effet en relief de la vidéo 3D, grâce à une 
commande de profondeur du son en perspective.

"" Cette fonction n’est disponible qu’en mode 3D.

Réinitialisation de tous les réglages du son
MENU > Son > Réinitial. son Ess. maint.

Permet de rétablir tous les réglages du son aux réglages définis par défaut.
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Configuration de l'heure et utilisation du minuteur

Réglage de l'heure actuelle
MENU > Système > Heure > Horloge Ess. maint.

Permet de régler l’horloge manuellement ou automatiquement.

Pour voir l'heure après avoir réglé l'horloge, appuyez sur la touche INFO de votre télécommande.
"" Il faut régler l’horloge de nouveau chaque fois que le téléviseur est débranché du secteur d'alimentation.

Réglage de l'horloge à partir de l'écran d'information sur la diffusion numérique

MENU > Système > Heure > Horloge > Mode horloge Ess. maint.

Réglez Mode horloge à Auto. Le téléviseur télécharge automatiquement l'heure exacte à partir d'une chaîne 
numérique. Pour activer cette option, la prise d'antenne du téléviseur doit être branchée à une antenne ou à un 
câble de sortie et doit recevoir une diffusion numérique. L'exactitude de l'information relative à l'heure reçue 
peut dépendre de la chaîne et du signal. Vous devez régler l'heure manuellement si le téléviseur est branché à un 
câblosélecteur ou à un récepteur satellite par câble HDMI ou composante.

Si l'horloge n'est pas à la bonne heure en mode automatique...

MENU > Système > Heure > Horloge > Fuseau horaire Ess. maint.

Si l'heure réglée automatiquement au téléviseur n'est pas correcte, vous pouvez ajuster l'horloge en incréments 
d'une heure, à savoir -/+ 12 heures. Sélectionnez Système > Heure > Horloge > Fuseau horaire, puis rectifiez 
l'heure sur l'horloge.

"" La fonction Fuseau horaire vous permet de modifier l'heure grâce à une connexion réseau et est seulement disponible si 
la fonction Mode horloge est réglée à Auto et si le téléviseur est connecté à Internet grâce à un réseau local.

"" La fonction Fuseau horaire permet de régler l'heure si le téléviseur ne reçoit pas les données nécessaires par l'entremise 
des signaux numériques réguliers.

Général
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Réglage manuel de l'horloge

MENU > Système > Heure > Horloge > Réglage Horloge Ess. maint.

Suivez les étapes ci-après pour saisir manuellement l'heure et la date.
1.	 Réglez Mode horloge à Manuel, puis sélectionnez Réglage Horloge.

2.	 Sélectionnez Date. La fenêtre de saisie de la date s'affiche.

3.	 Les touches < et > vous permettent de changer le mois. Lorsque c'est fait, allez dans le champ Date, puis 
dans le champ Année et changez les valeurs de la même façon. Une fois la date entrée, appuyez sur la touche 
RETURN de la télécommande.

4.	 Sélectionnez le champ Heure. Les touches < et > vous permettent de changer l'heure.

5.	 Lorsque c'est fait, allez dans le champ Minutes, puis dans le champ am/pm et changez les valeurs de la même 
façon. Une fois la date entrée, appuyez sur la touche RETURN de la télécommande.

Utilisation des minuteurs

Utilisation de la minuterie de mise en veille

MENU > Système > Heure > Mise en veille Ess. maint.

Cette fonction permet d'éteindre automatiquement le téléviseur après un délai prédéfini. Sélectionnez Système 
> Heure > Mise en veille. Vous pouvez régler la minuterie par tranches pouvant aller jusqu'à 180 minutes par 
incréments de 30 minutes.



102

Mise sous tension du téléviseur à l'aide de la fonction Minuteur d'activ.

MENU > Système > Heure > Progr. activ. Ess. maint.

Réglez la fonction Progr. activ. pour que votre téléviseur se mette automatiquement sous tension à l’heure de 
votre choix. Vous pouvez faire trois réglages de Progr. activ. distincts en même temps : Progr. activ. 1, Progr. activ. 
2 et Progr. activ. 3. La fonction Minuteur d'activ. est disponible seulement si l'Horloge a été réglée.

●● Configuration

Sélectionnez Désactiver, Une fois, Quotid., Lun~Ven, Sam~Dim, ou Manuel. Si vous sélectionnez Manuel, vous 
pouvez sélectionner les jours où vous désirez que le Progr. activ. mette le téléviseur sous tension en mettant 
chacun de ces jours en évidence, puis en les sélectionnant.

●● Heure

Permet de régler l'heure à laquelle le téléviseur se mettra automatiquement sous tension. See "Réglage 
manuel de l'horloge" for time setting instructions.

●● Volume

Permet de définir le volume lorsque le téléviseur s'allume.

●● Source

Permet de sélectionner une source de signal dans la liste. Il s'agit de la source qui sera activée à la mise sous 
tension du téléviseur. Si vous voulez utiliser une clé USB, la clé doit être branchée au téléviseur avant de 
commencer la configuration des réglages du minuteur d'activation. Pour lire un support de média à partir 
d'une source HDMI ou d'une composante telle qu'un lecteur de DVD ou Blu-ray ou un récepteur satellite, 
l'appareil doit être laissé sous tension. Il doit être déjà sous tension au moment ou le téléviseur s'allume.

●● Antenne

Si vous avez réglé la Source à TV, sélectionnez une source de signal de diffusion, Hertzien ouCâble.

●● Chaîne

Si vous avez réglé la Source à TV, sélectionnez une chaîne.

●● Musique / Photo

Si vous avez réglé la Source à USB, choisissez le dossier d'un dispositif USB contenant des fichiers de 
musique dans le champ Musique ou le dossier contenant des fichiers d'image dans le champ Photo. Si vous 
sélectionnez un dossier contenant des fichiers de musique et un dossier contenant des fichiers de photo, le 
téléviseur lit les fichiers de musique et affiche en même temps les photos.
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Suivez les étapes ci-après pour sélectionner, par exemple, un dossier contenant des fichiers de musique :
1.	 Sélectionnez le champ Musique. L’écran Musique s’affiche.

2.	 Si votre lecteur USB ne contient aucun dossier et que tous vos fichiers de musique se trouvent dans le 
répertoire racine, mettez en évidence et sélectionnez la touche Sélectionner. La clé USB est sélectionnée et 
l'écran Progr. activ. apparaît de nouveau et affiche le nom de la clé USB dans le champ Musique.

3.	 Si votre lecteur USB contient des dossiers de musique, appuyez sur la touche E. Le téléviseur affichera tous 
les dossiers qui se trouvent dans le répertoire.

4.	 Faites dérouler la liste des dossiers jusqu'à ce que s'affiche celui que vous voulez. Placez le curseur à la touche 
Sélectionner à droite du répertoire. Appuyez sur la touche E. L'écran Progr. activ. apparaît de nouveau et 
le nom du dossier apparaît maintenant dans le champ Musique.

"" Si le dossier contient des sous-dossiers, vous pouvez sélectionner un sous-dossier de la même façon.

5.	 Vous pouvez également choisir un dossier de photo de la même façon. Commencez par sélectionner le champ 
Photo.

"" Cette option ne fonctionnera pas correctement si le dispositif USB sélectionné ne contient aucun fichier média ou si 
aucun dossier n'a été précisé.

"" Le diaporama ne débutera pas si le dispositif USB ne contient qu'un seul fichier image.

"" Les dossiers portant des noms longs ne peuvent être sélectionnés.

"" Les noms des dossiers doivent toujours être différents pour chaque clé USB.

"" Utilisez une clé USB ou un lecteur multicartes. La fonction Progr. activ. peut ne pas fonctionner avec certains dispositifs 
USB dotés d’une pile intégrée, les lecteurs MP3 ou les lecteurs média portables car il faut trop de temps pour reconnaître 
ces périphériques.

Mise hors tension du téléviseur à l'aide de la fonction Minuteur désact.

MENU > Système > Heure > Progr. désact. Ess. maint.

Réglez le Progr. désact. de manière que le téléviseur s’éteigne automatiquement à une heure prédéfinie. Vous 
pouvez faire trois réglages de Minuteur désact. distincts en même temps : Progr. désact. 1, Progr. désact. 2 et 
Progr. désact. 3. La fonction Minuteur désact. est disponible seulement si l'Horloge a été réglée.

●● Configuration

Sélectionnez Désactiver, Une fois, Quotid., Lun~Ven, Sam~Dim, ou Manuel. Si vous sélectionnez Manuel, vous 
pouvez sélectionner les jours où vous désirez que le Progr. désact. mette votre téléviseur hors tension en les 
mettant en surbrillance, puis en les sélectionnant.

●● Heure

Permet de régler l'heure à laquelle le téléviseur se mettra automatiquement hors tension.
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Utilisation des fonctions Protection contre la brûlure d'écran 
et Économie d'énergie

Prévention des brûlures d'écran
MENU > Système > Délai protect. auto. Ess. maint.

Les images fixes affichées sur l'écran pendant une longue période peuvent laisser des images rémanentes. Utilisez 
la fonction de protection contre la brûlure pour protéger l'écran. Sélectionnez Système > Délai protect. auto., puis 
choisissez une durée à partir de la liste. Si une image fixe s'affiche sur l'écran pendant une période qui dépasse la 
durée définie, le téléviseur activera automatiquement la fonction Protection contre la brûlure d'écran pour éviter 
la formation d'images rémanentes.

Utilisation des fonctions d'économie d'énergie
MENU > Système > Solution Eco Ess. maint.

La fonction Solution Eco permet de régler le niveau de luminosité du téléviseur et d'éviter la surchauffe afin de 
réduire la consommation générale d'énergie.

●● Écon. Énergie Ess. maint.

Sélectionnez un réglage de luminosité dans la liste pour réduire la consommation électrique du téléviseur.

●● Capteur Eco Ess. maint.

Permet de régler automatiquement le niveau de luminosité du téléviseur en fonction de la lumière ambiante 
afin de réduire la consommation d'énergie. Si le niveau de luminosité de l'écran a été réglé par le Capteur 
Eco, vous pouvez ajuster la luminosité minimale de l'écran au moyen de la fonction Rétroécl. min. ou Lumière 
cell. min. (pour les modèles concernés). Le fait de modifier le réglage de la fonction Contre-jour ou Lumière 
cell. min. (pour les modèles applicables) alors que le Capteur Eco fonctionne désactive automatiquement le 
Capteur Eco.

"" Cette fonction n'est pas disponible pour les modèles de série à DEL 4500.

"" Lorsque l'option Capteur Eco est réglée sur Activer, l'écran est plus sombre qu'à l'habitude.

●● Veille abs. sign. Ess. maint.

Sélectionnez l'heure dans la liste. Si aucun signal n'est émis après une certaine période, le téléviseur se met 
automatiquement sous tension pour réduire la consommation d'énergie.

●● Arrêt autom. Ess. maint.

Si le téléviseur reste en marche sans qu'il n'y ait aucune manipulation, il se met automatiquement hors tension 
pour éviter toute surchauffe.
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Mise à jour du logiciel du téléviseur
MENU > Support technique > Mise à jour du logiciel Ess. maint.

Affichez la version du logiciel du téléviseur et procédez à la mise à jour au besoin.

Le téléviseur est configuré pour mettre à jour automatiquement le logiciel par défaut par le biais d'Internet. Si vous 
ne voulez pas que la mise à jour se fasse automatiquement, réglez Mise à jour auto (Support technique > Mise à 
jour du logiciel > Mise à jour auto) à Désactiver.

[[ ÉVITEZ de couper l'alimentation avant la fin de la mise à jour. Le téléviseur se mettra hors tension et 
redémarrera automatiquement une fois la mise à jour terminée. Tous les réglages vidéo et audio sont rétablis 
aux valeurs par défaut après la mise à jour.

Mettre à jour
MENU > Support technique > Mise à jour du logiciel > Mettre à jour Ess. maint.

Mettre à jour vous permet d'effectuer une mise à jour du logiciel de votre téléviseur de trois façons différentes :

●● En ligne, en téléchargeant la mise à jour à partir de Internet directement dans le téléviseur.

●● Manuellement, à l'aide d'une clé USB.

●● Automatiquement (Mettre à jour automatiquement), pendant que le téléviseur est en mode de veille.

L'explication de chacune des méthodes est donnée ci-dessous.

En ligne
Suivez les étapes ci-après pour mettre à jour le téléviseur en utilisant la méthode En ligne :
1.	 Assurez-vous que le téléviseur est connecté au réseau et à Internet. La connexion peut être établie à l'aide 

d'un câble ou être sans fil.

2.	 Tous les réglages vidéo et audio sont rétablis aux valeurs par défaut après la mise à jour. Nous vous 
recommandons d'enregistrer vos réglages actuels maintenant afin de rétablir facilement vos réglages une 
fois la mise à jour complétée.

3.	 Appuyez sur la touche MENU, puis sélectionnez Support technique > Mise à jour du logiciel > Mettre à jour. 
La fenêtre contextuelle Mettre à jour maintenant s'affiche.

4.	 Le téléviseur recherche en ligne la dernière version du logiciel pour votre téléviseur.

5.	 S'il n'en trouve pas, le message « Aucune nouvelle mise à jour » s'affiche. Appuyez sur la touche EXIT pour 
sortir.

6.	 Si le téléviseur trouve une nouvelle version, la fenêtre d'autorisation de mise à jour s'affiche.

7.	 Sélectionnez OK. Le téléviseur effectue la mise à jour du logiciel et, ensuite, se met hors tension puis sous 
tension automatiquement.

"" N'éteignez pas le téléviseur durant la mise à jour logicielle. Ceci pourrait causer une défaillance du téléviseur.
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Manuellement, à l'aide d'une clé USB.
Suivez les étapes ci-après pour mettre à jour le téléviseur en utilisant la méthode Manuelle :
1.	 Tous les réglages vidéo et audio sont rétablis aux valeurs par défaut après la mise à jour. Nous vous 

recommandons d'enregistrer vos réglages actuels afin de rétablir facilement vos réglages une fois la mise à 
jour complétée.

2.	 À partir d'un ordinateur, allez à l'adresse www.samsung.com.

3.	 Sélectionnez ASSISTANCE > Téléchargements.

4.	 Saisissez le numéro de modèle de votre produit dans le champ de recherche. À mesure que vous saisissez le 
numéro de modèle, une liste déroulante s'affichera énumérant les produits qui correspondent au numéro de 
modèle.

5.	 Cliquez sur le numéro de modèle de votre téléviseur dans la liste déroulante.

6.	 Sur la page qui s'affiche, défilez vers le bas et cliquez sur Téléchargements.

7.	 Cliquez sur Microgiciel, au centre de la page.

8.	 Cliquez sur la touche ZIP dans la colonne Fichier.

9.	 Cliquez sur Envoyer dans le premier menu contextuel qui s'affiche.

10.	 Cliquez sur Enregistrer dans le deuxième menu contextuel afin d'effectuer le téléchargement, et enregistrez 
ensuite le microgiciel sur votre ordinateur.

11.	 Décompressez le fichier d'archive dans votre ordinateur. Vous devriez avoir un seul dossier portant le même 
nom que celui du dossier compressé.

12.	 Copiez-le sur une clé USB.

13.	 Insérez la clé USB dans le port USB du téléviseur.

14.	 Dans le menu du téléviseur, allez à Soutien > Mise à jour du logiciel > Mettre à jour maintenant. Le téléviseur 
recherche le logiciel sur la clé USB. La fenêtre contextuelle d'autorisation de mise à jour s'affiche lorsque le 
logiciel est trouvé.

15.	 Appuyez sur OK. Le téléviseur effectue la mise à jour du logiciel et, ensuite, se met hors tension puis sous 
tension automatiquement.

"" N'éteignez pas le téléviseur durant la mise à jour logicielle. Ceci pourrait causer une défaillance du téléviseur.
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Activation de la mise à jour automatique du logiciel
MENU > Support technique > Mise à jour du logiciel > Mise à jour auto Ess. maint.

Si le téléviseur est connecté à Internet, vous pouvez mettre les logiciels à jour pendant que vous regardez une 
émission grâce à la fonction Mise à jour auto. Si une mise à jour est téléchargée en arrière-plan, elle sera appliquée 
la prochaine fois que vous utiliserez le téléviseur.

"" Cette option exige une connexion Internet.

Si vous acceptez les modalités de Smart Hub, la mise à jour automatique sera activée automatiquement. Si vous 
désirez que le logiciel du téléviseur soit mis à jour automatiquement, réglez Mise à jour auto (Support technique > 
Mise à jour du logiciel > Mise à jour auto) à Désactiver.

Protection du téléviseur contre les intrusions informatiques et 
les programmes malveillants
MENU > Système > Sécurité intell.

Lorsque le téléviseur est connecté à Internet, il est vulnérable aux attaques de piratage et de codes malveillants. 
Sécurité intell. protège le téléviseur et le support de données branché à l'ordinateur contre de telles menaces.

Allez à Système > Sécurité intell., puis réglez Sécurité intell. à Activer.

Vérification du téléviseur et du support de données branché
MENU > Système > Sécurité intell. > Recher.

Allez à Système > Sécurité intell., puis sélectionnez Recher.. Cette option analyse le téléviseur et le support de 
données branché à la recherche de code malveillant. Si aucun code malveillant n'est détecté, une notification à cet 
effet s'affiche à l'écran.
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Si un programme malveillant a été détecté...

Si un programme malveillant est découvert, le résultat de l'analyse apparaît à l'écran. La fenêtre des résultats 
affiche le programme malveillant et offre l'option de mettre le programme en quarantaine ou de lui permettre de 
fonctionner.
1.	 Sélectionnez le programme malveillant que vous voulez mettre en quarantaine ou laisser fonctionner.

2.	 Sélectionnez Bloquer ou Permet.. Cette action déplace le logiciel malveillant sélectionné vers la Liste 
d’éléments isolés ou la Liste permis.

"" La Liste d’éléments isolés affiche tous les programmes mis en quarantaine ou bloqués. Vous pouvez également 
déplacer un logiciel malveillant à partir de cette liste vers la liste autorisée.

"" La Liste permis affiche tous les programmes malveillants autorisés. Vous pouvez également déplacer les 
programmes de cette liste à la liste des éléments isolés.

Balayage automatique du téléviseur à la mise sous tension
MENU > Système > Sécurité intell. > Paramètres > Analyse auto.

Allez à Système > Sécurité intell. > Paramètres, puis réglez Analyse auto.à Activer. Cette action permet de 
parcourir automatiquement le téléviseur et les supports de données connectés lorsque le téléviseur est sous 
tension.

Ajouter le code malveillant automatiquement à la liste bloquée
MENU > Système > Sécurité intell. > Paramètres > Ajouter automatiquement à la liste d’éléments isolés

Allez à Système > Sécurité intell. > Paramètres, puis réglez Ajouter automatiquement à la liste d’éléments isolés à 
Activer. Les codes de sources malveillantes détectés pendant l'analyse sont automatiquement ajoutés à la liste des 
émissions bloquées.
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Utilisation des autres fonctions

Ajouter un mot de passe
MENU > Système > Changer NIP Ess. maint.

Permet d'ajouter un NIP (numéro d'identification personnel) pour verrouiller des chaînes, réinitialiser le téléviseur 
et modifier les réglages du téléviseur.
1.	 Sélectionnez Système > Changer NIP. La fenêtre de saisie du NIP s'affiche.

2.	 Saisissez votre NIP. Le NIP par défaut est 0000.

3.	 Saisissez un nouveau NIP, puis saisissez-le à nouveau pour le confirmer. Le changement de NIP est effectué.

"" Si vous oubliez votre NIP, vous pouvez le réinitialiser à l'aide de la télécommande. Pendant que le téléviseur est sous 
tension, appuyez sur les touches suivantes sur la télécommande pour rétablir le code à 0000 : MUTE → w → RETURN → 
v → RETURN → w → RETURN. « + » est le bouton permettant d'augmenter le volume. « - » est le bouton permettant 
de diminuer le volume.

Changer la langue des menus
MENU > Système > Langue menu Ess. maint.

Cette option vous permet de définir la langue du menu. Sélectionnez Système > Langue menu, puis choisissez une 
langue dans la liste.

Vérifier les notifications
MENU > Système > Avis

Sélectionnez Avis dans le menu Système pour consulter la liste des messages générés par le téléviseur. Le 
message Avis apparaît à l'écran lorsque des événements comme la sortie d'une mise à jour pour une application ou 
l'ouverture ou la fermeture d'une session dans le compte Samsung se produisent.

"" Sélectionnez Supprimer tout pour supprimer toutes les notifications.

"" Sélectionnez Notification pour consulter les notifications de service du téléviseur intelligent (SMART TV) dans un 
navigateur Web.

Ajustement de la transparence des menus
MENU > Système > Accessibilité > Transparence menu Ess. maint.

Allez à Système > Accessibilité et ajustez le niveau d'opacité et la transparence du menu.
"" Lorsque le réglage Contraste élevé (Système > Accessibilité > Contraste élevé) est à Activer, l'affichage du menu est 

automatiquement réglé à opaque et vous ne pouvez plus changer le réglage du Transparence menu.
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Texte blanc sur un arrière-plan noir (Contraste élevé)
MENU > Système > Accessibilité > Contraste élevé

Allez à Système > Accessibilité, puis réglez Contraste élevé à Activer. Cette option permet de transformer les 
principaux écrans de service en texte blanc sur fond noir, ou rend opaque les menus transparents du téléviseur 
pour rendre la lecture du texte plus facile.

Agrandissement de la zone de l'objectif Smart Hub
MENU > Système > Accessibilité > Enlarge Ess. maint.

Allez à Système > Accessibilité, puis réglez Enlarge à Activer. Ce dispositif permet de zoomer sur l'élément choisi 
lorsque vous utilisez Smart Hub et il agrandit l'élément.

Verrouillage/déverrouillage des touches du panneau
MENU > Système > Général > Verrouill. panneau Ess. maint.

Utilisez pour verrouiller et déverrouiller les boutons du panneau avant du téléviseur (menu, chaîne, volume) et le 
manche de commande à l'arrière du téléviseur. Sélectionnez Système > Général > Verrouill. panneau et verrouillez 
ou déverrouillez les touches.

Afficher/masquer le logo Samsung au démarrage
MENU > Système > Général > Logo au démarr. Ess. maint.

Permet d'activer ou de désactiver l'affichage du logo Samsung qui apparaît au démarrage du téléviseur.

Activation du mode Jeu
MENU > Système > Général > Mode Jeu Ess. maint.

Le mode Jeu optimise les paramètres du téléviseur pour vous permettre de jouer à des jeux vidéo sur une console 
de jeu telle que PlayStation™ ou Xbox™. 

"" Le mode Jeu ne peut être utilisé pour regarder la télévision.

"" Branchez la console de jeu avant d'activer le mode Jeu. Autrement, la qualité de l'image peut être altérée.

"" L'écran peut trembler un peu.

"" L'activation du mode Jeu règle automatiquement Image Mode à Standard et Son Mode à Cinéma.

"" Pour utiliser un autre appareil externe, vous devez d'abord débrancher la console de jeu et désactiver le mode Jeu.
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Profiter de couleurs riches et d'une qualité d'image supérieure (BD Wise)
MENU > Système > Général > BD Wise

Cette fonction est disponible seulement pour les modèles de téléviseurs à DEL de la série 6100, 6200.

Le branchement d'un lecteur de DVD Samsung, d'un lecteur Blu-ray ou d'un système de cinéma maison prenant en 
charge le mode BD Wise permet des couleurs les plus riches et une meilleure qualité d'image. L'activation du mode 
BD Wise optimise automatiquement la résolution du téléviseur.

"" Cette fonction est disponible seulement si l'appareil externe est branché au moyen d'un câble HDMI.

Enregistrement du téléviseur comme appareil certifié DivX (pour voir les 
films DivX payants).
MENU > Système > Vidéo sur demande DivX® Ess. maint.

Pour regarder sur votre téléviseur des films en format DivX protégés par une gestion des droits numériques, vous 
devez enregistrer votre téléviseur en tant qu'appareil certifié DivX.

"" La gestion des droits numériques est un mécanisme de sécurité numérique qui vise à protéger les droits d'auteur du 
fournisseur de contenu.

"" Vous pouvez regarder des films que vous possédez ou des films DivX gratuits sans avoir à vous inscrire.

"" Visitez le site Web DivX (http://www.divx.com) et ouvrez une session dans votre compte utilisateur avant d'enregistrer le 
téléviseur comme appareil DivX-certified. Si vous n'avez pas de compte, veuillez en créer un.

1.	 Sélectionnez Système > Vidéo sur demande DivX®. Une fenêtre contenant un code d'enregistrement 
s'affiche à l'écran.

2.	 Consultez le site Web DivX sur un ordinateur, puis cliquez sur [enregistrer votre produit], sous [soutien] dans 
le menu supérieur.

3.	 Saisissez le code d'enregistrement affiché à l'écran du téléviseur dans le champ [Entrez votre code 
d'enregistrement].

4.	 Entrez le nom du téléviseur dans le champ [nom de votre appareil], puis cliquez sur [SUIVANT].

5.	 Cliquez sur [TÉLÉCHARGER], puis sauvegardez le fichier [nom_du_dispositif.divx].

6.	 Transférez le fichier [device_name.divx] de l'ordinateur vers une clé USB, et branchez ensuite la clé USB dans 
le téléviseur.

7.	 Exécutez le fichier [nom_du_dispositif.divx] sur le téléviseur pour enregistrer ce dernier en tant qu'appareil 
certifié DivX.
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Rétablissement des réglages du téléviseur aux réglages définis par défaut
MENU > Support technique > Autodiagnostic > Régler Ess. maint.

Cette option permet de restaurer tous les réglages du téléviseur (sauf les réglages relatifs à l'Internet et au réseau) 
aux valeurs par défaut du fabricant.
1.	 Sélectionnez Support technique > Autodiagnostic > Régler. La fenêtre de saisie du NIP de sécurité apparaît à 

l'écran.

2.	 Entrez le NIP de sécurité et sélectionnez Oui. Tous les réglages sont réinitialisés. Le téléviseur s’éteint et se 
rallume automatiquement, puis il affiche l'écran Configuration.

"" Pour en savoir davantage sur la réinitialisation du téléviseur, consultez le guide de l'utilisateur fourni avec l'appareil.

Utiliser le téléviseur comme modèle de démonstration (seulement pour les 
magasins de détail).
MENU > Support technique > Mode utilisation Ess. maint.

Sélectionnez Support technique > Mode utilisation > Démo magasin. Permet de transformer le téléviseur en 
modèle de démonstration dans un environnement de vente au détail.

"" Sélectionnez Util. à domicile pour tout autre utilisation.

"" Démo magasin ne doit être utilisée que dans un environnement de vente au détail. Si vous utilisez Démo magasin, 
certaines fonctions seront désactivées et le téléviseur se réinitialisera automatiquement après un certain temps.
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Obtenir du soutien technique
Le téléviseur est doté de plusieurs systèmes intégrés pour faciliter le soutien technique du téléviseur.

Soutien technique par l'entremise de la fonction Gestion à distance
MENU > Support technique > Gestion à distance Ess. maint.

Si vous avez besoin d'aide, cette fonction vous permet de demander à Samsung Electronics de diagnostiquer 
votre téléviseur à distance. Il faut d'abord lire et accepter l'entente de service avant d'utiliser cette fonction. Un 
technicien de Samsung Electronics procédera à distance au diagnostic, à la réparation et à la mise à jour de votre 
téléviseur. Ces options ne sont disponibles que si votre téléviseur est connecté à Internet.

Obtenir du soutien à distance

Samsung vous offre un service de soutien technique à distance et personnalisé. Un technicien de Samsung pourra 
à distance : 

●● diagnostiquer votre téléviseur;

●● ajuster les réglages du téléviseur;

●● Réinitialisez votre téléviseur en lui redonnant tous ses paramètres par défaut.

●● installer les dernières versions du micrologiciel recommandées.

Comment cela fonctionne-t-il?

Grâce au service de soutien technique à distance de Samsung, vous pouvez effectuer les mesures de dépannage en 
toute facilité.

Il vous suffit d'appeler un centre d'appels 
Samsung et de demander un soutien 
technique à distance.

Ouvrez le menu de votre téléviseur et 
accédez à la section Support tech..

Sélectionnez Gestion à distance, puis 
acceptez les ententes sur le service après en 
avoir pris connaissance. Lorsque l'écran du 
NIP s'affiche, communiquez le NIP à l'agent.

Ce dernier accède à votre téléviseur.

Dépannage
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Trouver l'information sur le service pour lequel vous désirez de l'aide
MENU > Support technique > Contacter Samsung Ess. maint.

Cette option vous permet d'afficher l'adresse du site Web de Samsung, le numéro de téléphone du centre d'appels, 
le numéro de modèle de votre téléviseur, la version du logiciel de votre téléviseur, les renseignements sur Smart 
Hub, et d'autres renseignements dont vous pourriez avoir besoin pour obtenir du soutien technique d'un agent du 
service de soutien technique Samsung, ou sur le site Web de Samsung.

Demande de soutien
MENU > Support technique > Request Support

Si vous éprouvez des problèmes pendant que vous utilisez votre téléviseur Smart TV, vous pouvez faire appel au 
service de soutien.

"" Vous pouvez y accéder par Internet. Après avoir vérifié le statut de connexion du réseau, demandez l'aide du service de 
soutien.

1.	 Allez à Support technique > Request Support. Une fenêtre contextuelle s'affiche.

2.	 Sélectionnez Agree. Un écran « Demande de soutien » s'affiche.

"" Il est disponible uniquement lorsque vous acceptez les conditions.

3.	 Entrez vos nom et numéro de téléphone.

4.	 Après avoir sélectionné la catégorie de problèmes, sélectionnez Envoyer.

"" Vous pouvez sélectionner jusqu'à 3 catégories.

"" En cas d'erreur, refaites une demande après avoir avoir confirmé vos nom et numéro de téléphone ainsi que le 
problème. Si vous laissez un champ vide ou n'entrez pas des bons renseignements, la demande de soutien peut 
échouer.
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Problème concernant l'image

Tester l'image
MENU > Support technique > Autodiagnostic > Essai d'image Ess. maint.

Avant d'essayer de corriger le problème en consultant la liste de problèmes et de solutions ci-dessous, utilisez 
l'option Essai d'image pour savoir si le problème provient du téléviseur. L'essai d'image affiche une image haute 
définition permettant de détecter les imperfections. Si l'image d'essai ne s'affiche pas ou si celle-ci présente du 
bruit ou une distorsion, il se peut que le téléviseur soit défectueux. Communiquez avec le centre d'appels de 
Samsung pour obtenir de l'aide. Si l’image d’essai s’affiche correctement, il est possible qu'un appareil externe soit 
défectueux. Vérifiez les branchements. Si le problème persiste, vérifiez la puissance du signal ou consultez le guide 
d’utilisation de l’appareil externe.

Le problème Conseil

Scintillement et 
diminution de la 
luminosité

En cas de scintillement ou de diminution de la luminosité de manière sporadique de votre 
téléviseur Samsung, vous devrez peut-être désactiver certaines fonctions d’économie 
d’énergie. Désactivez Écon. Énergie (Système > Solution Eco > Écon. Énergie) ou Capteur 
Eco (Système > Solution Eco > Capteur Eco).

Branchement de 
composants/Couleur de 
l’écran

Si vous constatez que la couleur de l’écran de votre téléviseur Samsung n’est pas bonne 
ou que le noir et le blanc ne sont pas précis, exécutez Essai d'image (Support technique > 
Autodiagnostic > Essai d'image).
Si les résultats du test indiquent que le problème n'est pas causé par le téléviseur, suivez les 
étapes suivantes :

●● Assurez-vous que les connecteurs d'entrée du téléviseur sont branchés aux connecteurs 
de sortie adéquats sur l'appareil externe.

●● Vérifiez également les autres branchements. Si le téléviseur est branché à un appareil 
externe au moyen d’un câble composante, vérifiez que les prises Pb, Pr et Y sont 
branchées aux connecteurs correspondants.

Luminosité de l’écran

Si les couleurs du téléviseur Samsung sont bonnes, mais légèrement sombres ou brillantes, 
réglez d’abord les paramètres ci-après.

●● Allez au menu Image et ajustez les réglages Contre-jour/Lumière cellule (disponibles sur 
plusieurs modèles) Contraste, Luminosité, Netteté, Couleur etTeinte (V/R).

Images rémanentes, 
floues, effet de saccades

Si vous constatez l'apparition d'images rémanentes ou floues, utilisez l'option Auto Motion 
Plus (Image > Options d'image > Auto Motion Plus) pour résoudre ce problème.

"" Pour les modèles à DEL de série 5300, 5200, 5100, 4300 et 4200, vous pouvez résoudre 
cette question en utilisant l'option DEL mouvement clair (Image > Options d'image > DEL 
mouvement clair).

Mise hors tension 
inopportune

Si votre téléviseur Samsung semble se mettre hors tension par lui-même, essayez de 
désactiver certaines fonctions d'économie d'énergie automatiques. Vérifiez si la fonction 
Mise en veille (Système > Heure > Mise en veille) a été activée. L'option Mise en veille met 
automatiquement le téléviseur hors tension après une période de temps précise. Si la mise 
en veille n’a pas été activée, vérifiez si l'option Veille abs. sign. (Système > Solution Eco > 
Veille abs. sign.) ou Arrêt autom. (Système > Solution Eco > Arrêt autom.) a été activée et 
désactivez-la.
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Le problème Conseil

Problèmes de mise sous 
tension

À la mise sous tension du téléviseur, le récepteur de la télécommande clignote cinq fois 
avant que l’écran ne s’allume.
Si vous avez des difficultés à mettre votre téléviseur Samsung sous tension, procédez 
à certaines vérifications avant d’appeler le service de dépannage. Assurez-vous que le 
cordon d'alimentation du téléviseur est branché correctement aux deux extrémités et 
que la télécommande fonctionne normalement. Assurez-vous que le câble de l'antenne 
ou du service de câblodistribution est bien branché. Si vous avez un câblosélecteur ou un 
récepteur satellite, assurez-vous qu'il soit branché et mis sous tension.

Impossible de trouver une 
chaîne

Si votre téléviseur est branché à un câblosélecteur ou un récepteur satellite, exécutez 
Configuration (Système > Configuration) ou Prog. auto (Diffusion > Prog. auto).

L’image du téléviseur 
n’est pas aussi belle qu’en 
magasin.

Les affichages en magasin sont tous réglés en fonction de chaînes numériques haute 
définition (HD).
Si vous avez un câblosélecteur ou un boîtier décodeur analogique, procurez-vous un 
récepteur numérique. Utilisez des câbles HDMI ou composantes pour obtenir une image de 
qualité HD (haute définition).
De nombreuses chaînes HD sont soumises à une interpolation à partir du contenu SD 
(définition standard). Cherchez une chaîne diffusant du contenu HD pur.

●● Abonnés au câble ou au satellite : essayez des chaînes HD figurant dans la liste des 
chaînes.

●● Connexion antenne Air ou Câble : essayez les chaînes HD après l’exécution de fonction 
de programmation automatique.

Réglez la résolution de la sortie vidéo du câblosélecteur ou du récepteur satellite à 1080i ou 
720p.

L’image est déformée.

La compression du contenu vidéo peut causer une déformation de l’image, surtout lorsque 
les mouvements sont rapides, comme dans les émissions de sport et les films d’action.
Un signal faible ou médiocre peut causer une déformation de l’image. Il ne s’agit pas d’un 
problème du téléviseur.
L'utilisation de téléphones cellulaires à proximité du téléviseur (jusqu'à une distance de 97 
cm (3,3 pi) peut causer des parasites à l'affichage de chaînes analogiques ou numériques.

Les couleurs sont 
faussées ou absentes.

Si vous avez une connexion avec des câbles composantes, assurez-vous que ces derniers 
sont branchés aux prises correspondantes. Des connexions incorrectes ou lâches peuvent 
causer des problèmes de couleur ou une absence d’image.

La couleur est médiocre 
ou l’image manque de 
luminosité.

Allez au menu Image et ajustez les réglages Image Mode, Luminosité, Netteté et Couleur.
Vérifiez si la fonction Écon. Énergie (Système > Solution Eco > Écon. Énergie) a été activée.
Essayez de réinitialiser l’image. (Image > Réinitialisation de l’image)

Ligne pointillée sur le 
bord de l’écran.

Si l'option Image Format a été réglée à Plein écran, changez le réglage à 16:9.
Modifiez la résolution du câblosélecteur ou du récepteur satellite.

L’image est en noir et 
blanc.

Si vous utilisez une entrée AV composite, branchez le câble vidéo (jaune) à la prise 
composante verte du téléviseur.
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Le son n'est pas clair

Tester le son
MENU > Support technique > Autodiagnostic > Essai de son Ess. maint.

Avant de consulter la liste de problèmes et de solutions ci-dessous, assurez-vous que l'élément de menu Sortie 
du son du téléviseur est réglé à Haut-parleur TV, et ensuite faites un essai de son avec les haut-parleurs. S'il n'y a 
toujours pas de son, exécutez la fonction Essai de son. La fonction Essai de son utilise une mélodie intégrée pour 
vérifier les problèmes de son. S'il n'y a pas son ou qu'il est distordu, il se peut que le téléviseur soit défectueux. 
Communiquez avec le centre d'appels de Samsung pour obtenir de l'aide. Si la mélodie est jouée par le téléviseur 
pendant l'essai de son, il est possible qu'un appareil externe soit défectueux. Vérifiez les branchements. Si le 
problème persiste, consultez le guide d’utilisation de l’appareil externe.

Le problème Conseil

Il n’y a pas de son ou le 
son est trop bas alors que 
le volume est réglé au 
maximum.

Vérifiez le contrôle du volume de l’appareil (câblosélecteur, récepteur satellite, lecteur 
DVD, lecteur Blu-ray, etc.) branché à votre téléviseur.

L’image est bonne, mais il n’y 
a pas de son.

Réglez la fonction Son > Paramètres haut-parleur > Sortie du son du téléviseur à Haut-
parleur TV.
Si vous utilisez un appareil externe, vérifiez l’option de sortie audio de cet appareil. (Par 
exemple, vous pourriez avoir à changer l’option audio de votre câblosélecteur à HDMI si 
votre récepteur est branché au téléviseur à l’aide d’un câble HDMI.)
Pour entendre le son provenant de l'ordinateur, branchez les haut-parleurs externes au 
connecteur de sortie audio de l'ordinateur.
Si votre téléviseur est doté d’une prise pour casque d’écoute, vérifiez qu’aucun appareil 
n’y est branché.
Réinitialisez l’appareil branché en débranchant et en rebranchant son cordon 
d’alimentation.

Les haut-parleurs émettent 
un son étrange.

Assurez-vous que le câble audio est branché correctement au connecteur de la sortie 
audio de l’appareil externe.
Si le téléviseur est branché à une antenne ou à un câblosélecteur, vérifiez les données 
sur le signal. Un signal faible peut causer une distorsion sonore.
Exécutez Essai de son (Support technique > Autodiagnostic > Essai de son).
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Les images 3D ne sont pas claires

Effectuer un essai de la qualité des images 3D
MENU > Support technique > Autodiagnostic > Test de l’image 3D

"" Pour effectuer un essai de la qualité des images 3D, vous devez porter des lunettes 3D appariées au téléviseur.

La fonction 3D n'est pas offerte aux États-Unis ou au Canada, et est seulement offerte sur les téléviseurs à DEL de 
série 6200 ou d'une série supérieure.

Avant de consulter la liste de problèmes et de solutions ci-dessous, effectuez un essai d'image 3D pour déterminer 
si le problème vient du téléviseur. L'essai d'image 3D affiche une image haute définition et vous permet de voir 
si cette image est imparfaite ou défectueuse. Si l'image d'essai ne s'affiche pas ou si celle-ci présente du bruit ou 
une distorsion, il se peut que le téléviseur soit défectueux. Communiquez avec le centre d'appels de Samsung pour 
obtenir de l'aide. Si l’image d’essai s’affiche correctement, il est possible qu'un appareil externe soit défectueux. 
Vérifiez les branchements. Si le problème persiste, vérifiez la puissance du signal ou consultez le guide d’utilisation 
de l’appareil externe.

Le problème Conseil

Les lunettes 3D ne 
fonctionnent pas 
correctement.

Assurez-vous que les lunettes sont sous tension.
La fonction 3D peut ne pas fonctionner correctement si un autre produit ou appareil 
électronique 3D est sous tension à proximité.
En cas de problème, éloignez le plus possible les autres appareils électroniques des 
lunettes 3D Active.

Les images 3D ne sont pas 
claires

La distance de visionnement idéale est d’au moins trois fois la hauteur de l’écran.
Nous vous recommandons de vous regarder le contenu 3D de sorte que vos yeux soient 
au même niveau que l’écran.

Les piles des lunettes 3D 
sont à plats.

Mettez les lunettes 3D hors tension lorsque vous ne les utilisez pas. Si vous les laissez sous 
tension, la durée de vie des piles sera réduite.
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Problème concernant la diffusion
Le problème Conseil

Le téléviseur ne reçoit pas 
toutes les chaînes.

Si votre téléviseur n'est pas branché à un câblosélecteur ou un récepteur satellite :
●● assurez-vous que le câble coaxial est bien branché au téléviseur. 
●● Si vous utilisez une antenne, assurez-vous qu'elle est bien positionnée et bien 

branchée.
●● Exécutez Configuration (Système > Configuration) ou Prog. auto (Diffusion > Prog. 

auto).

Pas de sous-titres pour les 
chaînes numériques.

Allez à Sous-titres (Système > Accessibilité > Sous-titres), puis modifiez le réglage du 
Mode ss-titres codés.
Il est possible que certaines chaînes n’aient pas de sous-titres.

L’image est déformée.

La compression du contenu vidéo peut causer une déformation de l’image, surtout 
lorsque les mouvements sont rapides, comme dans les sports et les films d’action.
Un signal faible peut causer une déformation de l’image. Il ne s’agit pas d’un problème du 
téléviseur.

Je n'arrive pas à connecter mon ordinateur.
Le problème Conseil

Le message « Mode non 
disponible » s’affiche.

Réglez la résolution de sortie de votre ordinateur pour qu’elle corresponde à une 
résolution prise en charge par le téléviseur.

La vidéo est bonne, mais il 
n’y a pas de son.

Si vous avez branché l’ordinateur à l’aide d’un câble HDMI, vérifiez le réglage de sortie 
audio de votre ordinateur.
Si vous utilisez un câble DVI à HDMI, un câble audio distinct est nécessaire.

Impossible de se connecter à Internet.
Le problème Conseil

Perte de connexion au 
réseau sans fil.

Vérifiez que votre modem/routeur est bien allumé et branché à Internet. 
Réinitialisez votre modem/routeur en le fermant, puis en le rallumant après 15 secondes.
Exécutez configuration du réseau (MENU > Réseau > Paramètres réseau).

Échec de la mise à jour du 
logiciel par Internet.

Vérifiez la connexion réseau (MENU > Réseau > État du réseau).
Connectez le téléviseur au réseau, le cas échéant.
Si vous avez la version la plus récente du logiciel, aucune mise à niveau ne sera effectuée.
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J'ai de la difficulté à lancer ou utiliser des applications.
Le problème Conseil

J'ai lancé une 
application, mais elle 
est en anglais. Comment 
puis-je changer de 
langue?

Les langues prises en charge par une application peuvent être différentes de la langue 
de l’interface utilisateur. La disponibilité du contenu dans plusieurs langues dépend du 
fournisseur de service.

L'application ne 
fonctionne pas.

Communiquez avec le fournisseur de service.
Reportez-vous à la section d'aide du site Web du fournisseur de services liés à l'application.

Impossible de lire mon fichier.
Le problème Conseil

Impossible de lire 
certains fichiers.

Ce problème peut survenir en cas de fichiers à haut débit. Bien que la lecture de la plupart 
des fichiers soit possible, les fichiers à un haut débit risquent de poser problème.

Je veux réinitialiser le téléviseur.
Régler Chemin Description

Réinitialiser les 
réglages

MENU > Support technique 
> Autodiagnostic > Régler

Réinitialiser aux valeurs par défaut les paramètres Image, Son, 
Chaîne, Smart Hub et tous les autres paramètres, à l'exception 
des paramètres réseau.

Réinitialiser Smart 
Hub

MENU > Smart Hub > 
Réinitialisation de Smart 
Hub

Permet de rétablir tous les paramètres par défaut de Smart 
Hub et de supprimer toute information associée aux comptes 
Samsung et aux comptes de service associés, ainsi que les 
applications et les ententes de service Smart Hub. 
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Autres problèmes
Le problème Conseil

Le téléviseur est chaud.

Le panneau peut dégager de la chaleur si le téléviseur est utilisé pendant une période 
prolongée. La chaleur se dissipe par les orifices de ventilation aménagés dans le haut du 
téléviseur. Le bas peut aussi devenir chaud au toucher après une utilisation prolongée. 
Les parents doivent surveiller les enfants qui regardent la télévision pour les empêcher de 
toucher l’appareil. Cette chaleur ne découle toutefois par d'un défaut et elle n'affecte en 
rien le fonctionnement du téléviseur.

L’image ne s’affiche pas en 
mode plein écran.

Des barres noires apparaissent de chaque côté de l’image des chaînes HD durant 
l’affichage d’un contenu SD (4:3) soumis à une interpolation.
Des barres noires au haut et au bas de l’image apparaissent dans les films dont le rapport 
hauteur/largeur est différent de celui du téléviseur.
Réglez l’option de format de l’image de votre appareil externe ou du téléviseur à plein 
écran.

Le message « Mode non 
disponible » s’affiche.

La résolution de sortie de l'appareil branché n'est pas prise en charge par le téléviseur. 
Vérifiez la résolution prise en charge par le téléviseur et réglez la résolution de sortie de 
l’appareil externe en conséquence.

L’option Sous-titres dans le 
menu du téléviseur est en 
gris.

Vous ne pouvez pas sélectionner le menu Sous-titres si vous avez sélectionné une source 
branchée au téléviseur au moyen d’un câble HDMI ou composante. Pour afficher les sous-
titres, activez la fonction de sous-titres de l'appareil externe.

Le téléviseur dégage une 
odeur de plastique.

Cette odeur est normale et s’atténuera avec le temps.

L'option Info. sur signal 
sous Autodiagnostic n'est 
pas activée.

Vérifiez si la chaîne active est numérique.
L'option Info. sur signal est disponible seulement pour les chaînes numériques. 

Le téléviseur est incliné 
d’un côté.

Retirez la base du téléviseur et assemblez-la de nouveau.

L'option Diffusion a été 
désactivée.

L'option Diffusion n'est disponible que lorsque la Source est réglée sur TV.
Vous ne pouvez pas accéder au menu Diffusion si vous regardez la télévision par 
l’intermédiaire d’un câblosélecteur ou d’un récepteur satellite.
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Le problème Conseil

Les réglages sont perdus 
après 5 minutes ou chaque 
fois que le téléviseur est 
éteint.

Si Mode utilisation est réglé à Démo magasin, les réglages audio et vidéo du téléviseur 
sont réinitialisés toutes les 5 minutes.
Passez de Mode utilisation (Support technique > Mode utilisation) à Util. à domicile.

Perte intermittente du son 
ou de l’image.

Vérifiez les branchements des câbles et refaites-les.
La perte du son ou de l’image peut être causée par l’utilisation de câbles trop rigides ou 
trop épais.
Assurez-vous que les câbles sont suffisamment souples pour une utilisation à long 
terme. Pour la fixation murale, nous recommandons l’utilisation de câbles pourvus de 
connecteurs à 90 degrés.

De petites particules sur le 
cadre du téléviseur.

Cela fait partie de la conception du produit et ne constitue pas un défaut.

Le menu ISI n’est pas 
disponible.

La fonction ISI est disponible uniquement lorsque vous visionnez une vidéo provenant 
d'une source HDMI ou d'une composante, sur l'écran principal.

Une bannière publicitaire 
interne du téléviseur (POP) 
apparaît à l’écran.

Passez de Mode utilisation (Support technique > Mode utilisation) à Util. à domicile.

Le téléviseur émet un bruit 
de craquement.

L'expansion et la contraction du téléviseur peuvent engendrer des craquements. Il 
ne s’agit pas d’une défaillance du produit. Vous pouvez utiliser le téléviseur en toute 
sécurité.

Le téléviseur émet un 
bourdonnement.

Votre téléviseur utilise des circuits de commutation à grande vitesse et des courants 
électriques de forte intensité. Il peut sembler plus bruyant qu’un téléviseur conventionnel 
compte tenu du niveau de luminosité sélectionné.
Votre téléviseur a fait l’objet de procédures strictes de contrôle de qualité qui répondent 
à nos strictes exigences en matière de rendement et de fiabilité.
Un simple bruit provenant du téléviseur est tout à fait normal et ne constitue donc pas 
une raison valable pour un échange ou un remboursement.
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À lire avant d'utiliser le mode de visionnement 3D
La fonction 3D n'est pas offerte aux États-Unis ou au Canada, et est seulement offerte sur les téléviseurs à DEL de 
série 6200 ou d'une série supérieure.

Précautions à suivre pour visionner du contenu 3D

[[ Avertissement

●● Si vous regardez une vidéo en 3D sous une lampe fluorescente (50 Hz – 60 Hz) ou une lampe à trois 
longueurs d'ondes, il est possible que vous remarquiez un léger scintillement à l'écran.

"" Si c'est le cas, réduisez l'intensité de la lampe ou éteignez-la.

●● Le fait de changer de mode d'entrée pendant le visionnement d'un film en 3D peut désactiver la fonction 3D 
du téléviseur.

"" Par conséquent, il se peut que les lunettes 3D ne fonctionnent pas et que l'affichage à l'écran ne soit pas normal.

●● Assurez-vous de respecter la distance de fonctionnement lorsque vous regardez une vidéo en 3D.

"" Il est possible que vous ne puissiez pas voir les images en 3D si vous vous dépassez la distance de travail du téléviseur 
pendant trois secondes.

"" Si les lunettes 3D sont à une trop grande distance par rapport au téléviseur, le signal émis par ce dernier n'est 
plus capté et l'affichage 3D s'arrête au bout de quelques secondes. Lorsque cela se produit, la DEL rouge s'allume 
pendant trois secondes.

●● Si vous êtes en position allongée sur le côté lorsque vous utilisez les lunettes 3D Active, il se peut que 
vous ne voyiez pas d'image ou qu'elle soit sombre. La perception des effets 3D peut varier en fonction 
du téléspectateur. L'effet 3D peut ne pas être perceptible si les capacités de votre œil gauche sont très 
différentes de celles de votre œil droit.

●● Si les lunettes 3D ou les lentilles sont endommagées, entièrement ou partiellement, elles ne peuvent pas être 
réparées; les lunettes doivent être remplacées. Si les lunettes ne fonctionnent pendant la période de validité 
de la garantie, elles peuvent être réparées ou remplacées gratuitement. Si les lunettes ont été endommagées 
après l'expiration de la période de garantie ou en raison d'une faute de l'utilisateur, ce dernier doit acheter 
des lunettes neuves.

●● Les lunettes 3D pourraient ne pas fonctionner correctement en raison de l'interférence avec d'autres 
appareils 3D ou appareils électroniques qui fonctionnent avec une fréquence de 2,4 GHz, comme un four 
à micro-ondes ou des points d'accès Internet. Si la fonction 3D est perturbée en raison de l'interférence, 
assurez-vous que les autres appareils électroniques ou de communication sans fil sont le plus loin possible 
des lunettes et du téléviseur.

●● Si vous regardez une vidéo 3D dans un endroit exposé à la lumière directe du soleil ou à l'éclairage, la clarté 
de l'image peut vous sembler se dégrader.

●● Les lunettes 3D peuvent ne pas bien fonctionner en présence d'un champs électrique ou d'un objet métallique 
tel une plaque d'acier à proximité. Éloignez le plus possible les lunettes des champs électriques et des objets 
métalliques.

●● Les lunettes du modèle SSG-3570 peuvent se mettre hors tension si vous regardez des vidéos 3D pendant 
une période prolongée dans la même position. 

●● Si les lunettes 3D de modèle SSG-3570 ne fonctionnent pas immédiatement alors que le téléviseur est en 
mode 3D, retirez-les et remettez-les de nouveau.

Annexe
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[[ Mise en garde

CONSIGNES IMPORTANTES SUR LA SANTÉ ET LA SÉCURITÉ RELATIVEMENT AUX IMAGES 3D. LISEZ LES 
AVERTISSEMENTS SUIVANTS AVANT D’UTILISER OU DE LAISSER VOTRE ENFANT UTILISER LA FONCTION 3D.

●● Les enfants qui utilisent la fonction 3D doivent être supervisés fréquemment par un adulte. Si l'enfant se 
plaint de fatigue oculaire, de maux de tête, d'étourdissements ou de nausée, il doit arrêter de regarder le film 
3D et se reposer.

●● N'utilisez pas les lunettes 3D à d'autres fins (comme lunettes de vue, lunettes de soleil ou de protection, etc.)

●● Certaines personnes peuvent éprouver des étourdissements, des nausées, des maux de têtes, etc. lorsqu'elles 
regardent un film sur un téléviseur 3D. Si vous éprouvez ce genre de symptômes, arrêtez de regarder le film 
3D, enlevez les lunettes 3D et reposez-vous pendant quelques minutes.

●● Si vous regardez des films 3D pendant une période prolongée, cela peut vous causer de la fatigue oculaire. Si 
vous éprouvez de la fatigue oculaire, arrêtez de regarder le film 3D, enlevez les lunettes 3D et reposez-vous 
pendant quelques minutes.

●● N'utilisez pas la fonction 3D ou les lunettes 3D lorsque vous vous déplacez. Si vous utilisez la fonction 3D ou 
des lunettes 3D Active en vous déplaçant, vous pourriez vous blesser en heurtant des objets, en trébuchant 
ou en tombant.

●● Ne dormez pas en portant les lunettes 3D, Cela risquerait d'endommager ou de briser les branches de vos 
lunettes.

●● Les branches de vos lunettes 3D ne sont pas pliables. Si vous tentez de plier les branches de force, vous 
endommagerez les lunettes 3D.

●● Si vous avez des lunettes 3D de modèle SSG-3570, ne les secouez pas de manière répétée. Cela les allumera, 
ce qui risque de décharger les piles prématurément.

●● Si vous possédez des lunettes de modèle SSG-5100GB ou SSG-5150GB, vous pouvez causer une explosion en 
remplaçant la pile par une pile d'un type qui ne convient pas.

●● Si vous possédez des lunettes de modèle SSG-5100GB ou SSG-5150GB, assurez de remplacer la pile par une 
pile de même type.
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[[ Consignes de sécurité

Veuillez prendre connaissance des directives de sécurité ci-dessous afin d'assurer votre propre sécurité, d'éviter 
de causer des dommages matériels et de vous assurer de faire un usage correct du produit.

●● Veillez à ce que le produit ne soit pas exposé directement à la lumière du soleil, une flamme nue, la chaleur ou 
l'eau. Ceci pourrait causer une défectuosité du produit ou un incendie.

●● Évitez d'exercer une pression sur les lentilles des lunettes 3D. Veillez à ne pas échapper ou plier les lunettes. 
Éviter d'exercer une pression, de laisser tomber ou de plier les lunettes 3D car ceci pourrait causer une 
défectuosité.

●● Tenez les composants des lunettes 3D hors de la portée des enfants. En particulier, veillez à ce qu'aucun 
enfant n'avale de composant des lunettes. Dans le cas où votre enfant a avalé un élément constitutif, 
consultez immédiatement un médecin.

●● Lorsque vous nettoyez les lunettes, veillez à ne pas vaporiser d'eau ou de produit nettoyant directement 
sur la surface. Évitez de vaporiser de l'eau ou un produit nettoyant directement sur les lunettes pour éviter 
les risques d'incendie ou de choc électrique, de dommages causés à la partie extérieure du produit ou le 
décollement des étiquettes d'information qui y sont apposées.

●● N'utilisez pas de produits chimiques contenant de l'alcool, des solvants ou des agents tensio-actifs tels que 
de la cire, du benzène, des diluants, pesticides, désodorisants, lubrifiants ou détergents pour nettoyer les 
lunettes. Si vous utilisez ces produits chimiques, la partie extérieure des lunettes risque de se décolorer ou 
se fissurer et les étiquettes contenant les instructions risquent de se détacher. Utilisez seulement un chiffon 
doux en fibres superfines ou flanelle de coton pour nettoyer les lunettes, étant donné que les lentilles ou la 
surface des lunettes se rayent facilement. Étant donné que les lunettes se rayent facilement sous l'action de 
substances étrangères, assurez-vous de secouer le chiffon avant son utilisation.

●● Ne démontez pas les lunettes 3D, et n'essayez pas de les réparer ou de les modifier vous-même.

●● Manipulez avec précaution les branches des lunettes 3D Active pour éviter que les extrémités vous blessent 
les yeux.

●● Ne dormez pas en portant les lunettes 3D, vous risqueriez d'en casser les branches.

●● N'utilisez que vous mains pour retirer ou porter les lunettes 3D.

●● Pour les modèles de lunettes SSG-5100 et SSG-5150GB, utilisez uniquement les piles standard indiquées. 
Lorsque vous remplacez la pile, veillez à respecter la polarité (+, -) indiquée. Le non-respect de cette consigne 
peut causer des dommages à la pile, un incendie, des blessures ou des dommages environnementaux en 
raison de la fuite du liquide interne.

●● Pour les modèles de lunettes SSG-5100 et SSG-5150GB, conservez les piles usées hors de la portée des 
enfants pour éviter qu'ils ne les avalent accidentellement. Si votre enfant a avalé une pile, consultez 
immédiatement un médecin.

●● L'ingestion des piles sphériques (de type bouton) peut causer des blessures sévères aux organes internes. Si 
quelqu'un avale une pile bouton, communiquer immédiatement avec un médecin.
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Résolutions prises en charge pour les modes 3D
La fonction 3D n'est pas offerte aux États-Unis ou au Canada, et est seulement offerte sur les téléviseurs à DEL de 
série 6200 ou d'une série supérieure.

Ces spécifications s'appliquent seulement au format d'image 16:9.

HDMI
●● Mode 3D :  (G/D),  (H/B)

Résolution Fréquence (Hz)

1280 x 720p 59.94 / 60

1920 x 1080i 59.94 / 60

1920 x 1080p 23.98 / 24 / 29.97 / 30 / 59.94 / 60 

Composante

Résolution Fréquence (Hz)

1280 x 720p 59.94 / 60

1920 x 1080i 59.94 / 60

1920 x 1080p 23.98 / 24 / 29.97 / 30 / 59.94 / 60 

Chaîne numérique

Résolution Fréquence (Hz)

1280 x 720p 59.94 / 60

1920 x 1080i 59.94 / 60

Vidéos ou photos
Reportez-vous à la section « Instructions à lire avant de lire des fichiers photo, vidéo ou de musique ».

Connexion à un ordinateur à l'aide d'un câble HDMI
Pour un ordinateur branché au téléviseur à l'aide d'un câble HDMI, la résolution optimale est 1920 x 1080 pixels. Si 
vous sélectionnez une résolution différente, il est possible que le téléviseur n'affiche pas correctement les images 
3D, ou qu'il ne soit pas possible d'afficher en plein écran les vidéos issues de l'ordinateur.
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À lire avant d'utiliser les applications
●● En raison des caractéristiques des produits présentés dans Smart Hub de Samsung et des restrictions 

s'appliquant au contenu disponible, certains services, options et applications peuvent ne pas être disponibles 
sur tous les appareils ou dans toutes les régions. Il se peut aussi que certaines options de Smart Hub exigent 
des périphériques additionnels ou des frais d'adhésion. Veuillez visiter le site Samsung à l'adresse http://
www.samsung.com pour obtenir plus de renseignements sur les contenus disponibles ou des appareils en 
particulier. La disponibilité des services et des contenus peut faire l'objet de modifications sans préavis.

●● Samsung Electronics n'assume aucune responsabilité juridique que ce soit à l'égard de toute interruption des 
services des applications causée par le fournisseur de services, pour quelque raison que ce soit.

●● Les services des applications peuvent être fournis en anglais seulement et les contenus peuvent varier selon 
la région.

●● Pour de plus amples renseignements sur les applications, visitez le site Web du fournisseur du service en 
question.

●● Une connexion Internet instable peut causer des délais ou des interruptions. En outre, les applications 
risquent de s'interrompre automatiquement en fonction des conditions du réseau. Si cela se produit, vérifiez 
votre connexion Internet et essayez de nouveau.

●● Il se peut que les services et les mises à niveau des applications ne soient pas disponibles.

●● Le contenu des applications peur faire l'objet de modifications sans préavis par le fournisseur de service 
concerné.

●● Les services particuliers peuvent varier en fonction de la version de l'application installée sur le téléviseur.

●● Les fonctionnalités de l'application peuvent varier selon les versions futures de l'application. Dans ce cas, 
exécutez le tutoriel de l'application en question ou visitez le site Web du fournisseur de service.

●● Selon les politiques du fournisseur de service, certaines applications pourraient ne pas prendre en charge le 
fonctionnement multitâche.
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À lire avant d'utiliser le Web Browser
●● Sélectionnez Web Browser. L’écran de navigation peut différer de celui de votre ordinateur.

●● Le navigateur Web n’est pas compatible avec les applications Java.

●● Vous ne pouvez pas télécharger de fichiers. Si vous essayez de télécharger un fichier, un message d’erreur 
s’affiche.

●● Le navigateur Web peut ne pas accéder à certains sites Web.

●● La lecture des vidéos Flash n'est pas prise en charge.

●● Le commerce électronique pour l’achat de produits en ligne n’est pas pris en charge.

●● La navigation dans des sites Web contenant des fenêtres déroulantes peut entraîner l’altération de certains 
caractères.

●● ActiveX n’est pas pris en charge.

●● Certaines options sont inaccessibles en mode Navig. par lien. (Pour accéder à ces options, passez en mode 
Navig. par pointeur.)

●● Le nombre de polices prises en charge est limité. Certains symboles et caractères peuvent ne pas s’afficher 
correctement.

●● La réponse à une commande transmise depuis la télécommande ou l’affichage à l’écran peuvent être ralentis 
si la page Web est en cours de téléchargement.

●● Sur certains systèmes d’exploitation, le chargement d’une page Web peut être lent ou ne pas s’effectuer.

●● La fonction copier/coller n’est pas prise en charge.

●● Lorsque vous rédigez des courriels ou des messages, certaines fonctions (comme le changement de la taille 
ou de la couleur) ne seront peut-être pas prises en charge.
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●● Le nombre de signets et de fichiers journaux pouvant être enregistrés est limité.

●● Le nombre de fenêtres pouvant être ouvertes en même temps peut varier selon les conditions de navigation 
ou le modèle du téléviseur.

●● La vitesse de navigation sur le Web dépend des conditions du réseau.

●● Vous pouvez lire des vidéos en même temps qu'une image sur image (ISI).

●● Seuls les fichiers audio MP3 peuvent être lus dans le navigateur Web.

●● L’importation ou l’exportation de signets sont prises en charge seulement pour les fichiers de signets d’un 
format particulier. (Format compatible : Netscape-bookmarkfile- 1)

●● Lorsque vous importez ou exportez un signet, l’arbre du dossier n’est pas inclus.

●● Si vous exportez un fichier de signets vers un dispositif USB branché au téléviseur, le fichier est enregistré 
dans le dossier « Signets Samsung SmartTV ».

●● Si vous n'avez pas réglé Horloge (Système > Heure > Horloge), votre historique de navigation ne sera pas 
enregistré.

●● L’historique des sites visités est enregistré selon un ordre chronologique; les dernières pages visitées 
effacent les plus anciennes.

●● Les sources vidéo des fournisseurs de services de transmission en continu optimisés sur PC peuvent ne pas 
fonctionner correctement sur notre navigateur Web.

●● Lorsque vous utilisez un clavier QWERTY à l’écran, le mode ISI se désactive automatiquement. (Sauf lorsque 
vous entrez une adresse URL.)
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Instructions à lire avant de lire des fichiers photo, vidéo ou de 
musique

Restrictions d'utilisation des photos, vidéos et fichiers musicaux
●● Le téléviseur prend en charge seulement les dispositifs USB à mémoire de grande capacité (MSC). MSC 

se rapporte à une catégorie de dispositifs à mémoire de grande capacité, notamment. Les dispositif USB 
à mémoire de grande capacité (MSC) comprennent les lecteurs de carte mémoire et les appareils photo 
numériques. (Les concentrateurs USB ne sont pas pris en charge.) Ces périphériques doivent être branchés 
directement au port USB du téléviseur. Si le téléviseur est branché à un dispositif USB au moyen d'un câble de 
rallonge USB, il se peut qu'il ne reconnaisse pas ce dispositif ou qu'il ne lise pas les fichiers qu'il contient. Évitez 
de débrancher le dispositif USB pendant le transfert des fichiers.

●● Certains appareils photo numériques ou appareils audio peuvent ne pas être compatibles avec le téléviseur.

●● Les appareils USB très énergivores (plus de 500 mA ou 5 V) pourraient ne pas être pris en charge. Le 
téléviseur ne prend pas en charge les lecteurs de disque dur branchés dans le port USB.

●● Le téléviseur prend en charge les systèmes de fichiers FAT, exFAT et NTFS.

●● Après avoir trié les fichiers en mode Vue Dossier, jusqu'à 1000 fichiers par dossier peuvent être affichés par 
le téléviseur. Si le dispositif USB contient plus de 8 000 fichiers et dossiers, il se peut toutefois que certains 
fichiers et dossiers ne soient pas accessibles.

●● Le mode de connexion PTP (point à point) est disponible avec les appareils photo numériques seulement. 
Si vous branchez un téléphone intelligent ou une tablette au téléviseur en mode PTP, l'appareil ne sera pas 
reconnu par le téléviseur.

Dispositifs de stockage compatibles pour un transfert de fichiers

Dispositif de stockage avec le contenu média Appareil cible

Dispositif USB
Appareil DLNA, SugarSync, Dropbox, SkyDrive ou appareil 
portable

Caméra Appareil DLNA

Appareil DLNA Dispositif USB

SugarSync, Dropbox, SkyDrive Dispositif USB

Appareil portable Dispositif USB
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Sous-titres externes pris en charge
"" Le téléviseur peut ne pas lire certains fichiers en raison de leur type d'encodage.

"" En fonction du modèle, certains fichiers ne sont pas disponibles.

Nom Format

MPEG-4 (texte minuté) .ttxt

SAMI .smi

SubRip .srt

SubViewer .sub

Micro DVD .sub ou .txt

SubStation Alpha .ssa

Advanced SubStation Alpha .ass

Powerdivx .psb

SMPTE-TT (texte) .xml

Sous-titre internes pris en charge
"" Le téléviseur peut ne pas lire certains fichiers en raison de leur type d'encodage.

"" En fonction du modèle, certains fichiers ne sont pas disponibles.

Nom Format

Xsub AVI

SubStation Alpha MKV

Advanced SubStation Alpha MKV

SubRip MKV

VobSub MKV

MPEG-4 (texte minuté) MP4

TTML en diffusion en continu fluide MP4

SMPTE-TT (texte) MP4

SMPTE-TT PNG MP4
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Formats de fichiers d'image et résolutions pris en charge
"" Le téléviseur peut ne pas lire certains fichiers en raison de leur type d'encodage.

"" En fonction du modèle, certains fichiers ne sont pas disponibles.

Extension de fichier Format Résolution

*.jpg
*.jpeg

JPEG 15360 x 8640

*.png PNG 4096 x 4096

*.bmp BMP 4096 x 4096

*.mpo MPO 15360 x 8640

Codecs et formats de fichiers de musique pris en charge
"" Le téléviseur peut ne pas lire certains fichiers en raison de leur type d'encodage.

"" En fonction du modèle, certains fichiers ne sont pas disponibles.

Extension de 
fichier Format Codec Remarque

*.mp3 MPEG MPEG1 Audio Layer 3

*.m4a
*.mpa
*.aac

MPEG4 AAC

*.flac FLAC FLAC Prend en charge jusqu'à 2 canaux.

*.ogg OGG Vorbis Prend en charge jusqu'à 2 canaux.

*.wma WMA WMA
Prend en charge jusqu'à 10 Pro 5.1 canaux.
Format WMA audio sans perte non pris en charge.
Prend en charge jusqu'au profil M2.

*.wav wav wav

*.mid
*.midi

midi midi
Type 0 et type 1 pris en charge.
La fonction de recherche n'est pas prise en charge.
Seul le mode USB est pris en charge.

*.ape ape ape La fonction NonSmart n'est pas prise en charge.

"*.aif
*.aiff"

AIFF AIFF

*.m4a ALAC ALAC
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Codecs vidéo pris en charge
"" Le téléviseur peut ne pas lire certains fichiers en raison de leur type d'encodage.

"" En fonction du modèle, certains fichiers ne sont pas disponibles.

Format de 
fichier Contenant Codecs Vidéo Résolution Fréquence de 

trames (image/sec)
Débit binaire 

(Mbsp) Codec audio

*.avi
*.mkv
*.asf

Motion JPEG 640x480 8

*.wmv
*.mp4
*.mov

AVI
MKV

H.264 BP / MP / HP
Dolby Digital

LPCM

*.3gp
*.vro

ASF
MP4

DivX 3.11 / 4 / 5 / 6
ADPCM(IMA, MS)

AAC
*.mpg

*.mpeg
*.ts

3GP
MOV

MPEG4 SP/ASP 1920x1080 MAX 30 30
HE-AAC

WMA

*.tp
*.trp

*.mov

FLV
VRO

Window Media Video 
v9(VC1)

Dolby Digital Plus
MPEG(MP3)

*.flv
*.vob

VOB
PS

MPEG2
DTS(Core, LBR)
G.711(A-Law,

μ-Law)
*.svi

*.divx
TS MPEG1

*.webm WebM VP8 1920x1080 6~30 20 Vorbis
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Autres restrictions

●● Les codecs peuvent ne pas fonctionner correctement si un problème survient au niveau du contenu.

●● S'il y a une erreur dans le contenu ou le contenant, la lecture du contenu vidéo risque d'être compromise.

●● Le son ou la vidéo peuvent ne pas fonctionner si le nombre d'images par seconde ou le débit binaire est 
supérieur à la capacité du téléviseur.

●● Si le tableau d'indexation contient des erreurs, la fonction Recherche (Saut) ne fonctionne pas.

●● Lorsque vous visionnez une vidéo par l’intermédiaire d’une connexion réseau, la lecture pourrait être altérée 
en raison des vitesses de transmission des données.

●● Certains types d’appareil audio ou d’appareil photo numériques USB ne sont pas compatibles avec le 
téléviseur.

●● L'affichage du menu est retardé lorsque la vitesse de transmission est égale ou supérieure à 10 Mo/s.

Décodeurs vidéo

●● Prend en charge jusqu'à H.264, Niveau 4.1 (FMO/ASO/RS non pris en charge)

●● VC1 AP L4 non pris en charge.

●● Format GMC 2 ou supérieur non pris en charge.

Décodeurs audio

●● WMA 10 Pro prend en charge jusqu'à 5.1 canaux. Prend en charge jusqu'au profil M2. Format WMA audio 
sans perte non pris en charge.

●● WMA 10 Pro ne prend pas en charge le profil M3.

●● QCELP et AMR NB/WB ne sont pas pris en charge.

●● Vorbis est pris en charge jusqu'à 2 canaux.

●● Dolby Digital Plus est pris en charge jusqu'à 5.1 canaux.

●● Le codec DTS LBR est seulement disponible pour les formats MKV, MP4 et TS.
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À lire après avoir installé le téléviseur

Dimensions de l'image et signaux d'entrée

Signal d'entrée Taille de l'image

Chaîne analogique/source externe 16:9, Zoom1, Zoom2, 4:3

Composante (480i, 480p) 16:9, Zoom1, Zoom2, 4:3

Composante (720p) 16:9, Format large, 4:3

Composante (1080i, 1080p) 16:9, Format large, 4:3, Plein écran

Chaîne numérique (720p) 16:9, Format large, 4:3, Vue intell. 2

Chaîne numérique (1080i, 1080p) 16:9, Format large, 4:3, Plein écran, Vue intell. 2

HDMI (720p, 1080i, 1080p) 16:9, Format large, 4:3, Plein écran, Vue intell. 1, Vue intell. 2

Les réglages de Image Format s'appliquent à la source actuelle. La fonction Image Format gardera les mêmes 
réglages jusqu'à la prochaine sélection de la source à moins que vous en changiez.

Installation du système antivol
Le dispositif antivol permet de protéger physiquement le téléviseur contre le vol. Recherchez la fente du dispositif 
antivol à l'arrière de l'appareil. La fente se trouve à côté de l'icône K. Pour utiliser le système antivol, enroulez 
le verrou autour d'un objet lourd, puis faites-le glisser dans la fente du téléviseur. Le système antivol est vendu 
séparément.

La méthode d'utilisation du dispositif antivol peut différer selon le modèle du téléviseur. Pour en savoir davantage, 
reportez-vous au guide d'installation du dispositif antivol.

"" La disponibilité varie en fonction du modèle.
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À lire avant de configurer une connexion à Internet sans fil

Internet sans fil – précautions

●● Ce téléviseur prend en charge les protocoles de communication IEEE 802.11a/b/g/n. Samsung recommande 
l'utilisation du protocole IEEE 802.11n. La lecture de certains fichiers vidéo enregistrés sur un dispositif 
branché au téléviseur par l'entremise d'un serveur DLNA pourrait être altérée.

●● Pour utiliser une connexion Internet sans fil, le téléviseur doit être connecté à un routeur ou un modem 
sans fil. Si le routeur sans fil est compatible avec le protocole DHCP, le téléviseur peut utiliser une adresse IP 
statique ou DHCP pour établir la connexion au réseau sans fil.

●● Sélectionnez une chaîne actuellement inutilisée pour le routeur sans fil. Si la chaîne choisie pour le routeur 
est actuellement utilisée par un autre appareil, il y aura des interférences et la communication échouera.

●● La plupart des systèmes de réseau sans fil sont équipés d’un système de sécurité optionnel. Pour mettre en 
service le système de sécurité d'un réseau sans fil, vous devez créer un mot de passe à l'aide de caractères 
et de chiffres. Ce mot de passe est ensuite nécessaire pour se connecter à un point d'accès dont la fonction 
sécurité est activée.

Protocoles de sécurité du réseau sans fil

Votre téléviseur prend seulement en charge les protocoles de sécurité du réseau sans fil qui suivent.

●● Mode d'authentification : WEP, WPAPSK, WPA2PSK

●● Type de chiffrement : WEP, TKIP, AES

Les téléviseurs Samsung ne prennent pas en charge le type de chiffrement WEP ou TKIP conformément aux 
nouvelles spécifications de certification de produits sans fil lorsque le mode (Greenfield) 802.11n est sélectionné.

Si le routeur sans fil prend en charge la configuration WPS (Configuration Wi-Fi protégée), vous pouvez vous 
connecter au réseau à l’aide de la configuration par touches (PBC) ou d’un NIP (numéro d’identification personnel). 
WPS configurera automatiquement les clés SSID et WPA.

Le téléviseur ne peut se connecter à des routeurs sans fil non-certifiés.
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Instructions à lire avant de procéder à la connexion d'un 
ordinateur (résolutions prises en charge)

Séries à DEL 5300, 5200, 5100, 6100 et 6200
Lorsque vous branchez le téléviseur à un ordinateur, choisissez, pour l'ordinateur, l'une des résolutions standard 
indiquées dans les tableaux sur cette page ou la page suivante. Le téléviseur se réglera automatiquement à la 
résolution choisie. Veuillez noter que la résolution recommandée et optimale est 1920 x 1080.

Si vous sélectionnez une résolution ne figurant pas dans le tableau, l'écran de votre téléviseur pourrait être vide ou 
seul le voyant de mise en circuit pourrait s'allumer.

Reportez-vous au manuel de l'utilisateur de votre carte graphique pour connaître les résolutions compatibles.

IBM

Résolution
(horizontal x 

vertical)

Format 
d'affichage

Fréquence 
horizontale

(kHz)

Fréquence 
verticale

(Hz)

Fréquence de 
l'horloge

(MHz)

Polarité 
(horizontale/

verticale)

720x400 70Hz 31.469 70.087 28.322 -/+

MAC

Résolution
(horizontal x 

vertical)

Format 
d'affichage

Fréquence 
horizontale

(kHz)

Fréquence 
verticale

(Hz)

Fréquence de 
l'horloge

(MHz)

Polarité 
(horizontale/

verticale)

640 x 480 67Hz 35.000 66.667 30.240 -/-

832x624 75Hz 49.726 74.551 57.284 -/-

1152x870 75Hz 68.681 75.062 100.000 -/-
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VESA DMT

Résolution
(horizontal x 

vertical)

Format 
d'affichage

Fréquence 
horizontale

(kHz)

Fréquence 
verticale

(Hz)

Fréquence de 
l'horloge

(MHz)

Polarité 
(horizontale/

verticale)

640 x 480 60Hz 31.469 59.940 25.175 -/-

640 x 480 72Hz 37.861 72.809 31.500 -/-

640 x 480 75Hz 37.500 75.000 31.500 -/-

800x600 60Hz 37.879 60.317 40.000 +/+

800x600 72Hz 48.077 72.188 50.000 +/+

800x600 75Hz 46.875 75.000 49.500 +/+

1024x768 60Hz 48.363 60.004 65.000 -/-

1024x768 70Hz 56.476 70.069 75.000 -/-

1024x768 75Hz 60.023 75.029 78.750 +/+

1152x864 75Hz 67.500 75.000 108.000 +/+

1280 x 720 60Hz 45.000 60.000 74.250 +/+

1280x800 60Hz 49.702 59.810 83.500 -/+

1280x1024 60Hz 63.981 60.020 108.000 +/+

1280x1024 75Hz 79.976 75.025 135.000 +/+

1366x768 60Hz 47.712 59.790 85.500 +/+

1440x900 60Hz 55.935 59.887 106.500 -/+

1600x900RB 60Hz 60.000 60.000 108.000 +/+

1680x1050 60Hz 65.290 59.954 146.250 -/+

1920 x 1080 60Hz 67.500 60.000 148.500 +/+
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Téléviseurs à DEL de série 4500, 4300 ou 4200
Après avoir raccordé un ordinateur au téléviseur, réglez la résolution de l'écran pour l'afficher à l'ordinateur. La 
résolution optimale est 1366 x 768 à 60 Hz. Si la résolution est réglée à une valeur différente de celles indiquées 
dans le tableau ci-dessous, il se peut que le téléviseur n'affiche aucune image. Réglez la résolution de manière 
adéquate, en se reportant au guide d'utilisation de l'ordinateur ou de sa carte graphique.

IBM

Résolution
(horizontal x 

vertical)

Format 
d'affichage

Fréquence 
horizontale

(kHz)

Fréquence 
verticale

(Hz)

Fréquence de 
l'horloge

(MHz)

Polarité 
(horizontale/

verticale)

720x400 70Hz 31.469 70.087 28.322 -/+

MAC

Résolution
(horizontal x 

vertical)

Format 
d'affichage

Fréquence 
horizontale

(kHz)

Fréquence 
verticale

(Hz)

Fréquence de 
l'horloge

(MHz)

Polarité 
(horizontale/

verticale)

640 x 480 67Hz 35.000 66.667 30.240 -/-

832x624 75Hz 49.726 74.551 57.284 -/-

VESA DMT

Résolution
(horizontal x 

vertical)

Format 
d'affichage

Fréquence 
horizontale

(kHz)

Fréquence 
verticale

(Hz)

Fréquence de 
l'horloge

(MHz)

Polarité 
(horizontale/

verticale)

640 x 480 60Hz 31.469 59.940 25.175 -/-

640 x 480 72Hz 37.861 72.809 31.500 -/-

640 x 480 75Hz 37.500 75.000 31.500 -/-

800x600 60Hz 37.879 60.317 40.000 +/+

800x600 72Hz 48.077 72.188 50.000 +/+

800x600 75Hz 46.875 75.000 49.500 +/+

1024x768 60Hz 48.363 60.004 65.000 -/-

1024x768 70Hz 56.476 70.069 75.000 -/-

1024x768 75Hz 60.023 75.029 78.750 +/+

1280 x 720 60Hz 45.000 60.000 74.250 +/+

1366x768 60Hz 47.712 59.790 85.500 +/+
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Résolutions prises en charge pour les signaux vidéo

CEA-861

Résolution
(horizontal x 

vertical)

Format 
d'affichage

Fréquence 
horizontale

(kHz)

Fréquence 
verticale

(Hz)

Fréquence de 
l'horloge

(MHz)

Polarité 
(horizontale/

verticale)

720(1440)x480i 60Hz 15.734 59.940 27.000 -/-

720(1440)x576i 50Hz 15.625 50.000 27.000 -/-

720x480 60Hz 31.469 59.940 27.000 -/-

720x576 50Hz 31.250 50.000 27.000 -/-

1280 x 720 60Hz 45.000 60.000 74.250 +/+

1280 x 720 50Hz 37.500 50.000 74.250 +/+

1920x1080i 60Hz 33.750 60.000 74.250 +/+

1920x1080i 50Hz 28.125 50.000 74.250 +/+

1920 x 1080 60Hz 67.500 60.000 148.500 +/+

1920 x 1080 50Hz 56.250 50.000 148.500 +/+

1920 x 1080 30Hz 33.750 30.000 74.250 +/+

1920 x 1080 25Hz 28.125 25.000 74.250 +/+

1920 x 1080 24Hz 27.000 24.000 74.250 +/+
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Licence

DivX Certified® to play DivX® video up to HD 1080p, including premium content.
ABOUT DIVX VIDEO: DivX® is a digital video format created by DivX, LLC, a subsidiary of Rovi Corporation. This is an official 
DivX Certified® device that has passed rigorous testing to verify that it plays DivX video. Visit divx.com for more information 
and software tools to convert your files into DivX videos.
ABOUT DIVX VIDEO-ON-DEMAND: This DivX Certified® device must be registered in order to play purchased DivX Video-on-
Demand (VOD) movies. To obtain your registration code, locate the DivX VOD section in your device setup menu. Go to vod.
divx.com for more information on how to complete your registration.
DivX®, DivX Certified® and associated logos are trademarks of Rovi Corporation or its subsidiaries and are used under 
license.
Covered by one or more of the following U.S. patents: 7,295,673; 7,460,668; 7,515,710; 7,519,274

Manufactured under a license from U.S. Patent No’s: 5,956,674, 5,974,380, 5,978,762, 6,487,535, 6,226,616, 7,212,872, 
7,003,467, 7,272,567, 7,668,723, 7,392,195, 7,930,184, 7,333,929 and 7,548,853. DTS, the Symbol, and DTS and the 
Symbol together are registered trademarks & DTS Premium Sound | 5.1 is a trademark of DTS, Inc. ©2012 DTS, Inc. All Rights 
Reserved.

Manufactured under a license from U.S. Patent No’s: 6,285,767, 8,027,477, 5,319,713, 5,333,201, 5,638,452, 5,771,295, 
5,970,152, 5,912,976, 7,200,236, 7,492,907, 8,050,434, 7,720,240, 7,031,474, 7,907,736 and 7,764,802. DTS, the Symbol, 
and DTS and the Symbol together are registered trademarks & DTS Studio Sound is a trademark of DTS, Inc. ©2012 DTS, Inc. 
All Rights Reserved.
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Fabriqué sous licence de Dolby Laboratories.
Dolby et le symbole double-D sont des marques déposées de Dolby Laboratories.

The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI Logo are trademarks or registered trademarks 
of HDMI Licensing LLC in the United States and other countries.

Open Source License Notice

Open Source used in this product can be found on the following webpage.

(http://opensource.samsung.com) Open Source License Notice is written only English.

Il se peut que cette licence ne soit pas prise en charge en fonction du pays ou du modèle.
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Lexique
●● 480i/480p/720p/1080i/1080p

Fait généralement référence au nombre de lignes de balayage réelles qui détermine la résolution de l'écran. Il 
existe deux méthodes de balayage : entrelacé et progressif.

–– Balayage

Projection séquentielle de pixels pour former les images. Plus le nombre de pixels est élevé, plus les 
images sont claires et vives. 

–– Progressif

Une méthode de balayage séquentielle balayant chaque ligne, une après l'autre.

–– Entrelacé

Une méthode de balayage en étage qui balaie une ligne sur deux jusqu'à la fin de l'écran, puis remplit les 
lignes restantes.

(Exemple) Si le nombre de lignes horizontales balayées est 480i

Balaie 240 lignes du début à la fin, puis balaie les 240 lignes restantes pour un total de 480 lignes.

* Les principales différences entre 480i et 480p sont :

480i 480p

Fréquence horizontale 15,75Khz 31,5Khz

Image/sec 30 60

Ligne à l'écran 480 480

●● DVI (interface vidéo numérique)

Le branchement du connecteur DVI du téléviseur au connecteur DVI de l'ordinateur à l'aide d'un câble 
HDMI-DVI vous permet d'utiliser le téléviseur comme écran d'ordinateur. Cependant, les câbles HDMI-DVI 
ne transmettent que le signal vidéo. Vous devez brancher des haut-parleurs à l'ordinateur à l'aide d'un autre 
câble pour entendre le son de l'ordinateur.

●● HDMI (Interface multimédia haute définition)

HDMI est une méthode de transmission permettant le transfert des signaux vidéo et audio par l'entremise 
d'un seul câble.
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●● Adresses IP dynamiques et statiques

Si votre réseau nécessite une adresse IP dynamique, vous devez utiliser un modem ou routeur ADSL prenant 
en charge le protocole DHCP (Dynamic Host Configuration Protocol). Les modems et routeurs qui prennent 
en charge le protocole DHCP fournissent automatiquement l’adresse IP, le masque de sous-réseau, la 
passerelle et les valeurs DNS dont votre téléviseur a besoin pour accéder à Internet, de sorte que vous n’ayez 
pas à les saisir manuellement. La plupart des réseaux domestiques utilisent une adresse IP dynamique.

Si le réseau nécessite une adresse IP statique, vous devez saisir manuellement l’adresse IP, le masque de sous-
réseau, la passerelle et les valeurs DNS lors de la configuration de votre connexion au réseau. Pour obtenir 
ces données, veuillez communiquer avec votre fournisseur d'accès Internet.

Si le réseau nécessite une adresse IP statique, vous devez utiliser un modem ADSL qui prend en charge le 
protocole DHCP. Les modems ADSL qui prennent en charge le protocole DHCP permettent aussi d’utiliser 
des adresses IP statiques.

●● Ethernet

Ethernet est un réseau local (LAN) utilisant des câbles coaxiaux respectant la norme IEEE.

●● Branchement d'une composante

Les câbles composantes sont principalement utilisés pour les consoles de jeux et transmettent le signal vidéo 
en le convertissant en un signal de luminance (Y) et deux signaux des couleurs (Pb et Pr). Le connecteur est 
identifié par [Component IN]_(Pr, Pb, Y) à l'arrière du téléviseur. Sur certains appareils, vous pourriez voir les 
noms Cr, Cb et Y. Cb et Cr sont les versions numériques des signaux Pb et Pr.

Les connecteurs sont habituellement identifiés par leur couleur rouge (R), bleu (B) et vert (V) et offrent la 
meilleure qualité d'image possible pour une connexion analogique.
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